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DISCLAIMER 

RED® has made every effort to provide clear and accurate information in this Operation Guide, which is 
provided solely for the user’s information. While thought to be accurate, the information in this document 
is provided strictly “as is” and RED will not be held responsible for issues arising from typographical errors 
or user’s interpretation of the language used herein that is different from that intended by RED. All safety 
and general information is subject to change as a result of changes in local, federal or other applicable 
laws. 

RED reserves the right to revise this Operation Guide and make changes from time to time in the content 
hereof without obligation to notify any person of such revisions or changes. In no event shall RED, its 
employees or authorized agents be liable to you for any damages or losses, direct or indirect, arising from 
the use of any technical or operational information contained in this document. 

For comments or questions specifically about the Operations Guide content, please send a detailed 
message to OpsGuides@red.com. 

COPYRIGHT NOTICE 

COPYRIGHT © 2012 Red.com, Inc. 

All trademarks, trade names, logos, icons, images, written material, code, and product names used in 
association with the accompanying product are the copyrights, trademarks or other intellectual property 
owned and controlled exclusively by Red.com, Inc. 

TRADEMARK DISCLAIMER 

All other company, brand and product names are trademarks or registered trademarks of their respective 
holders. RED has no affiliation to, is not associated or sponsored with, and has no express rights in third-
party trademarks. MAC® and QuickTime® are registered trademarks of Apple, Inc. Intel® is the registered 
trademark of Intel Corporation. Windows®, Microsoft Windows® and Windows Vista® are the registered 
trademarks of Microsoft Corporation. AVID® is a registered trademark of Avid Technology, Inc. NUKE is a 
trademark of The Foundry Visionmongers Ltd. Torx® is a registered trademark of Textron, Inc. Canon® and 
EOS® are registered trademarks of Canon Kabushiki Kaisha Corporation.  

  

mailto:OpsGuides@red.com�
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COMPLIANCE 

INDUSTRIAL CANADA EMISSION COMPLIANCE STATEMENTS 

This Class B digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada. 

FEDERAL COMMUNICATIONS COMMISSION (FCC) STATEMENT 

This equipment has been tested and found to comply with the limits for a class B digital 
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and if not installed and 
used in accordance with the instructions, may cause harmful interference to radio 

communications. However, there is no guarantee that interference will not occur in a particular installation. 
If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the interference 
by one or more of the following measures: 

1. Reorient or relocate the receiving antenna. 

2. Increase the separation between the equipment and receiver. 

3. Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected. 

4. Consult the dealer or an experienced radio/TV technician for help. 

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. 
Operation with non-approved equipment or unshielded cables is likely to result in interference to radio 
and TV reception. The user is cautioned that changes and modifications made to the equipment without 
the approval of manufacturer could void the user's authority to operate this equipment. 

NOTE: This device complies with Part 15 of the FCC Rules.  

Operations subject to the following two conditions: (1) this device may not cause harmful interference, and 
(2) this device must accept any interference received, including interference that may cause undesirable 
interference. 

CAUTION: If the device is changed or modified without permission from RED, the user may void his 
or her authority to operate the equipment. 
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AUSTRALIA AND NEW ZEALAND STATEMENT 

This device has been tested and found to comply with the limits for a Class B digital device, pursuant to 
EN 55022:2006 

JAPAN STATEMENTS 

This is a Class B product based on the standard of the Voluntary Control Council for 
Interference (VCCI) for information technology equipment. If this equipment is used near a 
radio or television receiver in a domestic environment, it may cause radio interference. 
Install and use the equipment according to the instruction manual. 

 

EUROPEAN UNION COMPLIANCE STATEMENTS 

RED declares that the equipment described in this document is in conformance with 
the requirements of the European Council EMC Directive 2004/108/EC, Low Voltage 
Directive 2006/95/EC, RoHS Directive 2002/95/EC and WEEE Directive 2002/96/EC. 

This declaration is based upon compliance of the product to the following standards: 

• EN 55022, Information Technology Equipment - Radio Disturbance Characteristics 

• EN 55024, Information Technology Equipment - Immunity Characteristics  

• EN 61000-3-2, Limits for harmonic current emissions 

• EN 61000-3-3, Limits for harmonic current emissions 

• EN 60950-1, Information Technology Equipment – Safety 
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The Waste Electrical and Electronic Equipment (WEEE) mark applies only to countries 
within the European Union (EU) and Norway. This symbol on the product and 
accompanying documents means that used electrical and electronic products should not 
be mixed with general household waste.  For proper treatment, recovery and recycling, 
please take this product to designated collection points where it will be accepted free of 
charge. Alternatively, in some countries you may be able to return your products to your 
local retailer upon purchase of an equivalent new product. 

Disposing of this product correctly will help save valuable resources and prevent any potential negative 
effects on human health and the environment, which could otherwise arise from inappropriate waste 
handling. Please contact your local authority for further details of your nearest designated collection point. 
Penalties may be applicable for incorrect disposal of this waste, in accordance with you national 
legislation. 

For business users in the European Union, if you wish to discard electrical and electronic equipment, 
please contact your dealer or supplier for further information. 

Responsible party:     

Red Digital Cinema® 
34 Parker 
Irvine, CA 92618 
USA 
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BEFORE YOU START  

Congratulations on your purchase of a RED DSMC® Digital Still and Motion Camera.  

Please read the attached safety instructions, and only then unpack the camera body and any accessories. 
If there is any physical damage or missing components for either your camera body or any accessories, 
please file a support ticket at www.RED.com/support. 

 

RED SCARLET-X Digital Still and Motion Camera 

IMPORTANT SAFETY INSTRUCTIONS 

READ BEFORE USING YOUR CAMERA 
A. Heed all cautions and warnings in these instructions. 

B. Read these instructions before operating the camera and accessories. 

C. Follow these instructions while operating the camera and accessories. 

D. Keep these instructions with the camera and accessories at all times. 

E. DO NOT attempt to modify, dismantle or open your camera, lens or other accessory as doing so may 
expose you to electric shock and serious injury. There are no user-serviceable parts inside. Alteration 
or repairs made to the camera, lens or other accessory, except by a RED authorized service facility, 
will void the Limited Warranty. Users are not permitted to make design changes or otherwise modify 
the operation of the camera, lenses or other accessories, without the express written approval of RED 
DIGITAL CINEMA. 

F. Only use attachments/accessories specified by RED. 

G. Install camera and accessories in accordance with the manufacturer’s instructions. 

H. Avoid imaging of laser beams as they may cause damage to the sensor. 

I. DO NOT use the camera or accessories near water. Avoid exposing your camera to moisture. The unit 
is not waterproof, so contact with water could cause permanent damage to the unit as well as electric 

http://www.red.com/support�
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shock and serious injury to the user. DO NOT use the camera in the rain or under other conditions with 
high moisture without appropriate protection, and immediately remove power source if camera or 
accessories are exposed to moisture. 

WARNING: To reduce the risk of fire or electric shock, do not expose the camera or accessories to 
rain or moisture. 

J. DO NOT expose your camera to excessive vibration or impact (shock). Be careful not to drop your 
camera. Internal mechanisms may be damaged by severe shock. Mechanical alignment of optical 
elements may be affected by excessive vibration. 

K. ELECTROMAGNETIC INTERFERENCE: The use of devices using radio or other communication 
waves may result in the malfunction or interference with the unit and/or with audio and video signals. 

L. Clean only using a dry cloth. When cleaning your camera, remember that it is not waterproof and 
moisture can damage electronic circuitry. DO NOT rinse or immerse any element of the camera, lens 
or other accessory, keep them dry at all times. DO NOT use soaps, detergents, ammonia, alkaline 
cleaners, and abrasive cleaning compounds or solvents. These substances may damage lens 
coatings and electronic circuitry. 

M. Maintain sufficient ventilation - DO NOT block any ventilation openings or obstruct cooling fan airflow. 

CAUTION: Proper camera ventilation requires a minimum 1/2” (1,25cm) clearance between the 
camera ventilation openings and external surfaces. Verify that objects that can block the fan intake 
and exhaust ports do not impede airflow. Failure to permit adequate airflow may result in 
overheating of the camera, degraded operation and in extreme situations, damage to the camera. 

N. DO NOT operate or store near any heat sources such as radiators, heat registers, stoves, or any other 
apparatus that produce heat. Store in a protected, level and ventilated place. Avoid exposure to 
temperature extremes, damp, severe vibration, strong magnetic fields, direct sunlight or local heat 
sources during storage. Remove any batteries from the camera before storage. Recommended 
storage and usage temperatures for your camera, lenses and other accessories are: 

a. Operating range: 0°C to +40°C (32°F to 104°F) 

o Storage range: -20°C to +50°C (-4°F to 122°F) 

If there are any performance issues with your camera or accessories when operating within this 
temperature range, please file a support ticket on www.RED.com/support. 

O. The Side Handle, Side SSD Module, Rear Modules and Lens Mount are NOT HOT SWAPPABLE – 
meaning you cannot remove or install them while the camera is powered on. Before installing or 
removing any of these accessories, you MUST power down the camera. Failure to do so may result in 
damage to the accessory and / or camera brain that will not be covered under warranty. 

P. Do not bypass the third prong of the grounding-type plug on the power cord of the AC Power 
Adapter. A grounding-type plug has two blades and a third “grounding” prong. The third prong is 
provided for your safety. A grounding-type plug shall be connected to an outlet with a protective 
earthen connection. If the grounding-type plug does not fit into your outlet, do not attempt to modify 
the plug or outlet, consult a qualified electrician. 

Q. Protect all power cords from being pinched, walked on or driven over by a vehicle. Replace any power 
cords suspected of sustaining damage due to crushing or other forms physical damage.  

http://www.red.com/support�
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CAUTION: The power cord plug for the AC Power Adapter is used as the power disconnect. To 
disconnect all power from the AC Power Adapter, unplug the power cord plug from the wall outlet. 
During use, the power cord plug should remain easily accessible at all times. 

R. Lithium Ion batteries may be subject to special handling requirements pursuant to federal and local 
laws. Please refer to specific shipping instructions included with your battery regarding proper 
transport of your battery. Do not handle your battery if it is damaged or leaking. Disposal of batteries 
must be in accordance with local environmental regulations. For example, California law requires that 
all rechargeable batteries must be recycled by an authorized recycle center. Storing batteries fully 
charged or in high temperature, conditions may permanently reduce the life of the battery. Available 
battery capacity may also be temporarily lessened after storage in low temperature conditions. 

WARNING: Do not expose the battery to excessive heat. 

WARNING: Danger of explosion if an incorrect battery is charged with the RED Charger or is used 
to power the camera and accessories. Replace only with the same or equivalent type battery. 

CAUTION: Refer all service and repair to qualified RED service personnel. To reduce the risk of 
electric shock, and damage to the camera or accessories, DO NOT attempt to perform any 
servicing other than any procedures that are recommended in the operating instructions. 
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THEORY OF OPERATION 

The RED family of Digital Still and Motion Cameras (DSMC) provide high performance digital imaging over 
a wide range of frame rates and optical formats including Super 35mm / APS-H. The RED DSMC camera 
is supplied as standard with a PL mount, and may be configured with mounts and 19 mm rods to 
accommodate most cinematography lenses, matte boxes and follow focus systems. Adaptors for 15mm 
offset studio and 15mm lightweight rods are also available. 

In addition to compatibility with the majority of existing PL mount cinematography lenses; a select range 
of Super 35mm PL mount prime and zoom lenses are available from RED.  

Other lens mounts, including the DSMC Canon mount are available, permitting the use of Canon EF and 
EF-S photographic lenses. The Canon mount can report lens iris, focus and zoom data when mated to an 
appropriate lens. In addition, iris and manual or auto-focus settings may be controlled from the camera.  

Lens mounts may be exchanged in the field, however it is highly recommended that this be performed in a 
dust-free environment, as the optical path will be exposed to the elements during this process. 

A B4 mount to PL mount adaptor is also available to permit use of 2/3” HD broadcast lenses on the RED 
DSMC camera. The optical coverage it provides is approximately equivalent to 16mm, hence the 
maximum recording resolution operating with a B4 mount 2/3” lens is 2K (2048 x 1152 pixels) progressive 
scan. 

MYSTERIUM X® SENSOR 

The MYSTERIUM X sensor has been specifically designed for use with the RED DSMC camera, and 
provides variable frame rate imaging at up to 120fps at 5K resolution, and up to 240 fps at 2K resolution. 

Native color balance for the MYSTERIUM X sensor is 5,000 KELVIN, but it may be electronically 
compensated for any color temperature in the range 1,700 to 10,000 KELVIN. White balance preset 
values include Tungsten (3200K) and Daylight (5600K) light sources. The camera may also calculate a 
color neutralizing White Balance value on demand by imaging on a standard white or 18% grey card. 

The MYSTERIUM X sensor includes high precision analog to digital conversion, capable of delivering up 
to 13.5 stops of dynamic range with daylight light sources over a camera sensitivity rating of 320-800 ISO. 
In HDR mode, dynamic range can be extended to approximately 18 stops.  

IMAGE PROCESSING 

The digital image received from the sensor is formatted as a pixel defect corrected (but in all other 
aspects unprocessed) 12-bit, 14-bit or 16-bit per pixel RAW data frame. When operating in STILLS mode, 
each image received from the sensor is treated as a unique FRAME; however when operating in MOVIE 
mode, successive images received from the sensor are collected together into a CLIP. In all other regards, 
a frame of information gathered in STILLS mode or MOVIE mode is identical. 

Each RAW frame or sequence of RAW frames in a clip is compressed using proprietary wavelet based 
REDCODE® RAW compression, then stored to a digital media Magazine such as REDMAG™ 1.8” SSD. 

When recorded, the RAW data is independent of any RGB domain color processing such as ISO, White 
Balance or other RGB color space adjustments made by the camera operator. These parameters are 
saved with the RAW data as reference METADATA; i.e. color is not burned into the recorded RAW data.  
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This recording technique permits RGB color processing choices to be deferred to post production or to 
be adjusted in the field to help a director visualize alternative color treatments, without affecting the 
recorded RAW data’s image quality or dynamic range. 

The camera’s monitoring path converts RAW sensor data to a white balanced 12-bit depth 2048 x 1080 
pixel RGB 4:4:4 video signal. This signal may be modified using ISO, White Balance or other RGB color 
space adjustments as desired by the operator, and is then scaled and gamma corrected to provide 
VIEWFINDER, HD-SDI and HDMI monitor outputs at 10-bit depth in 4:2:2 YCC or 8-bit depth in 4:4:4 
RGB. 

Frame guides and other camera data may be added as desired by the user to one or more of the outputs. 

NOTE: The supplied REDCINE-X® PRO application software can create and export .RMD “color 
look” files which may then be imported as camera monitor path color processing PRESETs. This 
information is stored as reference metadata, so that this color processing choice can be the 
default value used in Post Production. Refer to SECONDARY MENUS > PRESETS for details how to 
import and apply .RMD file metadata. 

HDRX™ 

HDRx is an option for extending dynamic range up to 6 stops over the base Dynamic Range offered by 
the camera. When enabled HDRx simultaneously shoots two images of identical resolution and frame rate 
-  a normally exposed primary track (A-track), and an underexposed secondary track (X-track) whose 
exposure value reflects the additional stops of highlight protection desired.  

i.e. if you select an HDR value of +2 and your primary track exposure is 1/48th sec, the secondary track 
exposure will be 2 stops under, or 1/192 sec. The ISO and Aperture remain the same for both exposures. 

During acquisition and recording, the two tracks are "motion-conjoined", meaning there is no gap in time 
between the two exposures. This is very important to note because if they were traditional alternating 
exposures, there would be a time gap between the two tracks that would show up as an undesirable 
motion artifact. Both tracks (A & X) are stored in a single .R3D® file.  

Since there are two exposures in HDRx mode, the camera is recording double the amount of frames each 
second. For example, when shooting at 24fps, the camera is recording two 24fps tracks, which is the data 
rate equivalent of 48fps; however after combining the A and X tracks in postproduction you will see only 
one 24fps blended image sequence.  

HDRx provides multiple options for exploitation in postproduction. 

• Blend the two tracks in post tools like REDCINE-X, Storm or any other application that supports the 
SDK to create Magic Motion™. This blending of the two tracks comes with a slider so you can decide 
just how much of each track you want to use. A preview window shows you the combined result of 
your selection, or you can view each track individually. 

• Combine the two tracks using MNMB (More Normal Motion Blur). MNMB is designed to emulate the 
motion of a traditional camera with full motion blur. This is a tool created by The Foundry that uses a 
new motion estimation algorithm designed specifically for HDRx. The shorter exposure (sharper 
image) is blended to match the motion blur of the normal exposure. Again, a preview window shows 
the combined result of your selection, or you can view each track individually. 

• Use the X-track data for motion tracking, then combine the X-track with the A-track, or just motion 
stabilize the A-track using the motion analysis data extracted from the X-track. 
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• Exporting to EXR file format will give you a multi-view EXR with both exposures (like a stereo EXR). 

NOTE: If you ignore the X-track data, you will have a standard exposure with up to 13.5 stops of  
dynamic range just as if you had not enabled HDRx. For this reason, we encourage the A-track 
exposure to be "normal" as it provides the most options. If you are tempted to shoot "over-under", 
you are then fully committed to using HDRx and your postproduction options are reduced. 

NOTE: When recording in HDRx mode the camera records twice as many frames per second so the 
maximum frame rate or minimum REDCODE ratio, and the maximum record time on your media 
will be cut in half.  

MAGIC MOTION™ 

Shooting at 24fps and with an 180 degree (1/48th) shutter on a film or digital camera may create an 
optical illusion we are familiar with, however it is not really the way the eye sees motion. To understand 
this, ask someone to stand in front of you and swing their arm over their head from one side to the other. 
What you would observe in the recording is a constant motion blur until the arm stopped. What your eye 
sees though is both motion blur AND a sharper reference to the arm and hand all along the motion path. 
"Magic Motion" provides such a combination of motion blur (A-track) and a sharper reference (X-track), 
with the bonus of extreme dynamic range not available with any other motion capture camera system. 

AUDIO RECORDING 

The RED DSMC camera can record up to two discreet channels of microphone level uncompressed 24-
bit, 48 KHz audio (four channels of microphone level or line level audio inputs when equipped with a PRO 
I/O Module), that are synchronized with video and timecode to a REDMAG 1.8” SSD digital media 
Magazine. 

Input signals are routed via a high quality pre-amplifier and soft clip analog limiter in order to achieve the 
desired audio reference / recording level and maximize dynamic range. 

To assist with audio reference level setup, the camera provides a color-coded Audio Level Meter in the 
Graphical User Interface. Meter range is –36dBu to +20dBu (-56dBFS to 0dBFS) with audio input type, 
reference level and audio input clipping indicators. 

Audio monitor output options include a 2-channel headphone output on the camera Brain and 2-channel 
line level analog outputs from the optional PRO I/O Module, plus 2-channel and 4-channel 24-bit 48KHz 
uncompressed digital audio embedded in the HD-SDI and HDMI outputs. 

MICROPHONE LEVEL ANALOG INPUTS  

The recording level of a Microphone input is affected by the sensitivity of the microphone and the Gain 
setting of the camera’s pre-amplifier. Available pre-amplifier range is +8dB to +62dB, with a default value 
of +10dB. The camera operator should choose a Gain value that aligns the input signal to the 0dBu 
reference line drawn on the camera’s Audio Level Meter (or the 0VU reference line if operating at that 
level). 

This setting provides up to 30dB of input signal headroom above reference 0dBu level before clipping (up 
to 26dB above 0VU reference level) and maximizes the signal to noise ratio of the 24-bit digital recording. 
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LINE LEVEL ANALOG INPUTS 

The recording level of a Line input is affected only by the signal provided by the field production sound 
mixer or other external line level source. The sound mixer operator should choose a mixer output level 
that aligns a reference tone signal to the 0dBu (-20dBFS) reference mark drawn on the camera’s Audio 
Level Meter, or if using 0VU as reference level, a mixer output level that aligns a reference tone signal to 
the 0VU (-16dBFS) reference mark. 

This setting provides up to 24dB of input signal headroom above reference 0dBu level before clipping (up 
to 20dB above 0VU reference level) and maximizes the signal to noise ratio of the 24-bit digital recording. 

VIDEO MONITORING OUTPUTS 

In its default configuration, the RED DSMC camera can simultaneously support one VIEWFINDER output 
(suitable for use by a BOMB EVF®, or RED LCD) plus one PROGRAM output and one PREVIEW output 
(suitable for use by HDMI or HD-SDI monitors). The various monitor outputs can support a set of overlay 
graphics including camera GUI, timecode, clip name and framing guides; the specific overlay graphics for 
each type of output is user configurable. 

The default VIEWFINDER output is the EVF / LCD connector located on the front face of the Side SSD 
Module. If neither of these is connected, the VIEWFINDER output can be transferred to either the HDMI 
output or the HD-SDI output of the camera Brain.   

BOMB EVF 

A 1280 x 784 pixel progressive scan color display providing the equivalent of viewing a 17” reference 
monitor from a distance of about 3ft (1m). Display includes Surround View™ look around area, frame 
guides and safe action / title, zebra and false color exposure overlays, operation status and setup menus. 

RED LCD 

A 800 x 480 pixel progressive scan color display supporting a touchscreen overlay. Display includes 
Surround View™ look around area, frame guides and safe action / title, zebra and false color exposure 
overlays, operation status and setup menus. 

HD-SDI 

A 720p or 1080p progressive scan output suitable for monitoring or recording to an external VTR or DDR 
device. May be configured for 10-bit LIN (VIDEO) or 10-bit LOG (FILM) encoded data.  

HDMI 

A 720p or 1080p progressive scan output suitable for monitoring via a PC monitor or most HDTV displays.  
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Example of HDMI Monitor Output in MENUS mode. 

RED LCD / BOMB EVF® 

The optional RED LCD and BOMB EVF are specialized video monitors that provide the user with a variety 
of tools to assist framing, focus and exposure, including:  

- Surround View™, which is an additional look around area, visible outside of the recorded image.   

- Frame Guides, showing common film presentation and television aspects such as 2.40:1 and 16:9.  

- Focus, aided by high display resolution, 1:1 Focus Check function and False Color overlay. 

- Exposure, aided by dual Zebras, False Color overlay, RAW “Traffic Lights” and RGB histogram. 

- System information including current frame rate, ISO rating, shutter speed, color temperature, record 
resolution, record quality, clip name, timecode value and the remaining battery and media capacity.  

For applications where use of an attached RED EVF or RED LCD is not desired – for example when 
working on a crane – the VIEWFINDER / MENU output can be transferred to the HD-SDI or HDMI outputs, 
supporting remote camera monitoring up to 200 ft away. 
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REDMOTE® 

REDMOTE is a camera control unit for RED’s family of DSMC cameras that attaches to the rear of the 
camera Brain or rearmost expansion module. REDMOTE may also be detached from the camera or 
rearmost module and provide wireless remote control of the camera over proprietary REDlink™ protocol. 

Whether attached or operating via wireless, REDMOTE supports all controls necessary to operate the 
camera, including Record Start / Stop, Shutter Speed, White Balance, ISO and programmable User Keys. 
A color LCD displays critical camera parameters, including media and battery capacity, timecode and clip 
name, lens data and exposure information.. 

 

REDMOTE LCD display 

REDMOTE includes a rechargeable Li-Ion battery, which automatically re-charges when attached to the 
camera or rearmost module. It may also be re-charged by connecting to a USB 2.0 based power source 
such as a laptop PC or cell phone charger. Under typical operating conditions, REDMOTE should operate 
for up to 8 hours without requiring a re-charge and support a wireless communication range of 
approximately 50 ft. 

DIGITAL MAGAZINE (MEDIA) 

REDCODE RAW compressed MOVIE clips and STILL images; time code, multi-channel audio and 
metadata may be recorded to REDMAG 1.8” SSD solid-state digital media Magazine of 64GB, 128GB or 
256GB capacity. 

Each MOVIE clip is recorded with a unique name in a Clip folder with the extension .RDC. This folder 
contains all appropriate information describing the clip, including one or more REDCODE RAW.R3D files 
and all color grading metadata and other system level metadata such as lens and location information. 
Refer to CLIP NAMING CONVENTIONS. 

The individual Clip folders are placed into a Magazine folder (i.e. root directory) on the digital media. This 
Magazine folder has the extension .RDM. As this folder contains all the recorded Clips; copying all clips 
recorded on the SSD to other media may be performed by a drag and drop operation on the .RDM folder. 
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Typical Magazine Folder and clip structure  

For additional information about digital magazines, refer to APPENDIX B: MANAGING DIGITAL MEDIA. 

METADATA 

RED’s family of DSMC cameras record the Metadata, which is data for each frame of the recording:  

• Clip Name 

• Time Code 

• Date and GMT 

• Lens and shutter speed / 
angle parameters 

• Audio configuration 

•  Firmware version # 

• media serial # 

• LTC user bits (3 32-bit 
word reg-dump from ISP) 

• s4i static data 

• s4i dynamic data 

• GMT time/data 

• RGB curves 

• shadow control 

• Luma curve 

• Lens name, brand, ID, 
near focus, far focus 

• Camera Network Name 

• Production Name 

• Director Name 

• DP Name 

• Copyright 

• Unit 

• Camera Name 

• Location 

• Scene 

• Take 

• Accelerometer Data 

• Gyro Data 

CLIP NAMING CONVENTIONS  

When you press RECORD, the camera automatically creates a unique name for the CLIP being recorded 
to the REDMAG 1.8” SSD media. The format of this name is:  

Camera Letter + Reel Number + Month + Day      

e.g. A001_C002_0502**.RDC  
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Where: A = camera A, 001 = reel 001, C002 = clip 002, and 0502 = May 02, and the digits * * are two 
random characters generated by the camera to prevent any possibility of duplicate names being created. 

 

So a three Clip sequence of Clip Folders within a Magazine Folder on Camera A would look like this:  

A001_C001_0502**.RDC 

 

A001_C002_0502**.RDC 

 

A001_C003_0502**.RDC
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MULTI CAMERA SHOOTS 

The scheme provides flexibility to uniquely identify Clips from different cameras on a multi-camera shoot. 

For example three cameras, slated as camera A, camera B, and camera C respectively, can generate 
these easily recognizable clips on their respective digital media Magazines.  

A001_C001_0502**.RDC B001_C001_0502**.RDC C001_C001_0502**.RDC

3D (STEREO) CAMERA SHOOTS 

The scheme also allows unique identification of Clips from left and right eye cameras on a stereo shoot. 

For example two cameras, both slated as Camera S, can generate these easily recognizable clips on their 
respective digital media Magazines.  

S001_L001_0502**.RDC S001_R001_0502**.RDC

For more information refer to APPENDIX F: 3D SETUP / OPERATION > CLIP NAMING CONVENTIONS. 

SMPTE TIMECODE  

Time Code (TC) is a SMPTE timecode track that synchronizes to the camera’s high precision internal 
clock, or if operated in Jam Sync mode, references to an externally supplied SMPTE master timecode 
signal. TC is a sequential code that is continuous from frame to frame, but is discontinuous from clip to 
clip.  

Edge Code (EC) is a SMPTE timecode track that always starts at 1.00.00.00 on the first frame recorded to 
the digital media. It is a sequential code that is continuous from frame to frame and also continuous from 
clip to clip. EC is equivalent to RUN RECORD commonly found on broadcast cameras. 

Irrespective of the timecode mode selected, once recording starts the camera’s timecode counter will 
update at the same instantaneous frame rate as the recording. This ensures that a valid SMPTE timecode 
value is created for every frame in the clip, eliminating any timecode count jumps that could affect 
playback or editing.  

If operating in Jam Sync mode referenced to an external timecode source, the clip’s master time reference 
point is the first frame of the recorded clip. 

NOTE: When in Loop Record mode, Edge Code will also become discontinuous from clip to clip, 
because frames copied into the cache memory are discarded. This may lead to editing difficulties 
with postproduction applications that assume continuous timecode. 

POWER CONSUMPTION 

The camera draws approximately 60 watts when recording in 4K resolution, 24fps MOVIE mode. The 
camera is cooled by convection from the camera body assisted by a fan contained in a sealed air duct.  

Under typical operating conditions, a REDVOLT® battery will run the camera and accessories for about 30 
minutes and a REDVOLT® XL battery will run the camera and accessories for about 90 minutes. 
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CAMERA OPERATIONAL CONTROLS 

This section describes the available operational controls on the RED DSMC camera Brain, Side SSD 
Module, Side Handle and REDMOTE accessories. 

BRAIN 

 

 

Power / Record Button / Status LEDs 

• Power / Record Button: Powers camera Up / Down and initiates Record Stop / Start 

• Power Status LED: Indicates Power status: 

o LED Red = Power Present, Camera OFF 

o LED Yellow = Power present, Camera Booting  

o LED Green = Power present, Camera ON  

o LED Green Blinking = Power present. Running on Battery  

o LED Yellow Blinking = Power present. 5-10 minutes of Battery time left  

o LED Red Blinking = Power present. Less than 5 minutes of Battery time left  

A Power Status LED 

B Power / Record Button 

C Record Status LED 

A 
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• Record Status LED: Indicates record status: 

o LED Off = No Media present. 

o LED Green = Ready to Record  

o LED Red Constant = Recording  

o LED Red Slow Blink = Recording, 25% Media Left  

o LED Red Fast Blink = Recording, 5% Media Left  

o LED Yellow = Finalizing 

• Both LEDs: Indicates camera status: 

o Both LEDs Green Blink = firmware update in Progress 

SIDE SSD MODULE 

           

 

A SSD Slot 

B User Key 1 

C User Key 2 

D Focus / Record Button 

E Media Indicator 

Side SSD Module Controls 

B 

C 
A 

D 

FRONT REAR 

E 
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• SSD Slot: Slot for REDMAG 1.8” SSD digital media Magazine.  

• User Key 1: Initiates user defined camera function. Undefined by Default. 

• User Key 2: Initiates user defined camera function. Undefined by Default. 

• User Key 1 + User Key 2 : Press both keys to Eject (unmount) REDMAG 1.8” SSD Magazine. 

• Focus / Record Button: Touch for Auto Focus, fully depress to Start or Stop Record. 

• Media Indicator LED: Indicates status of media: 

o LED Off = No Media  

o LED Green = Ready to Record  

o LED Red Constant = Recording  

o LED Red Slow Blink = Recording, 25% Media Left  

o LED Red Fast Blink = Recording, 5% Media Left  

o LED Yellow = Finalizing  

o LED Yellow Blinking = Media Access (Format etc...) 
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SIDE HANDLE 

TOP 

 

A Battery Release D LCD Menu Keys 

B Focus / Record Button E LCD Display  

C Adjustment Ring F LCD Backlight Button 

RED Side Handle Controls - Top 

• Battery Door Release Button: Releases Side Handle battery door to permit battery exchange.  

• Focus / Record Button: Touch for Auto Focus, fully depress to Start or Stop Record. 

• Adjustment Ring: Selects and adjusts camera parameter values. Similar to the scroll wheel on the 
navigation group. 

• LCD Menu Keys:  The specific functions for each key are defined by the LCD screen. Defaults are: 

1 – ISO 2 – F-Stop 3 – Shutter Speed 4 – White Balance 

• LCD Display: Displays key camera parameter values.  

• LCD Backlight Button: Enables LCD backlight. 

Note: Side Handle controls can be locked/unlocked by holding the 1 and 4 buttons simultaneously.  

A 

B 

C 

D 

E 

F 
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FRONT 

 

 

A Stills / Movie Slider 

Side Handle Controls - Front 

• Stills / Movie Slider: Selects between STILLS and MOVIE modes of operation. 

NOTE: This switch is not active at this time. Default camera operation is MOVIE 

A 
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REAR 

 

RED Side Handle Controls - Rear 

A MENU Button D User Keys A-D 

B Rocker Switch E System Keys 1- 3 

C Navigation Group F Thumbwheel Lock 

• Menu Button: Press to access / camera setup menus.  

• Rocker Switch: Increases or decreases selected value based on parameter selected in USER KEYs.  

  

A 

B C 

D E 

F 
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• Navigation Group: Allows navigation through camera menus, selection of camera parameter for 
adjustment, and adjustment of selected camera parameter. 

 

Side Handle Navigation Group 

A Scroll Wheel B Direction Keys C Enter Button 

o Scroll Wheel: Selects and adjusts camera parameter value.   

o Direction Keys: Navigates camera menus and may select parameter for adjustment. 

o Enter Button: Confirms selected parameter value adjustment.  

• User Keys: User Function Keys A-D. The specific function of these keys may be programmed by the 
user. Default settings for User Function Keys A-D are as follow: 

- User Key A – Toggles Focus Assist indicator 

- User Key B –  Performs White Balance calculation.  

- User Key C – Toggles False Color > 1:1 Magnify  

- User Key D – Toggles False Color > Exposure Check 

• System Keys: Function is defined by System Firmware.  

- Upper: Toggles False Color > Exposure Check 

- Center:  Not currently defined 

- Lower: Ejects (unmounts) the currently selected Media 
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INSTALLATION / REMOVAL 

WARNING: THE SIDE HANDLE IS NOT HOT SWAPPABLE - MEANING YOU CANNOT REMOVE OR 
INSTALL WHILE THE CAMERA IS POWERED ON. BEFORE INSTALLING OR REMOVING THE SIDE 
HANDLE, YOU MUST POWER DOWN THE CAMERA. FAILURE TO DO SO MAY RESULT IN 
DAMAGE TO THE SIDE HANDLE AND / OR CAMERA BRAIN THAT IS NOT COVERED BY 
WARRANTY. 

To install the side handle: 

1. Power down the camera if necessary. 

2. Remove the brain side plate (if installed) by removing the single screw located at the bottom. 

3. Rotate upwards to disengage lip at top of side plate from camera brain. 

 

4. Insert the lip at the top of the side handle into the area where the lip from the side plate was installed. 

 

5. Rotate side handle down flush along side of camera brain. 

6. Rotate thumbscrew upwards until tight. Ensure side handle is secure to camera brain. You may have 
to apply steady pressure to get the screw started. 

  

Insert lip into top of 
camera brain. 

Press side handle flush 
against camera brain. 

Rotate thumbscrew 
upwards until tight. 
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To remove the side handle: 

1. Power down the camera if necessary. 

2. Rotate the thumbscrew downwards until detached from camera body. 

 

3. Rotate upwards and pull down to disengage lip at top of side handle from camera brain. 

4. Remove side handle from camera. 

  

Rotate thumbscrew 
downwards until loose. 

Rotate side handle 
upwards to remove. 

Disengage lip from top 
of camera brain. 
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DSMC MODULES 

REAR SSD MODULE 

The Rear SSD Module secures onto the back of the DSMC brain to serve as a rear location for 
recording onto 1.8" REDMAG SSD media. 
 

 

QUAD BATTERY MODULE 

• The QUAD MATTERY MODULE holds up to 4 REDVOLTs or 2 REDVOLT-XLs 

• Batteries may be hot swapped 

 

Quad Battery Module – Shown with REDVOLT batteries Installed 

Battery Eject 
Button 
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DUAL BATTERY MODULE 

• The DUAL BATTERY MODULE holds up to 2 REDVOLTs 

• Batteries may be hot swapped 

 

 

Dual Battery Module – Shown with REDVOLT batteries Installed 

MODULE INSTALLATION / REMOVAL 

To install a DSCM Module to the camera, an Adaptor Plate must be purchased separately. The following 
procedure details installation of the Adaptor Plate and DSMC Module.  

Install the Adapter Plate 

1. Power down the camera. 

2. Remove the REDMOTE. 

3. Place the adapter plate over the v-mount on the rear of the camera brain. 

 



  

COPYRIGHT © 2012 RED Digital Cinema 955-0003_v3.2, Rev-A1 
30 
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4. Using a T-20 Torx, lightly tighten the four screws. Do not over tighten. 

 

 

 

5. Tighten the screws again in a cross pattern until tight. 

 

ATTACHING THE DSMC MODULE 

WARNING: DSMC Modules are NOT hot swappable - meaning you cannot remove or install while 
the camera is powered on. Before installing or removing a Module, you MUST power down the 
camera. Failure to do so may result in damage to the Module and / or camera brain that is not 
covered by warranty. 

Quad Battery Module shown.  

1. Insert the lip at the top of the module into the recess at the top of the adaptor plate. 

 

1 

2 3 

4 
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2. Rotate module down flush with the rear of the adaptor plate. 

 

 

 

  

 
Insert Lip At Top of Adaptor Plate  

 
Rotate Module Down Until Flush 

with Adaptor 
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3. While applying steady pressure to hold the module against the adaptor plate, use a T-20 Torx 
screwdriver to rotate the lock on the adapter plate clockwise to secure the module. 

 

 

 

Installation is now complete.  

 

To remove the DSMC Module and Adaptor Plate: 

1. Power down the camera. 

2. Use a T-20 Torx screwdriver to rotate the lock on the adapter plate to the Unlock position. 

3. Rotate the module upwards and down to disengage lip at top of module from adaptor plate. 

4. Remove module from adapter plate. 

5. Use a T-20 to loosen the screws attaching the adaptor plate the camera brain. 

6. Remove the adaptor plate from the camera brain. 

REDMOTE 

This section describes the physical controls on the REDMOTE. For complete details on REDMOTE 
control, refer to APPENDIX E: REDMOTE OPERATION. 

IMPORTANT: For your REDMOTE to operate with this camera build version, ensure your REDMOTE 
has been upgraded to the latest firmware. Refer to APPENDIX E: REDMOTE OPERATION > 
MAINTENANCE > UPGRADING REDMOTE FIRMWARE. 

 

Rotate Lock Clockwise 
Until Red Dot Lines Up 

with Lock Icon 

Press Battery Module 
Flush with Adaptor 
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REDMOTE Controls 

A Still/Motion Slider F User Keys A-D K Soft Menu Keys 4-8 

B Release Button (L) G MENU Button L Power/Lock Slider 

C Record LED H Soft Menu Keys 1-3 M Release Button (L) 

D Power LED I Navigation Group N USB Connector 

E Rocker Switch J Focus / Record Button   

• Stills / Motion Slider: Allows selection of STILLS or MOVIE operational modes. 

• Rocker Switch: Provides continuous adjustment of parameter specified in USER KEYS menu. 

• User Keys: Press to initiate camera functions as defined in USER KEY menu.  

Default settings for User Function Keys A-D are as follow: 

- User Key A – Toggles Focus Assist Indicator 

- User Key B – Toggles False Color > RAW Check 

- User Key C – Toggles False Color > 1:1 Magnify.  

- User Key D – Toggles False Color > Exposure Check 

• Menu Button: Press to access / camera setup menus.  

• Soft Menus Keys 1-3: Below the LCD are three (3) Soft Menu buttons 1-3 (H) whose functions are 
defined on the LCD screen. For complete information refer to APPENDIX E: REDMOTE OPERATION > 
OPERATION > REDMOTE MENUS > SOFT MENU BUTTONS 1-3. 

C 

D 
A 

B 

E 

G 

F 

H 

J 

I 

N 

M 

K 

L 
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• Navigation Group: Allows navigation through camera menus, selection of camera parameter and 
adjustment of selected camera parameter. 

 

REDMOTE Navigation Group 

A Scroll Wheel B Direction Keys C Enter Button 

 

- Scroll Wheel: Selects and adjusts selected camera parameter value.   

- Direction Keys: Navigates camera menus and may select parameter for adjustment. 

- Enter Button: Confirms selected parameter value adjustment.  

• Focus / Record Button: Touch for Auto Focus, fully depress to Start or Stop Record. 

• Soft Menus Keys 4-8: To the right of the LCD are five Soft Menu buttons 4-8. These are pages 
displaying camera settings. For complete information refer to APPENDIX E: REDMOTE OPERATION > 
OPERATION > REDMOTE MENUS > SOFT MENU BUTTONS 4-8. 

• Power / Lock Slider: Slide and hold down for two seconds to power up / down REDMOTE and or 
camera. Slide up to lock keys. 

DISPLAYS 

BOMB EVF AND BOMB EVF (OLED) 

 

 

BOMB EVF is a high-definition, lightweight viewfinder that aligns quality performance with compact form 
factor. 

• Resolution: 1280 (wide) x 784 (high) full-color 
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• Contrast Ratio: 1000:1 typical 

• Available diopter range: +2.0 to -5.0.l 

 

RED BOMB EVF (OLED) brings advanced OLED technology into the field, providing truer blacks and more 
color accurate images  

• Resolution: 1280 (wide) x 1024 (high) full-color 

• Contrast Ratio: >10,00:1 typical 

• Available diopter range: +2.0 to -5.0.l l 

 

 

NOTE: The specific function of EVF user keys (B/C) may be programmed by the user. 

  

Focus Ring 

Brightness Controls 

Talley Light 

Focus Ring 

Brightness Controls 

Talley Light 

http://www.red.com/image/path/166/301001.jpg�
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TOUCHSCREEN LCD 

Red offers a five inch touch screen LCD with 800 X 400 resolution and 4:4:4 progressive scan. The 
touchscreen LCD allows navigation of camera menus and selection and adjustment of camera 
parameters by directly touching icons on the screen. Gestures supported include: 

• Tap: Tap on an icon to bring up a quick adjustment display.    

• Hold: Touch and hold on an icon to bring up an advanced interface display.  

• Slide: Touch and slide on an icon to increment a value. 

• Pinch: Touch with two fingers, then open or close to magnify or normalize the video image. 

 

 

RED 5” Touchscreen LCD Shown 

NOTE: Default functions shown. All keys may be programmed by the user. 

  

User Key 1 
1:1 Magnify 

User Key 2 
Exposure Check 

Backlight Adjust 
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BASIC OPERATION 

This section describes basic operation, starting from power up, Viewfinder layout and Menu navigation. 

WARNING: THE SIDE HANDLE, SIDE SSD MODULE, REAR MODULES AND LENS MOUNT ARE NOT 
HOT SWAPPABLE – MEANING YOU CANNOT REMOVE OR INSTALL THEM WHILE THE CAMERA IS 
POWERED ON. BEFORE INSTALLING OR REMOVING ANY OF THESE ACCESSORIES, YOU MUST 
POWER DOWN THE CAMERA. FAILURE TO DO SO MAY RESULT IN DAMAGE TO THE 
ACCESSORY AND / OR CAMERA BRAIN THAT WILL NOT BE COVERED UNDER WARRANTY. 

Power draw is prioritized as follows when multiple power sources are available to the camera.  

1. DC (Voltage) or Brick (%) 

2. Battery Module batteries 

3. Side Handle battery 

POWER SOURCES 

SIDE HANDLE 

The optional Side Handle accepts one REDVOLT. 

 

Side Handle Battery Compartment 
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QUAD BATTERY MODULE 

The optional QUAD BATTERY MODULE accepts up to four REDVOLT or up to two REDVOLT XL 
batteries, which can power the camera and typical accessories. 

 

Figure 16: Quad Battery Module 

REDVOLT AND REDVOLT XL 

 
REDVOLT and REDVOLT XL 

Note: When multiple batteries are installed in the Quad Battery Module, the power management circuit will 
select the lowest charged battery to supply power to the camera. On depletion, a battery may be ejected 
from the Quad Battery Module for re-charging, and a new charged battery may be inserted in its place. i.e. 
batteries may be hot swapped, there is no need for the operator to power down the camera to replace a 
REDVOLT battery when using the Quad Battery Module. 
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BACKPACK QUICKPLATE 

The optional BACKPACK QUICKPLATE attaches directly to the back of the DSMC BACKPACK to provide 
a compact REDBRICK configuration for EPIC or SCARLET-X. 

Note: DSMC BACKPACK is required for use of the BACKPACK QUICKPLATE 

 

 
BACKPACK QUICKPLATE 

 

 
REDBRICK 
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AC POWER ADAPTOR - (DSMC) 

 
AC POWER ADAPTOR - (DSMC)  

When powering from the Module it is called in the lower UI as Rear Module (RM Bx) Bay number on lower 
UI, and identified as Rear 1-4 in the POWER status menu. 

      

 

In use, an LED on the Quad Battery Module will flash to show the battery currently powering the camera.   

Current battery LED indicates status as follow: 

• LED Off = No Battery 

• LED Constant Green = Battery Not used but Charged 

• LED Green Blinking = Battery Used (100% - 11%) 

• LED Yellow Blinking = Battery has 10 minutes of run time remaining 

• LED Red Blinking = Battery has 5 minutes of run time remaining 

• LED Constant Red = Battery Discharged 

Remaining batteries will have a steady LED on module. 

When current battery reaches 4% charge, the battery module will automatically switch over another 
battery, by default the LOWEST charge capacity battery of the remaining batteries installed in the Module. 
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Battery location and status are displayed in the lower UI. In this case RM B1 (Rear Module, Bay 1). 

Battery location and status are also displayed on REDMOTE. In this case RM B3 (Rear Module, Bay 3). 

 

The POWER menu also shows all installed batteries and their state of charge. 

 

EXTERNAL DC POWER 

RED DSMC Cameras accept input voltages between 11.5V - 17V D.C and can draw a maximum current 
of 12 Amps. 

• An appropriate 150W supply with DC output rated at 15V 10A such as AC Power Adapter P/N 740-
0019 available from RED DIGITAL CINEMA. 

• RED Charger. For RED Charger you must use 2B-to-1B Power Adapter Cable P/N 790-0138. 

• RED BRICK® 140Wh batteries may be used with Backpack Quickplate, RED Quickplate, Battery Belt 
Clip, or RED Cradle via 2B-to-1B Power Adapter Cable P/N 790-0138. 

• 4-pin XLR DC power sources may be used with the camera via adaptor cable P/N 790-0164. 

  



  
 

955-0003_v3.2, Rev- A1 COPYRIGHT © 2012 RED Digital Cinema 
43 

POWER UP 

Locate the camera’s Power / Record button on the right face of the Brain.  

NOTE: This button also serves as a Record Start / Stop button once the camera is powered up. 

 

 

 

A Power Status LED 

B Power / Record Button 

C Media Status LED 

Power / Record Button / Status LEDs 

When an appropriate power source is connected to the Brain, the Power Status LED will illuminate Red. If 
it is illuminated, depress and then release the Power / Record button. The Power Status LED will initially 
go out and within 5 seconds illuminate Orange to confirm the camera is powering up, then it will illuminate 
Green, confirming the camera is powered up and ready to use. 

If a formatted REDMAG 1.8” SSD is attached to the Brain, once powered up the Media Status LED will 
illuminate Green. If this LED is not illuminated, verify a formatted REDMAG 1.8” SSD is inserted into the 
Side SSD Module and / or format the SSD if it has not previously been formatted on the camera. 
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NOTE: Once powered up, if the Power Status LED illuminates Red, it indicates low remaining 
battery capacity and a battery exchange or switch over to external DC power is recommended.  

POWER DOWN 

The camera can be powered down in two ways: 

1. Using REDMOTE or Side Handle Menu controls, or via Touch Screen LCD icons. Refer to 
SECONDARY MENUS > POWER. 

2. Depress and continue to hold the Power / Record button in its fully depressed position until the 
INITIATING CAMERA SHUTDOWN shows on the display. 

After Power Down, the Power Status LED will illuminate Red, if an appropriate power source is available. 
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GRAPHICAL USER INTERFACE AND NAVIGATION 

RED LCD/TOUCHSCREEN LCD, BOMB EVF, EXTERNAL MONITORS 

The following is a general description of the structure of the camera’s Graphical User Interface (GUI) which 
overlays the video monitor signal on the Viewfinder output(s) of the camera. 

 

 

 

 

GUI Display Elements 

The display elements include: 

• Frame Rate: Current frame capture rate 

• ISO Rating: Camera sensitivity  

• F Stop: Functional when optional mount and 
lens are installed 

• Shutter Speed: Exposure Time (or Degrees) 

• White Balance: Color Temp 

• Resolution Record Resolution 

• Quality: REDCODE setting 

• Lens Info: Lens information when using 
specific Canon or Cooke lenses. 

• Cursors: Reference cursors – Safe Action / 
Safe Title, Picture Center, Grid Overlay 

TIMECODE 

ISO RATING WHITE BALANCE SHUTTER SPEED 

RESOLUTION /  
PROJECT 
FRAME RATE / 
QUALITY 

FRAME RATE 

MEDIA 
SOURCE / STATUS 

AUDIO METER 

HISTOGRAM 

RAW CLIP 
METER 

POWER 
SOURCE / STATUS 

NEXT CLIP 
FILENAME 

FRAME GUIDE 

PICTURE CENTER / SPOT FOCUS 

TITLE GUIDE 

ACTION GUIDE 

RAW NOISE 
LEVEL BAR 

RAW CLIP 
LEVEL BAR 

RESOLUTION 

FALSE COLOR MODE 

HDRx MODE 

QUALITY 

TEMPERATURE 

DROP 

SHUTTER SYNC 

GENLOCK 

MAGNIFY 

TC 
REDMOTE 

LAN 

RIG STATUS 

FAN 
SPEED 

F STOP 

OVERLAY GRID 

LENS INFO 
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• Frame Guide: Record or Projection area 

• Next Clip Filename: Filename of the clip that 
will be shot next 

• Project Frame Rate: Current project TIME 
BASE  

• Noise Level Bar: Relative number of RAW 
pixels in noise 

• Histogram: RGB Histogram. 

• Clip Level Bar: Relative number of RAW 
pixels near clip 

• Clip Meter: RGB sensor RAW clipping status 

• Temperature: Displays camera sensor and 
core temperature  in that order (xx/xxC) 

• Drop: Indicates if any frames were dropped 
during recording of the clip 

• Fan Speed: Displays fan speed in % 

• HDR Mode: Displays HDRx mode status 

• False Color Mode: Displays false color 
overlay mode 

• Magnify: Tallies 1:1 if magnify is selected 

• TC: Indicates presence of valid SMPTE 
timecode signal and Jam Sync status 

• Genlock: Indicates presence of valid 
Genlock signal / sensor sync to genlock 

• Shutter Sync: Indicates shutter sync status 

• RM: Indicates communication to REDMOTE  

• LAN: Indicates communication via Ethernet 
connection 

• RIG: Indicates 3D rig metadata is present 

• Media Status: Media location and remaining 
media capacity in % 

• Power: Indicates D.C supply voltage or % of 
remaining battery capacity Including current 
supply voltage 

• Audio Meter:  Audio input selection  and 
levels 

• Timecode: Current timecode value 

• Menu ICON  : In the upper Right corner 
on the touchscreen LCD -  Opens the 
Secondary Menus 

• Playback ICON : In the upper Left corner 
on the touchscreen LCD - Accesses the 
Playback Function 
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The GUI is broken down into the following three main sections: the Upper Status Row, the Live Action 
Area, and the Lower Status Row. On VIEWFINDER output(s), all three sections are visible, on PREVIEW 
outputs only the Live Action Area and associated graphic overlays are visible. On PROGRAM outputs, 
none of the graphic overlays are visible, i.e. a PROGRAM output is defined to be a CLEAN FEED output. 

UPPER STATUS ROW 

 

Provides immediate feedback on the most critical image composition parameter settings, including (from 
Left to Right):   

• Playback Access (Touchscreen) 

• Current frame capture rate  

• ISO Rating  

• Shutter Speed (or Shutter Angle) 

• White Balance 

• Record Resolution  

• Record Quality 

• Secondary Menus Access (Touchscreen)  

Whichever parameter is underlined with a red bar may be immediately adjusted by pressing ENTER in the 
Navigation Group of the Side Handle or REDMOTE, then using the Scroll Wheel to change the value of 
that parameter. To confirm the parameter change press ENTER a second time. 

NOTE: Shutter angle is displayed in Relative mode by default, as indicated by Yellow text. 

If the red bar is not on the parameter you wish to change, first use the Scroll Wheel to position the red bar 
under that parameter, then press ENTER, adjust with the Scroll Wheel and press ENTER a second time to 
confirm the value change. 

 
In the above GUI example, the Scroll Wheel has been used to move the red cursor to the Shutter Speed 
parameter; and the ENTER key has been pressed. This reveals the Parameter Adjust Widow. Adjust the 
value using the Scroll Wheel and then press ENTER to confirm the value change, then close the sub-
menu. 
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LIVE ACTION AREA 

Contains the recorded image area plus Surround View™ look around area, plus overlays for Frame Guide, 
Safe Action / Safe Title and the current Clip Name and Timecode values. Each overlay may be color 
coded in one of 5 colors to maximize the contrast between the guide(s) and scene being captured.  

 

LOWER STATUS ROW 

 
The Lower Status Row provides feedback on key systems level camera values, including:  

• Clip Settings 

• Exposure (Histogram)  

• Temperature, Power and Sync  

• Media Status 

• Power Status 

• Audio Levels 

ICON BEHAVIOR 

TC 

• TC Gray - No analog time code is currently detected. 

• TC Red - Analog time code is being detected, but the use of it is not enabled.  

• TC Green - Analog time code is being used to jam the time of day time code. TC will revert to gray if 
the signal is no longer detected. 

GEN 

• GEN Gray - No genlock signal is currently detected. 
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• GEN Green - A genlock signal compatible with the current project and monitor rates has been locked 
to. 

SYNC 

• SYNC Gray - The sensor sync mode is not Genlock. 

• SYNC Red - The sensor sync mode is Genlock, but it is not locked to any genlock signal. 

• SYNC Green - A genlock signal compatible with the current project and monitor rates has been locked 
to and the sensor timing is also locked to it. 

POWER STATUS 

If powering camera through DC power, the current voltage will be displayed. 

 
If using a REDBRICK or similar external battery to power the camera through DC IN, power status 
displays the current supply voltage available from the battery. Supply voltage decreases as battery is 
discharged, the displayed text is color coded as follows: 

• Green = 12.0 V and up • Yellow = 11.9 – 11.8 V • Red = 11.7 – 11.6 V 

NOTE: The camera will automatically power down if supply voltage drops to 11.5 Volts. 

If using a REDVOLT battery in the Side Handle or Battery Module to power the camera, power status 
displays the location of the power source (example: SH: Side Handle; RM: Rear Module) and reports the 
remaining battery capacity and the displayed text is color coded as follows: 

• Green:  >10 minutes • Yellow: 5-10 minutes • Red: <5 minutes 

 

 

If using a RED BRICK battery connected to DC IN, power status displays BRICK and reports the % of 
remaining battery capacity and the displayed text is color coded as follows: 

• Green:  >10 minutes • Yellow: 5-10 minutes • Red: <5 minutes 
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RAW CLIP METER 

The RAW Clip meter looks a traffic light style meter and indicates if either of the Red, Blue or 
Green channels of the RAW sensor data are clipping. This meter is unaffected by White Balance, 
ISO, VIEW or LOOK settings and therefore represents a true measurement of the exposure 
levels of the sensor at all times. 

RAW NOISE LEVEL BAR 

The RAW noise level bar displays the amount of pixels in the image that are in noise. For example, if the 
bar is about 1/8 of the total height, this would indicate approximately 1/8 of the total pixels in the image 
are at an exposure level at risk of displaying noise when pushed at higher ISO or FLUT values in post-
production. 

 

RAW CLIP LEVEL BAR 

The RAW clip level bar displays the amount of pixels in the image that are clipping. For example, if the bar 
is about 1/4 of the total height, this would indicate approximately 1/8 of the total pixels in the image are at 
an exposure level at risk of clipping and may not be recoverable by lowering ISO or FLUT values in post-
production. 

 

  



  
 

955-0003_v3.2, Rev- A1 COPYRIGHT © 2012 RED Digital Cinema 
51 

SIDE HANDLE 

 

As you navigate and adjust settings on the camera (main menu settings only), they will be reflected on the 
Side Handle LCD display. 

The display elements include: 

• Power: Camera power status (DC Shown) 

• Frame Rate: Image capture rate 

• Resolution Recording Resolution 

• Quality: REDCODE setting 

• ISO Rating: Camera sensitivity 

• Shutter Speed: Exposure Time (or Degrees) 

• White Balance: Color Temp

REDMOTE 

 

The display elements include: 

• Camera ID: Displays camera ID (DEFAULT 
shown) 

• Wireless Status: Displays signal strength 
when connected wirelessly 

• Battery Indicator: Displays battery life or 
charge status (shown) of REDMOTE 

• Resolution Recording Resolution 

• Quality: REDCODE setting 

• Frame Rate: Image capture rate 

• ISO Rating: Camera sensitivity  
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• Frame Rate: Current frame capture rate 

• Shutter Speed: Exposure Time (or Degrees) 

• White Balance: Color Temp 

• Resolution Record Resolution 

• Quality: REDCODE setting 

• Clip Filename: Filename of the clip that will 
be shot 

• Project Frame Rate: Current project TIME 
BASE  

• Clip Meter: RGB sensor RAW clipping status 

• HDR Mode: Displays HDRx mode status 

• False Color Mode: Displays false color 
overlay mode 

• Magnify: Tallies 1:1 if magnify is selected 

• TC: Indicates presence of valid SMPTE 
timecode signal 

• Gen: Indicates presence of valid Genlock 
signal 

• Sync: Timecode Jam Sync status 

• RIG: Indicates 3D rig metadata is present 

• LAN: Indicates communication via Ethernet 
connection 

• Media Status: Media location and remaining 
media capacity in % 

• Power: Indicates D.C supply voltage or % of 
remaining battery capacity Including current 
supply voltage 

• Audio Meter:  Audio input selection  and 
levels 

• Timecode: Current timecode value  

• Histogram: Displays histogram 

NAVIGATING MENUS 

The primary method to navigate Menus is via the Scroll Wheel on the REDMOTE or Side Handle. Rotate 
clockwise to move right, counter clockwise to move left. However, the Left and Right direction Navigation 
Keys (REDMOTE or Side Handle) or Adjustment Ring (Side Handle) may also be used for this purpose.  

The Up and Down direction Navigation Keys provide additional navigation functions when pressed: 

UP Selects Advanced Settings menu. 

DOWN Selects standard Settings menu. 

 

As an example, position the Cursor under the Shutter Speed (24FPS) icon and press the UP Direction Key 
to access advanced adjustment values for Shutter Speed. 



  
 

955-0003_v3.2, Rev- A1 COPYRIGHT © 2012 RED Digital Cinema 
53 

USING TOUCHSCREEN LCD 

If operating a Touchscreen LCD, camera menu navigation may be made through finger gestures. 

 

• To adjust a parameter value, simply touch it, and then swipe the finger left / right to adjust its value.  

• To access an advanced parameter settings display, press and hold down on the parameter icon.  

• Touch anywhere outside the overlay windows to enter the value changes and to hide the sub-menus. 

• To enter the Secondary Menus, touch the MENU icon. 

 

• To return to the Main Menus, touch the MENU icon again. 

• To access the Playback function, touch the arrow. 

 

• To exit the Playback function, touch the circle. 
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TOUCHSCREEN SHORTCUTS 

The bottom portion of the touchscreen contains shortcuts to the most-used camera screens. 
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POWER DOWN 

NOTE: Camera will automatically power down if supply voltage drops to 11.5 Volts. 

POWER MENU 

1. Select the MENU icon  in the right corner of the Upper Status Bar to reveal the Secondary 
Menus. 

2. Select POWER. 

3. Select SHUTDOWN. 

4. The camera will immediately power down. 

 

USING POWER STATUS DISPLAY 

1. Select the POWER status located between the audio channels and media remaining indicator, to 
reveal the same menu illustrated above.  

 

2. Select SHUTDOWN.  

3. The camera will immediately power down. 
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LOCK / UNLOCK TOUCHSCREEN OPRERATION 

LOCK 

To lock out the touchscreen operation, touch and hold the MENU icon  until the LOCK icon  
displays; indicating the touchscreen has been locked out. When locked, the main menu will be displayed. 

 

UNLOCK 

To unlock out the touchscreen and allow normal operation, touch and hold the LOCK icon  until the 

MENU icon  displays; indicating the touchscreen has been unlocked. 
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FIRST TIME USE – SETTING UP YOUR RED EPIC 

ATTACH POWER SOURCE 

If a REDVOLT battery is installed in the Side Handle and DC power is connect through the DC IN 
connector, the DC IN power supply has priority and will power the camera instead of the battery. 

BATTERY 

Connect a RED battery to the camera in one of the following ways: 

SIDE HANDLE 

Attach a Side Handle and insert a REDVOLT battery. 

INSTALL 

 

1. Press the battery door release button (A). 

2. Open battery door (B). 

3. Press upwards on retainer (C). 

4. Insert a REDVOLT battery until it is fully seated and retainer (C) clicks into place. 

5. Close battery door. 

A 

B 

C 
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REMOVE 

1. Press the battery door release button (A). 

2. Open battery door (B). 

3. Press upwards on retainer (C) to release battery. 

4. Remove battery from side handle.  

QUAD BATTERY MODULE 

Attach a Quad Battery Module and insert one or more REDVOLT batteries. 

INSTALL 

Insert battery into desired location and press until a click is heard and battery is seated. 

REMOVE 

 

1. Press the battery eject button (A) for desired battery. 

2. When battery pops out, remove battery from battery module (B).  

 

B 

A 

B 
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RED BRICK 

Attach to the camera using a V-Plate and 2B-to-1B Power Adapter Cable P/N 790-0138 to the DC IN 
connector. 

DC POWER 

Connect a DC power source to the camera in one of the following ways: 

• Plug the RED AC Power Adapter into AC power, and the LEMO connector to the DC IN connector. 

• Plug the RED CHARGER into AC power, and the LEMO connector to the DC IN connector via 2B-to-
1B Power Adapter Cable P/N 790-0138. 

• Plug a 12V XLR based power source into the DC IN connector via adaptor cable P/N 790-0164.  

NOTE: The maximum sustainable power load of the DSMC AC Power Adapter is 150W (15V@10A). 
The output of the adapter is over current protected, and will shut down if an excess load condition 
occurs. If the output trips for any reason, remove any external loads from the camera, such as 
lights, motors etc, turn off the Adapter and repeat the above procedure. 

POWER UP 

Locate the camera’s Power ON / OFF button on the right face of the Brain. If the Power Status LED is 
illuminated Red, depress and then release the Power / Record button. If not illuminated, check your 
battery charge status or external power source cable connection. Once powered up the Power Status 
LED will illuminate Green, confirming the camera is ready to use. 

PREPARING TO RECORD 

Before each days recording, the camera should be prepared as follows:  

- Physically set-up camera as desired. 

- Verify camera is using the latest firmware version at www.RED.com/support and if appropriate, 
upgrade the camera firmware. Refer to APPENDIX A: UPGRADING CAMERA FIRMWARE. 

- Insert a blank (or previously used but erasable) REDMAG 1.8” SSD and format it. 

- Perform a BLACK SHADING CALIBRATION of the Sensor. 

- Check your PROJECT SETTINGS (Time Base, Record Resolution, Record Quality, etc.).  

- Frame, focus and record. 

CONNECT AND FORMAT MEDIA 

Identify a REDMAG 1.8” 64GB, 128GB or 256GB SSD that has not previously been recorded to, or is not 
a camera master and may therefore be erased and re-used. Aligned the RED logo of the SSD to the 
outside, and then push the SSD firmly, but without excessive force, into the slot in the Side SSD Module. 

http://www.red.com/support�
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NOTE: When fully inserted, the SSD media protrudes slightly from the SSD slot as indicated above.  

When SSD media is inserted into the camera, the camera will recognize if the media is unformatted: 

- On LCD, EVF and external monitors, in the media section of the GUI, NONE will be displayed twice (as 
opposed to when no media is inserted, the GUI displays NONE with three dashes below “---“). 

- On REDMOTE, NONE will be displayed twice (as opposed to when no media is inserted, the GUI 
displays NONE with three dashes below “---“). 

- On the Side Handle, NA will be displayed (same as if no media is present). 

To format the media select SECONDARY MENUS > MEDIA > FORMAT MEDIA. 

 

When FORMAT is selected, a FORMAT dialog box will appear allowing you to add Camera Identity and 
3D Position properties when formatting. When desired options are set, select FORMAT. 

NOTE: If any clips will be erased on the attached media, you will be informed of the number. 
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PERFORM A BLACK SHADING CALIBRATION 

Refer to SECONDARY MENUS > SETTINGS > MAINTENANCE > CALIBRATION for complete details for 
performing a Black Shading Calibration. 

ADJUST PROJECT SETTINGS 

TIME BASE 

To adjust the project TIME BASE, press the MENU button on the Side Handle or REDMOTE. Then use the 
Scroll Wheel or Direction Keys to navigate to SETTINGS > PROJECT > TIME BASE and press ENTER. 
Adjust to the desired value using the Scroll Wheel and press ENTER once more to confirm. 

 

If using a Touch Screen, select SECONDARY MENUS > SETTINGS > PROJECT > TIME BASE. Adjust by 
sliding your finger up / down or tapping on the desired value, and then press anywhere else on the touch 
screen to confirm. 

The following TIME BASES are currently available: 

• 23.98 fps 

• 24.00 fps 

• 25.00 fps 

• 29.97 fps 

• 47.96 fps 

• 48.00 fps 

• 50.00 fps 

• 59.94 fps 

NOTE: A project can only support one Time Base as this defines the frame count to be used for 
time code and as the clip playback and editing frame rate. It is also the primary frame rate for 
acquisition, but variable speed (over-crank and under-crank) recordings can be made above and 
below this base frame rate using the VARISPEED menu. 
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RECORD RESOLUTION 

 

To adjust Record Resolution, navigate the Cursor to the RESOLUTION icon in the Upper Status Row and 
press the Navigation Group ENTER key. Adjust to the desired value using the Scroll Wheel and press 
ENTER a second time to confirm.  

If using a Touch Screen, press the RESOLUTION ICON, adjust RESOLUTION by sliding your finger left / 
right, or tap on the desired resolution, and then press anywhere else on the touch screen to confirm. 

The following Recording Resolutions are currently available: 

• 5K 

• 5K HD 

• 5K 2:1 

• 5K WS 

• 5K ANA 

• 4K 

• 4K HD 

• 3K 

• 3K HD 

• 2K 

• 2K HD 

• 2K WS 

• 1K HD 

• 1K WS 

RECORD QUALITY (REDCODE) 

Allows adjustment of REDCODE settings. 

 

Range is 3:1 to 18:1 

Default is 8:1 

Use the scroll ribbon to select a target REDCODE compression ratio. 

The camera will automatically select the closest REDCODE to the desired target. 

The display will always show the "current" compression ratio being used by the camera. 

If the camera is able to achieve the desired target compression ratio, it will be displayed in white.  If the 
camera is unable to achieve the target compression ratio, it will be displayed in yellow. 

The current compression ratio will automatically be re-calculated when changes are made to Resolution, 
FPS, HDRX Mode, Media, or Target REDCODE. 
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CAMERA ID (SLATE) 

If operating on a multi-camera production, enter a different Camera ID for each camera; otherwise skip 
this step; the camera is ready to shoot. 

The Camera ID is set when the media is formatted. Refer to ADVANCED MENU > MEDIA for details. 

RECORDING 

Ensure a formatted REDMAG 1.8” SSD is inserted in the camera’s Side SSD Module, then fully depress 
any one of the RECORD buttons located on the Brain, Side SSD Module, Side Handle or REDMOTE. 

Fully depress again to stop recording. The camera will automatically create a unique and sequential file 
name for each clip recorded on the SSD based on the Camera’s I.D set in the MEDIA menu.  

REDCODE RAW data recordings store the Color Temperature and Exposure (ISO) and any RGB color 
processing values you use in the monitor path as metadata. This metadata is used in REDCINE-X or other 
post-production software as initial white balance, exposure and color correction points however, you are 
free to change these values at any time when you process the RAW footage.  

Time Code and Edge Code values used by the camera are Non Drop Frame (NDF); Drop Frame (DF) is not 
supported. Audio is captured uncompressed at 24-bit resolution, 48KHz sample rate per channel. 

Digital media such as REDMAG 1.8” SSDs are very robust, but should be treated with equal care as 
exposed film or a videotape master. We recommend storing digital media that contains your footage in a 
secure location and backing up the data to a digital archival media, such as data tape or hard disk drive. 

RECORD INDICATOR  

When recording, the RED DSMC camera provides a variety of record indications (tallies): 

- Timecode, normally displayed in white colored text, will be displayed in red colored text. 

- A small Red dot will appear in the top right corner of the VIEWFINDER output(s). 

 

- The REC LED on the right side of the camera Brain will illuminate Red.  

- REDMOTE upper LED will illuminate Red, and the Timecode will turn Red. 
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- If using a BOMB-EVF, the LED on the front will illuminate Red if Tally is enabled 

- SMPTE-RP188 timecode VITC-2 HANC metadata record flag will be enabled on HD-SDI outputs. 

- If enabled in the USER KEYS menu, the GPO trigger output in the CNTL connector will pulse. 

PLAYBACK 

Playback is available on the RED DSMC Camera by going to SECONDARY MENUS > SETTINGS > 
PLAYBACK or by touching the Playback arrow icon in the upper Left corner of the GUI. 

 

The Playback function will display. 

 

For complete details, go to SECONDARY MENUS > SETTINGS > PLAYBACK. 
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MENU CONTROLS 

Displayed in the Upper Display Group of the VIEWFINDER output(s), are FRAMERATE (FPS), EXPOSURE 
(ISO), _._ (F/Stop), WHITE BALANCE, RESOLUTION, and QUALITY (REDCODE). These parameters are 
adjustable directly through this screen. When using the touchscreen, directly to the right of these 
parameters is the MENU icon  which when pressed will take you to the secondary camera set up 
menus. 

 

ADJUSTMENTS 

BASIC SETTING ADJUSTMENTS 

SIDE HANDLE / REDMOTE 

• The MENU button can be used to ENTER the secondary menus, as well as CANCEL inside lists and 
for navigating back up menus. 

• Navigate to the desired setting using the NAVIGATION GROUP direction keys and press ENTER. 

• Use the Scroll Wheel or Adjustment Ring to increase or decrease the parameter value.  

• When the desired value has been selected, press ENTER to set. 

BASIC ADJUSTMENTS USING SIDE HANDLE ONLY 

Although not recommended, the Side Handle can be used stand alone to make basic adjustments to FPS, 
ISO, Shutter Speed, Resolution and REDCODE located on the Main Menu screen. Use the Navigation 
Group to make these adjustments while watching the cursor placement under the desired setting on the 
side handle LCD. When desired setting is selected, press the Enter button to access, then use the Scroll 
Wheel, Directional Pad or Adjustment Ring to make changes. When done, press the Enter button again to 
set the changed parameter. The MENU button can be used to ENTER the secondary menus, as well as 
CANCEL inside lists and for navigating back up menus. 

TOUCHSCREEN 

• The MENU ICON can be used to ENTER the secondary menus, as well as CANCEL inside lists and for 
navigating back up menus. 

• Touch the desired parameter for adjustment. 

• Slide your finger across the screen to scroll through the available parameter values. 

• When desired the parameter value has been selected, touch anywhere in the screen area to set. 
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• To close an alpha numeric keypad when entering information directly, tap anywhere on the screen 
outside the keypad. 

ADVANCED SETTING MENUS 

At this time, only FRAMERATE, F-STOP, SHUTTER SPEED and WHITE BALANCE on the MAIN MENU 
have advanced settings 

SIDE HANDLE / REDMOTE 

1. Navigate to the desired setting using the NAVIGATION GROUP direction keys and then press the UP 
directional key.  

2. Use the direction keys to navigate to the desired parameter adjustment field and press ENTER to 
confirm. 

3. Use the Scroll Wheel to adjust the selected parameter value.  

4. When desired selection is made, press the MENU button to set. 

TOUCHSCREEN 

1. Press and hold the desired parameter to gain access to advanced setting adjustments. 

2. Press the field - a keypad type menu may appear to allow adjustments. 

3. Press the desired parameter settings to adjust. 

4. When desired selection is made, press anywhere in the screen area to set and exit the advanced 
settings submenu. 
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MAIN MENU 

Available options under the MAIN MENU are FRAMERATE (FPS), ISO (SENSITIVITY), F STOP, 1/SEC 
(EXPOSURE), WHITE BALANCE, RESOLUTION, and QUALITY (REDCODE). 

 

FPS 

If using a Touch Screen, select SECONDARY MENUS > SETTINGS > PROJECT > TIME BASE. Adjust by 
sliding your finger up / down or tapping on the desired value, and then press anywhere else on the touch 
screen to confirm. 

The following TIME BASES are currently available: 

• 23.98 fps 

• 24.00 fps 

• 25.00 fps 

• 29.97 fps 

• 47.96 fps 

• 48.00 fps 

• 50.00 fps 

• 59.94 fps 

NOTE: A project can only support one Time Base as this defines the frame count to be used for 
time code and as the clip playback and editing frame rate. It is also the primary frame rate for 
acquisition, but variable speed (over-crank and under-crank) recordings can be made above and 
below this base frame rate using the VARISPEED menu. 

VARISPEED 

When a frame rate other than the current TIME BASE has been selected, the FPS text will turn Yellow 
and VARISPEED will be shown where the Audio Meter is normally displayed at the lower right of the 
display. 
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BASIC SETTINGS  

Provides quick selection of the most common VARISPEED frame rates. 

 

ADVANCED SETTINGS 

 
When selected a numerical keypad will appear allowing the desired VARISPEED Framerate to be 
entered in 1 fps increments. Maximum frame rate is a function of RECORD RESOLUTION and 
REDCODE settings. Granularity is 0.001 FPS. 

 

On Touchscreen systems, a Keypad is available for direct numeric entry of the VARISPEED FPS value. 
Touch the value bounded by the + and – labels to bring up, press outside the keypad to confirm the 
value. 
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ISO (SENSITIVITY) 

Adjusts the camera’s ISO rating. The sensitivity value is adjustable in 1/3rd stop increments. When the 
ISO rating is adjusted, the camera logs the change as metadata and the monitor path reacts 
accordingly. Higher ISO values lead to brighter images in the monitor path, and vice versa. 

 

Range is ISO 250 – 12800  

Default is ISO 800 

F STOP 

Aperture controls the depth of field of the subject imaged by the camera, and in combination with the 
shutter speed / angle setting controls the amount of light falling on the sensor. i.e. exposure. Increasing 
the F stop to a higher number reduces exposure as well as increases the depth of field, decreasing the F 
stop to a lower number increases the exposure and decreases the depth of field. You can chose either 
1/3 or 1/4 stops. 

 

RED DSMC Ti PL Mount Installed 

When a lens equipped with Cooke’s S4/i system is attached to the DSMC Ti PL Mount, the camera will 
display the current aperture (F stop) of the attached lens. This is for information only and on-camera 
adjustment is NOT available, manual adjustment only as indicated by being Grayed out. 

 

DSMC Canon Mount Installed 

This menu will appear when a DSMC Canon Mount is installed and a Canon EF or EF-S Lens or 
equivalent is attached (a Non-Canon EF or EF-S Lens may not function as smoothly or accurately). 
Adjusts the aperture (F stop) of the attached lens. 

The attached lens for the example shown is a Canon EF 24-70mm. 
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BASIC SETTINGS 

Allows adjustment of the aperture (F stop) of the attached lens. The range will vary depending on the 
attached lens. 

 

ADVANCED SETTINGS 

When selected, the advanced settings menu allows fine control over the f-stop value under APERTURE 
and focal distance under FOCUS. 

 

APERTURE (F STOP) 

Provides the ability to enter the F stop value directly. 

Range depends on attached lens. 

Default depends on attached lens. 
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FOCUS 

Provides the ability to enter the focal distance directly. 

Range depends on attached lens. 

Default depends on attached lens. 

 

EXPOSURE 

BASIC SETTINGS 

Adjusts the exposure of each frame captured by the MYSTERIUM X sensor. Shutter speed presets are 
provided for all common speeds (and shutter angles) for 24 / 25 fps and 50 / 60 fps project frame rates. 

 

Decreasing Shutter Speed increases the amount of time over which light falls on the sensor, increasing 
exposure and motion blur on any objects moving within the frame. Increasing Shutter Speed shortens 
the amount of time over which light falls on the sensor, decreasing exposure and motion blur on objects 
moving within the frame. 

Range is 1/24th sec – 1/8000th sec - Slowest available speed is 1 second per frame / frame rate, so for 24 
fps it is 1/24th sec. 

Default is 1/48th Sec. 
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ADVANCED SETTINGS 

When selected, the advanced settings menu allows fine control over the Exposure value, and permits 
entry in any of the three following common units – EXPOSURE (Shutter Speed), INTEGRATION TIME or 
ABSOLUTE ANGLE (Shutter Angle). 

 

EXPOSURE (SPEED) 

Provides the ability to enter the Exposure value as a Shutter Speed (1/xx sec). 

Range is 2 – 1/8000th Sec - Slowest available speed is 1/frame rate, so for 24 fps it is 1/24th Sec. 

Default is 1/48th Sec. 
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INTEGRATION TIME 

Provides the ability to enter the Exposure value as a Shutter Integration Time (xx milliseconds). 

Range is 0.125 to 41.708 mS (milliseconds) 

Default is 20.833 MS 

 

ABSOLUTE ANGLE 

Provides the ability to enter the Exposure value as a Shutter Angle (xx Degrees). 

Range is 1.000 to 360.000 Degrees 

Default is 180.0 Degrees 

 

As you adjust any of these three parameters, the camera will automatically calculate the equivalent value 
in the other units, but as a quick reference here are some common Speeds and Angles. 
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To Convert Shutter Speed to Angle Equivalent:  

 Equivalent Degrees = (Shutter Speed x Frame Rate x 360)  

 E.g. = (1/48 x 24 x 360) = (8640/48) = 180 

 

SHUTTER DEGREES SHUTTER DEGREES 

1/32 270 1/120 72 

1/48 180 1/192 45 

1/50 172.8 1/348 22.5 

1/60 144 1/696 11 

1/96 90 1/1000 8.6 

 

 Equivalent Shutter = 1 / (Frame Rate x 360 / Angle)  

 E.g. = 1/ (24 x 360/180) = 1/ (8640/180) = 1/48    

 

DEGREES SHUTTER DEGREES SHUTTER 

270 1/32 72 1/120 

180 1/48 45 1/192 

172.8 1/50 22.5 1/348 

144 1/60 11 1/696 

90 1/96 8.6 1/1000 

WHITE BALANCE 

BASIC SETTINGS 

Allows you to manually set Color Temperature in the range from 1,700 to 100,000 KELVIN. 

 

Range is 1,700 K to 10,000 K. 

Default is 5600K. 

  



  
 

955-0003_v3.2, Rev- A1 COPYRIGHT © 2012 RED Digital Cinema 
75 

ADVANCED SETTINGS 

When selected, allows additional adjustment of the White Balance. Available options are PRESET, 
COLOR TEMP, TINT, and CALCULATE WHITE BALANCE. Press APPLY PRESET for settings to take 
effect. 

 

PRESET 

Available preset options are: 

SHADE 

Preset to 9,000K 

CLOUDY 

Preset to 7,500K 

DAYLIGHT 

Preset to 5,600K 

FLASH 

Preset to 5,500K 

FLOURESCENT 

Preset to 4,500K 

TUNGSTEN 

Preset to 3,200K 

INCANDECENT 

Preset to 2,800K 

 

COLOR TEMP 

Allows you to manually set Color Temperature in the range from 1,700 to 100,000 KELVIN. Default is 
5600K. 

 



  

COPYRIGHT © 2012 RED Digital Cinema 955-0003_v3.2, Rev-A1 
76 

TINT 

Color Temperature calculations assume a pure light source that may not be true in the specific scene 
the camera is imaging. To compensate for any residual colorcast, the TINT parameter can adjust the 
RGB color balance with a compensating Magenta - Green color component. Default is 0.000. When 
selected, a secondary keypad will appear allowing you to enter the desired Tint value directly. 

NOTE: Selecting Calc White Balance calculates a new Tint value. This is maintained if the Color Temp is 
adjusted via the Color Temp parameter. If you select ANY presets, Tint will be reset to zero, which is the 
default value. 

 

CALC WHITE BALANCE 

The Calc White Balance function analyzes the central 25% of the image visible in the monitor to 
calculate a Color Temperature that will render a white object as white. 

 

To use Calc White Balance function, place a White or Gray object under the ambient light, select the 
Calc White Balance function and then press the Calc White Balance function box. Calc White Balance is 
also assigned to a User Key on the REDMOTE and Side Handle as a factory default setting. 
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RESOLUTION 

Allows adjustment of resolution. 

 

Default is 5K 2:1 

FORMAT WIDTH (PX) HEIGHT (PX) 

1K WS 1280 480 

1K HD 1280 720 

2K WS 2048 854 

2K HD 1920 1080 

2K 2048 1080 

3K HD 2880 1620 

3K 3072 1620 

4K HD 3840 2160 

4K  4096 2160 

5K ANA 3600 2700 

5K WS 5120 2160 

5K 2:1 5120 2560 

5K HD 4800 2700 

5K 5120 2700 

REDCODE 

Allows adjustment of REDCODE settings. 

 

Range is 3:1 to 18:1 

Default is 8:1 

Use the scroll ribbon to select a target REDCODE compression ratio. 

The camera will automatically select the closest REDCODE to the desired target. 

The display will always show the "current" compression ratio being used by the camera. 
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If the camera is able to achieve the desired target compression ratio, it will be displayed in white.  If the 
camera is unable to achieve the target compression ratio, it will be displayed in yellow. 

 

The current compression ratio will automatically be re-calculated when changes are made to Resolution, 
FPS, HDRX Mode, Media, or Target REDCODE. 

 

REDCODE OPTIONS FOR VARIOUS FRAME RATES 

Minimum frame rate is 1 sec per frame; maximum frame rate is a function of REDCODE setting, and 
record resolution: 

FPS 24 25 30 48 50 60 72 75 90 96 100 120 150 175 210 250 288 300 
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4:1 
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RC 
12:1 

RC 
12:1 - - - - - - - - 
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RC 
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3:1 

RC 
3:1 

RC 
3:1 

RC 
3:1 

RC 
3:1 
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3:1 
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5:1 

RC 
6:1 
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SECONDARY MENUS 

Press the Menu button on the REDMOTE / Side Handle or touch the MENU icon  on the LCD to 
access the Secondary Menus. 

Available options in this menu screen are HDR, FOCUS, PRESETS, MEDIA, SETTINGS, and POWER. 
EXPOSURE is not implemented at this time. 

 

HDR MENU 

Available options are HDR OFF, HDRx and STOPS. 

NOTE: HDR mode cannot be modified when in Magnify 1:1 mode. 
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HDR ON / OFF 

By default, HDRx is OFF (HDR button is illuminated Blue). In the Lower Status Group of the Viewfinder 
screen, the HDR text is Gray, indicating HDRx is inactive. 

 

To turn HDRx on, navigate to the HDRx button using the Navigation Group and press ENTER, or from 
the touchscreen directly touch the HDRx button. In the Lower Status Group of the Viewfinder screen, the 
HDR text will turn White, indicating HDRx is active. 

 

STOPS 

To adjust the STOPS parameter, select the Stops box and use the UP / DOWN arrows to adjust. 

 

Range is 1 to 6. 

Default is 2. 

FOCUS MENU 

The Focus Menu is used to enable and select Focus parameters including MODE and ZONES. 
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MODE 

MANUAL FOCUS 

To adjust the MODE parameter, select the Menu box and use the UP / DOWN arrows to adjust. 
Available options are MANUAL and CONFIRM. Default is MANUAL. 

MANUAL 

When selected all focus operations are manual. 

CONFIRM 

Enables the Center or Spot focus square for use with manual focus.  This mode provides additional 
focus assistance to the photographer using RED, YELLOW, and GREEN color changes to the focus spot 
window. Inadequate subject illumination and/or contrast may interfere with normal Focus Confirm 
operation. 

For best results with Focus Confirm, operators should 'rock' the focus ring --  focusing through the point 
of optimum focusing and back again in decreasing amplitude  -- as when 'zeroing-in' for precision 
manual focus. 

 

AUTO FOCUS 

NOTE: The following menus will ONLY appear if a DSMC Canon Mount is installed with a Canon 
or Sigma lens attached. 

With a DSMC Canon Mount installed and a supported lens attached, available options become 
MANUAL, CONFIRM, SINGLE, CONTINUOUS, TOUCH TRACK, and RACK. Default is MANUAL. 

All settings except MANUAL place a single square (Center) or a single rectangle (Spot) on the screen 
(depending on the ZONES selection) that indicate where the image is in focus. 

Pressing the designated button for spot focus (REDMOTE / Side Handle button A default) will cycle you 
through each Focus Mode option in order as you press the button repeatedly. 



  
 

955-0003_v3.2, Rev- A1 COPYRIGHT © 2012 RED Digital Cinema 
81 

 
Performance of Auto Focus may be reduced under the following conditions: 

• The subject is dark or distant. 

• There is inadequate contrast between the subject and background. 

• The scene has reflective highlights. 

• The subject is backlit. 

• There is inadequate surface contrast/detail inside the window. 

NOTE: Edge Mode can be used for additional assistance in these conditions. Refer to SETTINGS 
MENU > DISPLAY > TOOLS > EDGE. 

MANUAL 

When selected all focus operations are manual. 

CONFIRM 

Enables the Center or Spot focus square for use with manual focus.  This mode provides additional 
focus assistance to the photographer using RED, YELLOW, and GREEN color changes to the focus spot 
window. Inadequate subject illumination and/or contrast may interfere with normal Focus Confirm 
operation. 

For best results with Focus Confirm, operators should 'rock' the focus ring --  focusing through the point 
of optimum focusing and back again in decreasing amplitude  -- as when 'zeroing-in' for precision 
manual focus. 

SINGLE 

A Focus / Record Button half-press performs single-shot AF. Optimized for rapid focus even under low-
contrast conditions. Works with both Center and Spot Zones. 
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CONTINUOUS 

Once engaged with half-press, will attempt to keep objects in AF window in focus. Works best with 
good lighting and contrast. Works with both Center and Spot Zones. 

TOUCH TRACK 

Dynamically updating positionable AF using touchscreen. Works with Spot Zone only. Keep AF Spot on 
subject while moving across frame, will continuously focus on spot. 

RACK 

For quickly selecting two focus points and executing rack focus between them. Focus points are 
selected using the Touchscreen. Shutter half-press executes rack movement. Works with Spot Zone 
only. 

Rack mode remembers the last Center or Spot position and focus setting as the first rack point. A 
second rack point needs to be defined by moving the spot window to the desired second location. If the 
spot window is not moved, a shutter half-press will only cause the lens to execute a single AF 
adjustment on the original Spot. On the other hand, when two rack points have already been defined, 
the rack point can be updated by moving the spot to a new location. This will replace the rack point that 
is not in focus at that moment. 
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DSMC CANON MOUNT ELECTRONICALLY SUPPORTED LENSES  

Canon EF 100-400mm f/4.5-5.6L IS 
Canon EF 100mm f/2.0 USM 
Canon EF 100mm f/2.8L Macro IS USM 
Canon EF 135mm f/2.0L 
Canon EF 135mm f/2.8 Soft Focus 
Canon EF 14mm f/2.8L II USM 
Canon EF 15mm f/2.8 Fisheye 
Canon EF 16-35mm f/2.8L II 
Canon EF 17-40mm f/4L 
Canon EF 180mm f/3.5L Macro 
Canon EF 200mm f/2.0L IS 
Canon EF 200mm f/2.8L II 
Canon EF 20mm f/2.8 USM 
Canon EF 24mm f/1.4L II 
Canon EF 24-105mm f/4L IS 
Canon EF 24-70mm f/2.8L 
Canon EF 24mm f/2.8 
Canon EF 28-300mm f/3.5-5.6L IS 
Canon EF 28mm f/1.8 USM 
Canon EF 28mm f/2.8 
Canon EF 300mm f/2.8L IS 
Canon EF 300mm f/4L IS 
Canon EF 35mm f/1.4L 
Canon EF 35mm f/2 
Canon EF 400mm f/2.8L IS 
Canon EF 400mm f/4.0 DO IS 
Canon EF 400mm f/5.6L 
Canon EF 500mm f/4L IS 
Canon EF 50mm f/1.2L 
Canon EF 50mm f/1.4 USM 
Canon EF 50mm f/2.5 Compact Macro 
Canon EF 600mm f/4L IS 
Canon EF 70-200mm f/2.8L IS 
Canon EF 70-200mm f/2.8L IS II USM 
Canon EF 70-200mm f/4L 

Canon EF 70-300mm f/4-5.6 IS USM 
Canon EF 70-300mm f/4.5-5.6 DO IS USM 
Canon EF 800mm f/5.6L IS 
Canon EF 85mm f/1.2L II 
Canon EF 85mm f/1.8 USM 
Canon EF-S 10-22mm f/3.5-4.5 USM 
Canon EF-S 17-55mm f/2.8 IS USM 
Canon EF-S 18-200mm f/3.5-5.6 IS 
Canon EF-S 60mm f/2.8 Macro USM 
Sigma 10-20mm f/3.5 EX DC HSM 
Sigma 20mm f/1.8 EX DG ASP RF 
Sigma 24-70mm f/2.8 IF EX DG HSM 
Sigma 50mm f/1.4 EX DG HSM 
Sigma 70-200mm f/2.8 EX DG APO Macro HSM II 
Sigma 85mm f/1.4 EX DG HSM 
Sigma APO 50-150mm f/2.8 II EX DC APO HSM 
Zeiss Distagon T* 18mm f/3.5 
Zeiss Distagon T* 21mm f/2.8 
Zeiss Distagon T* 25mm f/2         
Zeiss Distagon T* 28mm f/2 
Zeiss Distagon T* 35mm f/2  
Zeiss Planar 50mm f/1.4 ZE 
Zeiss Makro-Planar 50mm f/2   
Zeiss Planar T* 85mm f/1.4   
Zeiss Makro-Planar 100mm f/2   
Zeiss Distagon T* 18mm f/3.5 
Zeiss Distagon T* 21mm f/2.8 
Zeiss Distagon T* 25mm f/2         
Zeiss Distagon T* 28mm f/2 
Zeiss Distagon T* 35mm f/2  
Zeiss Planar 50mm f/1.4 ZE 
Zeiss Makro-Planar 50mm f/2   
Zeiss Planar T* 85mm f/1.4 
Zeiss Makro-Planar 100mm f/2
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ZONES 

Available options are CENTER and SPOT. Default is CENTER. This control allows selection of the boxes 
used to indicate objects in/out of focus. 

 

CENTER 

Provides a large, square target for focus. When objects located in the circle are in focus, the square will 
be Yellow or Green. When objects located in the square are out of focus, the square will be Red. 
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SPOT 

Provides a small, square target for precise focus (similar to Center focus, only smaller). When objects 
located in the square are in focus, the square will be Yellow or Green. When objects located in the 
square are out of focus, the square will be Red. 

 

 

SPOT FOCUS INDICATOR 

Moving 

The spot focus square can be moved around the screen. 

Touchscreen 

Tap on the spot focus square directly on the touchscreen and drag to the location you wish to relocate 
the spot focus circle. 
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Side Handle / REDMOTE 

1. Navigate to the focus menu. 

2. Press the down arrow on the Navigation Group. 

3. The spot focus square line weight will increase and the Red cursor under FOCUS will dim slightly. 

 

4. Press the ENTER button. 

5. Use the directional arrows to move the Spot Focus square to the desired location. 

 

6. To exit: 

- Press the ENTER button, the spot focus square line weight will increase, then press the UP arrow 
to go back to the FOCUS menu. 

- Press the MENU button. 

Resizing 

The spot focus square can be resized using the Navigational Wheel or the Touchscreen. 

Touchscreen 

Tap two times on the square directly on the touchscreen to increase size. You can increase the size 3 
times. After that, when you double-tap the spot focus square, it will decrease in size. 
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LENS INFORMATION DISPLAY 

RED DSMC TI PL MOUNT + LENS 

When a RED DSMC Ti PL Mount is installed and a Lens equipped with Cooke’s S4/i system (or 
equivalent is attached, the Focal Length and Focal Distance is displayed on the LCD, EVF and external 
monitors. 

 

The focal length and focal distance values and range will vary depending on the attached lens. When the 
focal length or focal distance of the lens is manipulated, the current values are displayed. 

DSMC CANON MOUNT + LENS 

When a DSMC Canon Mount is installed, and a Canon EF or EF-S Lens or equivalent is attached, the 
Focal Length and Focal Distance is displayed on the LCD, EVF and external monitors. When AF is set to 
Manual or Confirm mode, the focus distance displays as a pair of Near - Far distances. When it is in AF 
mode, a single estimated Focus distance is displayed. 

 

The focal length and focal distance values and range will vary depending on the attached lens. When the 
focal length of the lens is manipulated, the current value is displayed under Focal Length. The Focal 
Distance can be changed under MAIN MENU > -.- (F-STOP) > ADVANCED SETTINGS. 
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EXPOSURE MENU 

Not implemented at this time. 

PRESETS MENU 

CAMERA PRESETS 

Camera Presets are used to store and recall camera setup information such as LOOKs, key mappings, 
I/O configuration, etc. 

Your RED DSMC camera has a number of factory-installed settings. 

APPLYING A PRESET 

• Select Presets from the secondary menus 

• Select the desired preset from the selection ribbon 

• Press APPLY button 

• Use the selection ribbon to selcet 

Custom presets may be created to store groups of camera settings. For example; White Balance and 
ISO settings for a particular shooting location can be captured and as a preset and easily recalled later. 

Presets can also be saved on an SSD and applied to other RED DSMC cameras. 

CREATING A PRESET  

• Select Presets from the secondary menus 
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• Select Create and enter a name for the new preset using the QWERTY keyboard 

• Press OK on keyboard to save the preset name 

 

 

• Copy the desired settings from the left box of the interface to the right box using the select one (-->) 
or select all button 

 

 

• Select and press Create button (upper right corner of the screen) 

 

 

The preset has been created and is now stored on the camera. 
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SHARING PRESETS 

Presets may be shared between RED DSMC cameras using SSD media. 

 

Camera to camera 

 

 

Camera to multiple cameras 

 

Select Presets from the secondary menu: 

 

  

On Camera 

On SSD 
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COPY PRESETS FROM CAMERA TO SSD 

• Use scroll ribbon to select desired preset in camera box 

• Use --> button to move the preset to the SSD box 

COPY PRESETS FROM SSD TO CAMERA 

•  Use scroll ribbon to select desired preset in SSD box 

• Use --> button to move the preset to the Camera box 

• The following window will appear 

 

 

• Select Yes to copy the preset to the camera and apply the setting 

• Select No to copy the preset to the camera without applying the settings 

MANAGING PRESET FILES 

• The APPLY, DELETE, and CREATE buttons are only affect the camera box. Presets on the SSD will 
remain there until the media is reformatted. 

• Copy the desired settings from the S-SSD\Presets side of the interface to the Camera side using 
the select one (-->) or select all button 
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LOOKS PRESETS 

Look Presets allows you to save the specific color, image, white balance, and detail settings to be used 
for other projects. Meta is the default settings shot on the camera and cannot be deleted. As looks are 
created, they will be displayed alphabetically. 

 

For detailed information on LOOKs, see the REDCINE-X Operation Guide, available on RED.com 
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 If  

MEDIA MENU 

The Media Menu is used to format media (SSD) prior to use on the camera as well as to Eject (unmount) 
the media prior to removal from the camera. Available options when selected are SELECT MEDIA, 
FORMAT MEDIA, EJECT MEDIA, and UTILITIES. 

IMPORTANT: Media MUST be ejected from the camera before removal to prevent corruption 
and/or loss of data on media. 

 

SELECT MEDIA 

Allows you to select the Media location to be used by the camera. Default is the Side SSD (S-SSD) 
Module. 

FORMAT MEDIA 

When selected, a new dialog box will appear allowing you to add properties to the media highlighted in 
the Current Media box when formatting. Available options are REEL NO, CAM ID, CAM POS, and 
FORMAT to format the media with the values entered. 
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NOTE: If clips are present on the media, you will be informed of how many clips will be erased 
when you format the media. 

REEL NO. 

When selected a keypad will appear allowing you to enter a value between 1 and 999. 

CAMERA ID (SLATE) 

Identifies the camera with a letter A through Z. Default is A. 

CAMERA POS (POSITION) 

Identifies the camera position as Right, Left or Center. Default is Center. 

FORMAT 

When selected, formats the media and adds the selected properties. 

• During formatting, the camera will display “Formatting” with a Green status bar. REDMOTE will also 
display this message. 

 

• When formatting is complete, camera will display “The magazine was successfully re-formatted. The 
digital magazine is ready for immediate use. REDMOTE will also display this message. 

 

EJECT MEDIA 

When selected will Eject (unmount) the media highlighted in the Select Media box. 

 

When ejected, camera will display “Media Ejected Successfully”. REDMOTE will also display this 
message. 
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UTILITIES 

Options are SECURE FORMAT. 

 

SECURE FORMAT 

Secure Format is a low-level format the rebuilds the SSD file system. It should only be used if the 
performance of the SSD is in question. 

 

NOTE: If clips are present on the media, you will be informed of how many clips will be erased when you 
secure format the media.  
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SETTINGS MENU 

This section describes the various secondary controls available to configure the camera. Menu options 
are DISPLAY, LOOK, SENSOR, PROJECT, MODES, AUDIO/VIDEO, SETUP, MAINTENANCE, and 
PLAYBACK. 

 

DISPLAY 

Available options are TOOLS, ZEBRA, OVERLAY, MODES, FRAME GUIDE, AREA GUIDES, and 
MONITOR. 

 

TOOLS 

The Tools menu permits the operator to adjust the GUI elements displayed on the Viewfinder output(s) 
Available options are OFF, EXPOSURE, FOCUS, VIDEO, EDGE, MAGNIFY, and RAW. The Dialog is 
available by either going to SETTINGS > DISPLAY > TOOLS or simply clicking on the histogram in the 
lower left. 

 

OFF 

Turns off any of the display modes in the first line. 
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EXPOSURE 

This will show areas of under exposure (Purple) or over exposure (Red) on top of a monochrome image. 
The color is based on RAW data so over/under exposure refers to data actually close to clipping in the 
sensor. When selected, the icon “E√” will be displayed in the Lower Status Group. 

 

The EXPOSURE meter’s color bands provide the following information: 

PURPLE Minimum Exposure 

RED Maximum Exposure 

Between minimum and maximum exposure values, the image is displayed as a monochrome image. 

 

In the image, Purple areas represent sensor exposure levels that are likely to be noisy if gained up in 
postproduction. Red areas represent sensor exposure levels that are at clipping. 

 

NOTE: As EXPOSURE meters sensor RAW information, it is not affected by any RGB domain 
adjustments - such as ISO rating, FLUT, White Balance, Video Gain or other LOOK information. 

NOTE: Because the RAW data represents a wider color space than RGB, provided that the Red 
(clip) color is not present in EXPOSURE view, even if Red (clip) color is present in VIDEO view, the 
apparently clipped RGB highlights can be recovered in post production by adjustment of ISO, 
FLUT or changing the KNEE and WHITE values of the CURVE box. 
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FOCUS 

This will emphasize edges in the image without changing brightness/image content so it is easier to 
judge if the image is in focus. By adjusting your lens zoom and focus you can see which objects are 
coming into and falling out of focus. When selected, the icon “F√” will be displayed in the Lower Status 
Group. 

 

 

VIDEO 

VIDEO displays a multi-color color overlay that allows you to check the video level of the RGB monitor 
path (calibrated to the SMPTE test signal) and any outputs driven from that path - such as HD-SDI and 
HDMI. When selected, the icon “V√” will be displayed in the Lower Status Group. 

 

Purple represents Super-Black, Dark Blue represents Black, Teal represents 3-stops under 18% Gray, 
Green represents 18% Gray, Pink represents Skin Tone, Straw represents White, and Yellow, Orange 
and RED represent various degrees of signal clipping in RGB space. 

By adjusting ISO, FLUT and Shadow while looking at VIDEO check, the operator can ensure that Black, 
White and 18% Gray values conform to the desired levels on the HD-SDI and /or HDMI outputs. 

The VIDEO bands provide the following information: 

PURPLE Super Black (IRE 1-0) 

BLUE Black (IRE 1-3) 

TEAL Dark Gray (IRE 9-12) 

GREEN Typical Level for 18% Gray Card (IRE 44-47) 

PINK Typical level for Caucasian Skin (IRE 54-57) 

STRAW White (IRE 96-98) 

YELLOW Super White (IRE 101-104) 
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ORANGE Super White (IRE 105-107) 

RED Super White (IRE 108-109) 

At all other values, the monochrome image displayed represents the luminance value of the ISO 
adjusted image. 

 

 

EDGE 

EDGE displays a color overlay that outlines the edges of objects in an outline mode. By adjusting your 
lens zoom and focus you can pinpoint focus. When selected, the icon “F√” will be displayed in the 
Lower Status Group. 

WARNING: This will potentially interfere with recordings done via HDMI/HD-SDI in "Clean" Mode! 
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MAGNIFY 

Magnify displays the central region of the sensor in 1:1 pixel resolution. When enabled, the 1:1 text in the 
Lower Status Group will change to Green. If in Magnify mode, when the Record button is pressed, the 
system will automatically exit this mode. When using a touchscreen you can also perform this function 
by pinching your fingers together and apart. 

NOTE: HDR mode cannot be modified when in Magnify 1:1 mode. 

 

 

NOTE: When in magnify mode, you will not be able to adjust frame rate or resolution. These 
options will be Grayed out. 
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RAW 

RAW displays the image without any ISO correction. When selected, OFF will be highlighted in the 
Lower Status Group. 

 

 

ZEBRA 

Zebras enable and adjust the upper and lower values for two independent Zebra indicators. One zebra 
may be used for highlight exposure, and the other for mid tone or shadows. Zebras will be visible when 
in 1:1 zoom. By default, Zebra 1 and 2 are disabled. 
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ZEBRA 1 

To enable, select ZEBRA 1 check box. Areas of the image exposed within these ranges will be indicated 
by crosshatched overlays at - 45 degrees relative to vertical. Zebra 1 is shown in the image below. 

 

High IRE 

Change the desired setting between 93 and 109 (default is 108). 

Low IRE 

Change the desired setting between 75 and 107 (default is 99). 

ZEBRA 2 

To enable, select ZEBRA 2 check box. Areas of the image exposed within these ranges will be indicated 
by crosshatched overlays at + 45 degrees relative to vertical. Zebra 2 is shown in the image below. 

 

High IRE 

Change the desired setting between 1 and 99 (default is 47). 



  
 

955-0003_v3.2, Rev- A1 COPYRIGHT © 2012 RED Digital Cinema 
103 

Low IRE 

Change the desired setting between 0 and 84 (default is 44). 

OVERLAY 

Allows you to enable and color code graphic overlays visible the on the Viewfinder and Preview outputs. 

 

Use check boxes and pull down menus to control appearance of the overlays 

Grid 

The Grid display is shown below. The grid may be used as a “rule of thirds” indicator. 
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Look Around 

Highlights the look around area. 

 

Overlay Elements 

 
 

 

 

 

  

01:17:06:16 

File Name 
Time Code Scene Name 

Lens Info 

Motion Data 
(Pitch & Roll) 
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MODES 

Available GUI display mode adjustments are Exposure, Shutter Mode, Aperture, and Focal Distance. 

 

EXPOSURE 

Selects GUI display of Shutter Exposure on Main screen as Time (1/xx sec) or Angle (Degrees). Default is 
Time. Angle is shown below. 

 

SHUTTER 

Enables one of two shutter timing (duration) modes: Absolute or Relative. Default selection is Absolute. 

Absolute 

Shutter Speed is defined exclusively by the Shutter Speed setting. 

NOTE: When operating in Absolute mode, the shutter speed is reported in White text. 

Relative 

Shutter Speed is defined by the requested Shutter Speed divided by the ratio of the current capture fps 
to the Project TIME BASE fps. 

NOTE: When operating in Relative mode, the shutter speed is reported in Yellow text. 

 

NOTE: If the operator requests a shutter speed that is outside the capability of the camera, the 
camera will automatically limit them when a limiting parameter changes. 
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APERTURE 

Selects GUI display of f/stop as 1/4 f Stop or 1/3 f Stop. Default is 1/3. 

FOCAL DISTANCE 

Allows you to set the Lens Info to display in Metric or Imperial measurements. Default is Imperial. 

 

GUIDES 

This sub-menu provides a selection of frame guides and safe action and safe title guides. User definable 
safe action and safe title guides may be saved as a USER PREFERENCE, thereby permitting the camera 
guides to be fully customized for any application. Available options are Size, Line Style, Color and 
Transparency.  
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SIZE 

Available options are Off, Full, 4:3, 16:9, 1.85:1, 1.9:1, 2.4:1, or User. 

LINE STYLE 

Available options are Solid, Dashed, or Bracket. 

COLOR 

Sets the frame guideline color to White, Gray, Teal, Purple, Yellow, Green, Blue, Red, or Black. Select 
the color that provides maximum color contrast with the scene you are shooting. Default is White. 

TRANSPARANCY 

Sets the frame guide transparency. Available options are 0%, 25%, 50%, 75% and 100%. 

 

MONITOR 

Allows you to modify brightness of the LCD and EVF parameters through Brightness Control. Also allows 
options for the LCD touchscreen to be changed through Touch Gestures. 
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BRIGHTNESS CONTROL 

Slide to the right for a brighter display; slide to the left for a dimmer display. 

TOUCH GESTURES 

These options apply ONLY to the Touchscreen LCD. 

Pinch to Magnify 

When selected, allows you to use two fingers in a pinching motion on the screen to enable Focus Zoom. 
To zoom out to normal view, slide fingers apart. 

Double-Click Right 25% to Record 

When selected, the right 25% of the screen can be double-tapped to start and double-tapped again to 
stop recording. 

Double-Click Left 25% to Start AF 

When selected, the left 25% of the screen can be double-tapped to start the Auto focus (when DSMC 
Canon Mount and compatible lens are installed). 

LOOK 

The LOOK menu permits adjustment of COLOR, GAIN, FLUT®, and CURVE metadata values. These 
parameters will affect the look of the monitor path, but do not affect the actual REDCODE RAW data 
being recorded. 

COLOR 

The Color sub-menu permits adjustment of SATURATION, CONTRAST, and BRIGHTNESS. 

 

SATURATION 

Adjusts color saturation. Range is 0.0 (monochrome) to +3.8 (super color). Default is 1.0. 
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CONTRAST 

Adjusts the overall contrast of the image. Range is -1.0 (flat) to +1.0 (max contrast). Default is 0.0. 

BRIGHTNESS 

Adjusts brightness without crushing highlights. Available range is – 10.0 to +10.0. Default is 0.0. 

GAIN 

The GAIN sub-menu permits adjustment of RED GAIN, BLUE GAIN and GREEN GAIN. 

 

RED 

Adjusts the gain of the RED channel only. Range is 0.0 (no Red) to 10.0. Default is 1.0. 

BLUE 

Adjusts the gain of the BLUE channel only. Range is 0.0 (no Blue) to 10.0. Default is 1.0. 

GREEN 

Adjusts the gain of the GREEN channel only. Range is 0.0 (no Green) to 10.0. Default is 1.0. 

FLUT 

The FLUT sub-menu permits adjustment of FLUT, EXPOSURE COMPENSATION and SHADOW. 
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FLUT 

FLUT (Floating Point Lookup Table) adjusts mid-range tone values. Range -8.0 to +8.0. Default is 0.0. 

EXPOSURE 

Adjusts exposure compensation. Available exposure range is –7.0 to +7.0. Default is 0.0. 

SHADOW 

Shadow adjusts the toe value of the FLUT or in other words, the tone near Black. Range is -2.0 to +2.0. 
Default is 0.0. Increasing the Shadow value raises the video level of near Blacks. Lowering the Shadow 
value crushes the video level of near Blacks. 

CURVES 

The curves dialog box allows the user to set define curves for Luminance, and the red, green, and blue 
channels. 
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COLOR/GAMMA 

The COLOR/GAMMA sub-menu permits adjustment of the monitor output Color Space and Gamma 
curves. 

 

Available Color Space Options 

 

 

 

Available Gama Space Options 
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PROJECT 

The project menu sets the operating parameters the camera will use for a given project. Options 
available are TIME BASE and TIME CODE. 
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TIME BASE 

Sets the TIME BASE (fps) to be used for the project - the primary acquisition frame rate, time code count 
and playback & editing frame rate. Setting is displayed in the lower left corner of VIEWFINDER output(s). 

Available options are 23.98, 24.00, 25.00, 29.97, 47.96, 48.00, 50.00, and 59.94. Default is 23.98.  

 

TIME CODE 

Selects the TIME CODE source to be used. Options are EXTERNAL TC and INTERNAL USER-
PROVIDED TC. 
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TIME CODE DISPLAY 

Allows you to choose between TOD and Edge display.  

TIME CODE SOURCE 

Available options are EXTERNAL and USER-PROVIDED. 

 

User-Provided 

The three numerical boxes below allow you to set hours, minutes and seconds (in that order). 

Use RTC Time  

When selected the camera uses the cameras Real Time Clock as the timecode counter source 
(snapshot of the RTC.) 

Set Manually  

When selected allows the user to define a custom value as the timecode counter seed. 
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SLATE 

When selected, a new dialog box will appear allowing you to add properties to the media highlighted in 
the Current Media box when formatting. Available options are CAM ID, CAM POS and SET to set the 
values entered. 

Auto-Incrementing Take 

If there is a value entered in the Scene box, the camera will automatically increment the take number 
every time the camera starts and stops recording. 

Note: The scene name is limited to eight characters. 

 

  

Scene Information Camera Information 

  

Project Information Auto Slate Information 

SYSTEM STATUS 

Selecting System Status from the Project menu displays key project information. 
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AUDIO/VIDEO 

Menu adjusts AUDIO INPUT, AUDIO OUTPUT, AUDIO CHANNELS, MONITOR CONTROL, and TEST 
SIGNALS. 

 

 

AUDIO INPUT 

Allows you to enable / disable and adjust levels for audio inputs (CAM ANALOG). Default is unchecked. 
Range 8 to 64 dB, default is 10 dB. 
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You can also directly input your desired audio levels. 

 

 

Audio channel level inputs are displayed in the lower section of the UI. 

When audio is enabled and an audio jack is plugged in (detected by the camera), the circle next to CH1, 
CH2 etc… will be Green and the box around the signal will be highlighted. 

When audio is enabled and an audio jack is not plugged in (not detected by the camera), the circle will 
be Red. 

 

Also, when audio is disabled and an audio jack is plugged in, the circle will remain Gray but the box 
around the signal will be highlighted (jack is detected by the camera). 
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AUDIO OUTPUT 

Allows adjustment of audio output levels fed to the outputs. Available options for each channel are ON 
and MUTE. Default is ON at -9 dB. 

 

AUDIO CHANNELS 

Allows selection of audio inputs and operational modes. 
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INPUT 

Available inputs are CH 1/2 and CH 3/4. 

NOTE: For cameras not equipped with a PRO I/O module, options are CH 1/2. 

Source 

Available options are NONE, CAM ANALOG, PRO I/O ANALOG, PRO I/O AES A, and PRO I/O AES B. 

NOTE: For cameras not equipped with a PRO I/O module, options are NONE or CAM ANALOG. 
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Mode 

Available options are UNBALANCED and BALANCED. 

 

Link 

Enables linkage between Channel Gain controls. 

Limiter 

Enables signal limiter circuit. Limiter enabled adds 10dB of headroom for Microphone level inputs, or 
4dB for Line Level inputs. 

OUTPUT 

Link 

Enables linkage between Output Channel Attenuation controls. 

MONITOR CONTROL 

This sub-menu allows the monitor outputs settings to be modified. For changes to take effect, the 
camera MUST be restarted.  
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MODE 

Allows you to choose the output for the LCD/EVF, HDMI and HD-SDI monitors. 

LCD/EVF 

Options are MENUS, PREVIEW, CLEAN, OVERLAY, 3D LEFT, and 3D RIGHT. 

If anything other than MENUS is selected on the LCD (such as CLEAN), to return to displaying the 
MENUS, perform a double-tap on the LCD screen. 

HDMI 

Options are OFF, MENUS, PREVIEW, CLEAN, OVERLAY, 3D LEFT, and 3D RIGHT.  

RES 

Allows you to choose the output resolution for HDMI monitors. Available options are AUTO, 720p and 
1080p. 

NOTE: Some HDMI monitors may have trouble when "AUTO" is selected. In these cases, it is 
recommended to manually select the maximum monitor resolution provided. 

HD-SDI 

Options are OFF, MENUS, PREVIEW, CLEAN, OVERLAY, 3D LEFT, and 3D RIGHT.  
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RES 

Allows you to choose the output resolution for HD-SDI monitors. Available options are AUTO, 720p and 
1080p. 

FREQ 

Allows you to choose the output frequency in Hertz (Hz) for HD-SDI monitors. Available options are 
AUTO, 23.976/24, 25, 29.976, 47.952/48, 50, and 59.94. 

AUTOMATICALLY ASSIGN MENU SCREEN IF ENABLED 

When checked will assign an attached external monitor to display the menus if none are selected. 

TEST SIGNALS 

Permits the video monitor outputs to be replaced with a video test pattern. Available test patterns are 
CHIP CHART and SMPTE BARS. 

 

 

To enable a desired test signal, select the desired test signal box. To exit the test signal, tap the 
touchscreen one time or press the Enter or Menu button on the Side Handle or REDMOTE. 

CHIP CHART 

 

SMPTE BARS 

 

NOTE: RED DSMC  test signals are not recordable, they are provided to help align external video 
monitors connected via the HD-SDI or HDMI outputs. 
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SETUP 

This menu permits a variety of system setup tasks to be accomplished. Options available are KEYS / 
SHORTCUTS, DATE / TIME, NETWORK, SERIAL, REMOTE, GPIO, and SYSTEM. 

 

KEYS 

Use Keys function to customize the assignment of DSMC camera controls. 

KEY MAPPING 

With Key Mapping, you press the button you want to change and follow on-screen instructions to 
complete the change. 

 When the Key Mapping tab is highlighted: 

• Press the camera key you want to change.  

• Use the pull down to select the desired function 

• Press menu or a blank area of the touchscreen to save the setting 
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OPTIONS 

• Select the desired option 

• Press menu or a blank area of the touchscreen to save the setting 

 

 

ADVANCED 

• The advanced tab allows you to set key functions using a series of pull down menus 

• Select Key Source (Brain, REDMOTE, Side SSD, etc.) 

• Select the key you wish to change 

• Select the desired key action 

 

Key Source 
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User Key 

 

 

Key Action 

 

WARNING: Do not remap the navigation keys (Up, Down, Left, Right, Select (Enter), or Menu) on the 
side handle doing so could render the camera inoperabel.  
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DATE / TIME 

This menu allows the user to reset the battery backed up internal clock of the camera. This time value is 
used as a timestamp on the .R3D files when recording to the RED MAG 1.8” SSD media.  

 

NOTE: Enter time in 24-hour clock format. i.e. 2:35 pm should be entered as 14:35:00. 

COMMUNICATION 

Communication Menu allows you to set a unique identification for the camera (or a group of cameras) 
when operating in command and control communications network. Parameters are NAME, GROUP, 
TARGET, set a SERIAL PROTOCOL, ENABLE DHCP, C2C or EXT, IP ADDRESS, NETMASK and 
GATEWAY. Using the serial port or a direct Ethernet interconnect, two cameras, or one camera and one 
external  device can be connected. If the camera is connected via Ethernet to a hub or router, multiple 
cameras and devices can communicate to each other.  

 

NAME 

Allows the user to create a unique camera NAME used in network communications 

Note: the camera name field is limited to 8 characters. 
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GROUP 

A camera can also be identified as a member of a GROUP of devices. (For example, a group "3DRIG_A" 
could include two cameras "CAM_A_L" and "CAM_A_R"). The default group is named "DEFAULT". 
Group names (like camera Names) can be used to uniquely address commands to a specific group of 
networked cameras. Note: the group name is limited to 8 characters, default name is DEFAULT. 

TARGET 

Using TARGET the user can specify if this camera can send commands to ALL devices on the network, 
to NONE of the devices on the network (meaning the camera will only listen to messages and not 
originate messages) or to a specific TARGET device - which can either be the NAME of a specific 
camera or device or a name of a GROUP of cameras or devices.  

This structure allows for a lot of flexibility. For example on a multi-rig 3D shoot the user can either send 
commands to an individual camera (e.g. Set CAM_A_L to 1/48th exposure), to a group of cameras (e.g. 
Set "3DRIG_A" to 48 FPS), or to all cameras (e.g. Start Recording on all cameras). It is important to note 
that with the exception of the NONE setting, all command filtering is happening on the receiver side of 
the communication link. 

 

SERIAL PROTOCOL 

The camera can communicate to external devices via RS232 Serial Port and / or the Gigabit Ethernet 
Port. 

This selection allows the user to specify the serial communications PROTOCOL. Available options are 
NONE, ELEMENT TECHNICA, 3ALITY SPC 7100 and 3ALITY SPC 7000. Default is NONE.  
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NETWORK 

If the Gigabit Ethernet port is used, additional settings are required. Each camera or device requires a 
unique IP ADDRESS. For simple camera-to-camera communication via Ethernet, both cameras need to 
be in the same sub-net. 

Use the same sub-NETMASK and GATEWAY addresses and the first three groups of the IP address 
need to be the same. 

In the example below, two cameras two cameras are assigned to the group “3D RIG.” Note the IP 
Addresses. 

  

Master Slave 

DHCP 

If a DHCP-server is available in the 
communications network the DHCP option can 
be checked and the camera will obtain an IP 
Address, Subnet Mask and Gateway address 
automatically from the DHCP -server. 

C2C 

If the camera-to-camera (C2C) check box is 
checked, changes to the settings on this 
camera will be sent out via the network as UDP 
packets as a SET command (Which then sets 
the property on other cameras). SET commands 
sent to this camera will not be propagated. 

EXT 

If the EXT check box is checked this camera 
can be controlled via TCP/IP from an external 
device. 

IP Address 

Permits the user to adjust the camera’s static IP 
address. 

Netmask 

Permits the user to adjust the Subnet Mask 
address.  

Gateway 

Permits the user to adjust the Gateway address. 
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REDMOTE 

This function is used to pair the camera to a REDMOTE for wireless operation.  

 

SCAN AND PAIR REDMOTES 

When selected, the camera will look for an attached REDMOTE, plus any REDMOTEs that are turned on 
with REDlink wireless enabled.  

Available REDMOTES will appear in the left window. 

The MAC Address for locally any attached REDMOTE will be in brackets <>. 

Use the Pair and Unpair buttons to select and Pair/ Unpair REDMOTES. 

MANUAL CHANNEL SELECT 

The Manual Channel Select option allows the user to change the communication channel for the 
REDLink wireless connection in the event of interference from other wireless devices. Auto (unchecked) 
will pick the "cleanest" channel automatically on each camera boot. Manual Channel Select is the 
default setting and for default uses Channel 0. 
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GPIO 

GPIO selects the GPIO preferences sub-menu. 

 

CAMERA INPUT 

Permits the function of the SYNC IN / GPI pin in the SYNC connector to be defined as: 

Sync In 

Accepts an Input Sync signal to control Shutter Start timing. 

 

General Purpose In 

Accepts an Input Trigger signal to act as a General Purpose Input.  
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CAMERA OUTPUT 

Permits the function of the SYNC OUT / GPO pin in the CNTL connector to be defined as: 

Sync Out 

Provides an Output Sync signal to act as a Shutter Start tally. 

General Purpose Out 

Provides an Output Tally to act as a General Purpose Output tally signal. 
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SYNC MODE 

Allows the shutter timing (scan start) to be synced to an external signal. 

 

Available options are OFF, GENLOCK, SHUTTER, INTERNAL, PROXY, and SLAVE. Default is Off.  

OFF – Shutter start time is defined by internal camera timing.  

GENLOCK – Shutter start time is slaved to an external RS170A tri-level sync signal .a.k.a. “Genlock”.  

SHUTTER – Shutter start time is slaved to an external Shutter Sync signal. 

INTERNAL – Not implemented at this time.  

PROXY – Not implemented at this time. 

SLAVE – Not implemented at this time. 

IMPORTANT: If Sync > Genlock mode is selected, DO NOT set fps to higher than 72fps, and to a 
speed NOT a multiple of the project base rate and genlock input.  
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SYSTEM 

Available options are FAN CONTROL, RECORD SPEED and STANDBY SPEED as well as BEEP 
SPEAKER and EVF TALLY LIGHT. 

 

FAN CONTROL 

Specifies cooling fan operation. Available options are AUTO and MANUAL. Manual will run the fan at the 
speeds specified in RECORD SPEED and STANDBY SPEED. Default setting is AUTO. 

Auto 

This setting selects VARIABLE speed fan operation in standby based on the camera core temperature. 

Manual 

This setting allows you to set a fixed fan speed to be used during Record and Standby modes. 

Record Speed 

Sets a fixed fan speed to be used during Record. Range 25 – 100%. Default is 50%. 

Standby Speed 

Sets a fixed fan speed to be used during Standby. Range 25 – 100%. Default is 75%. 
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INDICATORS 

Beep Speaker 

Available options are OFF and RECORD/STOP. When RECORD/STOP is selected, an audible beep will 
be heard when record is started and another when record is stopped. 

 

EVF Tally Light 

When checked, enables the Record Tally Red LED on the front of the EVF. 

MAINTENANCE 

The maintenance menu allows the user to check system status and information, save the camera 
diagnostic LOG to attached media, perform a software update, calibrate the sensor, perform a camera 
self test, and reset system settings to factory defaults. 
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SYSTEM INFO 

When selected the Viewfinder output(s) will display the camera Model, current firmware Version, installed 
and camera P.I.N. 

 

 

SAVE LOG 

Select to write camera’s .LOG file to the REDMAG 1.8” SSD. The .LOG file is a diagnostic tool that can 
assist RED with camera troubleshooting. After capture, upload the .LOG file to the RED customer 
service team contactable at www.RED.com/support. 

After successfully writing the log file to media, viewfinder output(s) will display LOG SAVE COMPLETED. 
REDMOTE will also display this message. 

 

If media is not attached to the camera when attempting to perform a write log request, external monitors 
will display NO MEDIA ATTACHED. 

NOTE: Log files will be stored as *.txt files in the 1.8” SSD root directory. 

SW UPDATE 

NOTE: Firmware upgrade currently uses a force upgrade procedure as outlined in APPENDIX A: 
UPGRADING CAMERA FIRMWARE. 

Update SW initiates a camera software (firmware) update. If a software update is on the attached media, 
you will be given the option to upgrade the camera (earlier firmware version shown for reference ONLY). 

 

For complete, detailed procedure, go to APPENDIX A: UPDATING CAMERA FIRMWARE. 

http://www.red.com/support�
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CALIBRATION 

Sensor calibration is a process where the camera generates a calibration map to correct for pixel 
defects and offsets based on current system and environmental settings. This allows you to perform a 
Black Shading calibration of the MYSTERIUM X sensor two (2) different ways; Default (at 24 FPS @ 1/48 
SEC) or using your current FPS/Exposure settings. 

 

To calibrate the sensor the image needs to be as dark as possible:  

• At a minimum put a lens cap on the lens (WARNING: Not all lens-caps completely block IR. They are 
made to protect the lens, not necessarily to block light...) 

• Preferably, take of the lens, and use the lens-mount cap provided by RED.  

• If possible, use a dark room.  

• Just closing the Iris is NOT sufficient.  

Additionally a SSD needs to be inserted in the camera to store the raw images during calibration. 

Calibration is required: 

• If the temperature deviates significantly from the currently used calibration, it is recommended to 
recalibrate the sensor. 

• If very long exposure (~longer then 1/24 Sec) is used it is recommended to recalibrate. 

After Calibration with a lens cap on and ISO set to maximum, the sensor should show a uniform noise 
profile over the whole area without any falloffs on any side. You can check at which 
temperature/exposure time the currently used calibration was taken on under SETTINGS > 
MAINTENANCE > SYSTEM STATUS under Calibration. 

Calibration maps will still be available after performing a system restore under SETTINGS > 
MAINTENANCE > RESTORE SYSTEM; however the factory calibration map will be reselected.  
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CURRENT CALMAP 

Calibration maps are stored in the camera.  Due to the nature of the camera, different calibration maps 
are needed for different situations. 

 

Factory 

This the calibration map generated during production. This map is always present and selected as 
default on first use after performing a system restore under SETTINGS > MAINTENANCE > RESTORE 
SYSTEM. 

User HS 

The user can select the CURRENT CALMAP. The dialog only show the calmaps stored in memory 
(FACTORY and USER HS in this case). 

BLACK SHADING (DEFAULT) 

This option uses fixed settings which are the same used for the factory calibration (around 23 Deg C). 

BLACK SHADING (CURRENT FPS/EXPOSURE SETTINGS) 

This option generates a calibration with the currently set frame rate/exposure. This can be used to 
generate a calibration for long exposures. After calibration (Which takes about 10 min), the new map is 
automatically selected. 
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BLACK SHADING PROCEDURE 

The calibration procedures are the same for both BLACK SHADING options. 

The calibration procedures are the same for both Black Shading (24 FPS @ 1/48 SEC) and Black 
Shading (Current FPS/Exposure) options. 

When selected, a screen will appear asking if you wish to proceed with Black Shading calibration. 
REDMOTE will also display the following messages. 

 

Black Shading calibration procedure: 

1. Ensure the sensor is NOT exposed to the calibration light source by installing the lens cap properly. 

2. Ensure a properly formatted SSD is attached to the camera and properly formatted. 

3. Select OK to perform the Black Shading calibration. The calibration will make 2 passes. 

4. A status screen will show progress of the Capturing step. Second pass shown. 

 

5. Once Capturing is complete, a status screen will show progress of the Analyzing step. 
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6. Once Analyzing is complete, a status screen will show progress of the Erasing step. 

 

7. Once Erasing is complete, a status screen will show progress of the Programming step. 

 

8. The camera will perform this procedure twice. 

9. After Programming, CALIBRATION SUCCESSFUL will be displayed. Select OK to complete Black 
Shading calibration. 

 

SELF TEST 

When selected allows you to perform a self-test for the sensor and LCD Touchscreen. 
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ENABLE / DISABLE SENSOR TEST PATTERN 

When selected enables / disables the sensor test pattern (White Screen). To turn on, select ENABLE 
SENSOR TEST PATTERN. 

 

To turn off, select DISABLE SENSOR TEST PATTERN. 
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TOUCHSCREEN 

When selected allows you to perform a touchscreen self-test. 

 

When the touchscreen self-test is on, you can verify all areas of the touch screen respond to touch. 
Simply touch each box using your finger. The touchscreen responds to the touch and the Green box 
turns Blue. 

  

 

To exit the Touchscreen Self-Test: 

• Place your finger on the touchscreen and hold it there until the main screen appears. 

• Press the Enter or Menu button on the Side Handle or REDMOTE. 

RESTORE SYSTEM 

Restore System permits ALL camera configuration and setup data to be reset to factory default values. 
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When selected, you will be asked to confirm if you want to delete all settings and restore the factory 
default settings. After settings are restored, “DEFAULT SETTINGS RESTORED, INITIALIZING 
RESTART…” Camera will automatically power down and will require you to manually power it up. 

 

NOTE: User key settings will be reset as well as any other changes from the cameras default 
settings. The REDMOTE will also require paring to communicate wirelessly with the camera. 

REDISCOVER 

Rediscovers all hardware and caches the data for future boot cycles. 

When selected, you will be asked to confirm if you want to reset all hardware discovery settings. After 
settings are reset, “RESET HARDWARE DISCOVERY SUCCESSFUL, INITIALIZING RESTART…” 
Camera will automatically power down and will require you to manually power it up. 
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MOTION SENSOR CALIBRATION 

The RED DSMC Camera displays data from the accelerometer to help orient the camera. After a 
firmware upgrade or Factory Restore the motion sensors need to be re-calibrated through the 
Maintenance->Motion Calib menu." 
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PLAYBACK 

Playback allows you to view clips on media currently attached to the camera. It also allows you to 
change the look of the playback clips be changing settings available when in playback mode. 

NOTE: SCARLET-X™ menus shown, EPIC menus similar. 

 

UPPER CONTROLS 

From Left to Right are ISO, WHITE BALANCE, VIEW, PRESETS, MEDIA, SEETINGS, and META. Below 
the settings is the clip playback status bar. 

 

Exit Playback ICON (Touchscreen) 

Select the O on the Left to exit Playback mode. 

NOTE: The Menu ICON on the Right does not respond to commands when in Playback mode. 

 

ISO 

Allows you to change the ISO in the clip during playback. 
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WHITE BALANCE 

Allows you to change the White Balance in the clip during playback. 

 

Advanced Menu 

Opens the advanced White Balance settings without the ability to Calculate. 

 

VIEW 

Allows you to select the items to be displayed in the playback window. Available options are Center, File 
Name, Time Code, Frame Guide, Action Guide, and Title Guide. 
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PRESETS 

Allows you to apply presets to the clip during playback. 

 

MEDIA 

When selected will list all available clips on the attached media. 
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Touchscreen 

1. Double-Tap the desired clip to open in the playback window. 

2. Load will also highlight. You can also select LOAD to load the clip in the player and allow playback. 

 

Side Handle / REDMOTE 

1. Select the desired clip to playback and press the ENTER button. 

2. Load will highlight. Select LOAD to load the clip in the player and allow playback. 
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SETTINGS 

Available options are DISPLAY, LOOK and RECORD. 

 

Display 

Available options under Display are TOOLS and ZEBRA. 

 

Tools 

Allows you to toggle ON/OFF Exposure, Focus, Video, Edge, and RAW. Refer to SETTINGS MENU > 
DISPLAY > TOOLS for complete details about these options. 

 

Zebra 

Allows you to toggle ON/OFF Zebras. Refer to SETTINGS MENU > DISPLAY > ZEBRA for complete 
details about these options. 
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Look 

Allows you to adjust the Color, Gain, FUT, and Curve of the image during playback. Refer to SETTTINGS 
MENU > DISPLAY > LOOK for complete details about these options. 

 

Record (Exit) 

When selected will exit playback to the main menu. 

 

META 

Displays current clip META information. 
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CLIP PLAYBACK STATUS BAR 

Displays the progress of the clip during playback. 

 

Touchscreen 

When using the touchscreen you can swipe your finger Left or Right to open and allow playback of the 
previous or next clip on the media. 

Side Handle / REDMOTE 

When using the Side Handle or REDMOTE you can use the navigation group to highlight the clip 
playback status bar. 

 

The navigation group will also allow you to perform the following actions to the clip: 

    

A Scroll Wheel B Directional Pad C Enter Button 

• Scroll Wheel: Rotating Clockwise or Counter-Clockwise will move through the clip on frame at a 
time forwards or backwards. 

• Directional Pad: Pressing Left or Right to open and allow playback of the previous or next clip on 
the media. 

• ENTER Button: Pressing the ENTER button controls Play / Pause of playback. 

C 

B 

A 
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LOWER CONTROLS 

From Left to Right, PLAYBACK SPEED, IN POINT MARKER, FRAME-BY-FRAME REVERSE, 
PLAY/PAUSE, FRAME-BY-FRAME FORWARD, OUT POINT MARKER, PLAY ONCE/LOOP, and 
PLAYBACK DIRECTION 

 

RESOLUTION / PROJECT FRAMERATE / QUALITY 

Display clip Resolution, Framerate and Quality (REDCODE). When using the touchscreen, touch the 
Resolution, Framerate and Quality (REDCODE) to display the METADATA for the clip. 

 

HISTOGRAM 

Displays the clip histogram. The histogram will change based on any changes made in the Upper 
Controls. When using the touchscreen, touch the histogram to display the TOOLS menu. 

 

PLAYBACK SPEED 

Allows you to select x1, x2, x4, x8, or x16 playback speed. 
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IN / OUT POINT MARKER 

Allows you to set In and Out Points during clip playback. This allows you to playback only a certain 
portion of the clip as desired. Helps when the clip is rather long and you want to focus on a particular 
segment. The In (Red) and Out (Green) points will be displayed in the Clip Playback Status Bar. You can 
use the navigation group to select the exact location of the In and Out Points if desired. 

 

FRAME-BY-FRAME REVERSE / FORWARD 

Allows you to move through the clip frame-by-frame in the reverse direction. 

 

PLAY / PAUSE 

Allows you to play and pause the clip. 

 

PLAY ONCE / LOOP 

Allows you to choose to play the clip one time or to loop the clip in the player. Loop is shown below. 
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PLAYBACK DIRECTION 

Allows you to play the clip forward or backwards. Reverse playback is shown. 

 

ADDITIONAL CLIP/CAMERA INFORMATION 

Will indicate if clip was recorded in HDRx and current camera power status as well as audio input 
signals. 

 

POWER 

The power menu displays the current power status of all attached power sources as well as allows you 
to shutdown the camera. 

POWER STATUS 

The power status is displayed for the BRAIN, SIDE HANDLE, REAR 1, REAR 2, REAR 3, and REAR 4. 

Below is what is displayed when the camera is connected to DC power and a REDVOLT is installed into 
the side handle with REDVOLT batteries installed in the optional QUAD BATTERY MODULE. 
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SHUTDOWN 

Power OFF controls are interlocked to prevent accidental powering down of the camera. For details on 
the different ways to power down your RED DSMC Camera, refer to BASIC OPERATION > POWER 
DOWN. 

1. Enter the Secondary Menu using the touch screen, REDMOTE or Side Handle. 

2. Select POWER. 

3. Select SHUTDOWN. 

 

4. The camera will immediately power down displaying SHUTTING DOWN…. If a REDMOTE is 
connected, the same message will display. 
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APPENDIX A: UPGRADING CAMERA FIRMWARE  

Your RED DSMC camera functionality may be upgraded by installing the latest firmware. 

Camera firmware is identified by Version and SVN number, which will be displayed by the camera on the 
LCD display when SYSTEM INFO is selected. A higher number reflects a later release.  

Make a habit of frequently visiting www.RED.com/support to check for later versions of camera 
firmware, Operations Guide updates, and post-production software. 

Your REDMOTE also requires a firmware upgrade. Go to APPENDIX E: REDMOTE OPERATION > 
MAINTENANCE > UPGRADING REDMOTE FIRMWARE. 

VERIFY CURRENT CAMERA FIRMWARE 

With the camera ON, select SECONDARY MENUS > SETTINGS > MAINTENANCE > SYSTEM INFO. 

 

The camera’s P.I.N. number and current firmware version will be displayed. 

 

UPGRADE PROCEDURE 

1. Download current firmware from http://www.RED.com/support. 

2. Follow instructions in “Epic_read_me…” file. 

3. To restore factory default settings, hold the power button down for 15 seconds while the camera is 
powering up. 

http://www.red.com/support�
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APPENDIX B: MANAGING DIGITAL MEDIA  

MEDIA 

REDMAG 1.8” SSD is available with capacities of 64GB, 128GB or 256GB. Record duration is 
dependent on resolution, quality and frame rate, but a 64GB SSD will typically provide 24 minutes of 
24fps 5K RAW recording. 

On MAC computers with REDCINE-X PRO installed, RED Watchdog will mount the SSD as “READ-
ONLY” by default and you cannot write the firmware to the SSD. RED Watchdog is identified by the RED 
Coin icon located on the Right side of the Menu Bar. Right-click on the icon to enter RED Watchdog 
settings and change to mount the drive as “READ-WRITE” to allow you to save the firmware to the SSD. 
Refer to REDCINE-X PRO OPERATION GUIDE for complete RED Watchdog instructions and details.  

IMPORTANT: After connecting REDMAG 1.8” SSD to the camera and BEFORE recording, you 
should format the media using the camera (even if formatting was previously performed on a 
computer). Go to ADANCED MENU > MEDIA > FORMAT to properly format media before 
recording. 

FORMATTING MEDIA 

Media must be formatted prior to using it for recording. Formatting is performed on camera, although 
media may be erased on a Macintosh OS X personal computer, allowing the camera to just add the 
necessary project profile and clip log data. 

NOTE: Media formatted on-camera will use a name and root volume in the format: 

Camera Letter + Reel Number + Month + Day + ** where ** is a two digit alphanumeric random number 
generated by the camera for each file e.g. A001_0512A6.RDM  

Clips recorded to the media follow similar naming conventions 

A001_C001_0512A6_001.RDC and A001_C001_0512A6_H.mov etc.  

IMPORTANT: Media must always be un-mounted prior to removal or disconnection from the 
camera. This ensures power is removed from the digital media and any open data files are closed. 
Failure to do so may result in lost data or corrupted files. Refer to REMOVE MEDIA FROM 
CAMERA (UNMOUNT). 

This procedure outlines the formatting of REDMAG 1.8” SSD media using the RED DSMC camera. 
Formatting the SSD media will take about 10 seconds. 

1. Insert SSD into camera. 

- Insert the REDMAG 1.8” SSD with the RED logo facing outward (away from camera body). SSD 
firmly into its slot, but without using excessive force to prevent damage. 

2. When SSD media is inserted into the camera, the camera will recognize if the media is unformatted: 

- On LCD, EVF and external monitors, in the media section of the GUI, NONE will be displayed 
twice (as opposed to when no media is inserted, the GUI displays NONE with three dashes 
below “---“). 
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- On REDMOTE, NONE will be displayed twice (as opposed to when no media is inserted, the GUI 
displays NONE with three dashes below “---“). 

- On the Side Handle, NA will be displayed (same as if no media is present). 

3. To format the media select SECONDARY MENUS > MEDIA > FORMAT MEDIA. 

 

4. You will be prompted to set the media and select FORMAT. 

 
 

- Viewfinder output(s) will display “FORMATTING”. 

 

NOTE: If when selecting FORMAT, the display indicates FORMAT FAILED, refer to MEDIA 
ERRORS. 

5. Once formatting is completed, the Viewfinder output(s) will display “THE MAGAZINE WAS 
SUCCESSFULLY FORMATTED THE DIGTAL MAGAZINE IS READY FOR IMMEDIATE USE”. 
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MEDIA CAPACITY REMAINING STATUS 

The Viewfinder output(s) will display the remaining media capacity in the MEDIA indicator (100% is 
shown). 

 

At 10%, remaining capacity the media status will turn yellow, at 5% it will turn red. At 2%, remaining the 
camera will cease recording. This reserves a small amount of capacity for ancillary data to be written to 
the media. 

NOTE: When media is full, the Side SSD LED will flash Red. 

EJECT MEDIA FROM CAMERA (UNMOUNT) 

IMPORTANT: Media must always be Ejected (un-mounted) prior to removal or disconnection from 
the camera. This ensures power is removed from the digital media and any open data files are 
closed. Failure to do so may result in lost data or corrupted files. 

Removing an SSD without first un-mounting it will not physically damage the media, however it does 
increase the risk of file corruption, so it’s good operational practice to un-mount the media if possible 
before removing or disconnecting. 

IMPORTANT: Unmounting the digital media takes a few seconds, protects the integrity of your 
recorded data and helps clips mount instantly to your workstation once in post-production, so it’s 
a recommended habit to develop. If you do not un-mount the media the camera will offer a 
warning – your files may not be damaged, but you will have been warned! 

NOTE: The camera will respond to physical removal of the media without un-mounting and 
display ”MEDIA REMOVED PRIOR TO UNMOUNT – DATA INTEGRITY RISK”. 

USING REDMOTE / TOUCHSCREEN LCD 

1. Go to SECONDARY MENUS > MEDIA. 

 

2. Select EJECT MEDIA. 
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3. When media is ejected, Viewfinder output(s) will display “MEDIA EJECTED SUCCESSFULLY“. 

 

4. Media can now be removed from the camera. 

USING SIDE HANDLE 

1. By default, the lower of the three (3) SYSTEM KEYS is set to Eject Media when pressed. 

 

2. When media is ejected, Viewfinder output(s) will display “MEDIA EJECTED SUCCESSFULLY“. 

 

3. Media can now be removed from the camera. 

USING SIDE SSD 

1. Press both User Keys 1 and 2 at the same time to eject REDMAG 1.8” SSD Media. 

2. When media is ejected, Viewfinder output(s) will display “MEDIA EJECTED SUCCESSFULLY“. 

 

3. Media can now be removed from the camera. 

COPYING MEDIA 

For use when media is connected directly to your computer. When copying media, it is recommended 
that you drag the complete .RDM folder on the digital magazine to the archive storage media. This 
copies all the media and metadata files. You will not need to copy the log, magazine profile, or presets 
files, but if you do so, it will do no harm. 
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ERASING MEDIA 

NOTE: If the media was formatted using SECURE FORMAT, you cannot erase the media using an 
external source. Erasing of the media must be performed by formatting on the camera. 

MACINTOSH OS X 

1. Connect the REDMAG 1.8” SSD via RED STATION REDMAG 1.8". 

2. Open the Disk Utility. 

3. Carefully choose the drive from the list on the left. 

4. Select the Erase tab. 

5. Choose MS-DOS (FAT) as the Volume Format. You can add a Name if desired, however the camera 
will overwrite this. 

IMPORTANT: Before performing the next step, double-check that this is the correct SSD that you 
wish to erase DATA FROM. 

6. Select Erase. When the pop up window appears click on the Erase button. 

7. When the media is erased, drag its icon to the trashcan and physically disconnect it. 

8. The media will need to be formatting by the camera before use. Refer to FORMATTING MEDIA. 

WINDOWS 

1. Connect the REDMAG 1.8” SSD via RED STATION REDMAG 1.8". 

2. Open Windows Explorer (go to my computer icon, right click and select EXPLORE). 

3. Double-click on the drive you wish to erase files from. 

4. Select all the files on the drive you wish to erase. 

IMPORTANT: Before performing the next step, double-check that this is the correct SSD that you 
wish to erase DATA FROM. 

5. Press the “DELETE” key on the keyboard, select FILE > DELETE or right-click on selected file and 
choose DELETE. When the pop up window appears click YES. 

6. The media will need to be formatting by the camera before use. Refer to FORMATTING MEDIA. 
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APPENDIX C: INPUT / OUTPUT CONNECTORS 

CAMERA BRAIN FRONT 

Shown with PL Mount installed. 

 

 

 

A MIC-1 3.5mm Audio Jack B MIC-2 3.5mm Audio Jack 

Camera Brain Connectors - Front 

 

  

  
A B 
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MIC-1, MIC-2 (MICROPHONE AUDIO) 

Two 3.5mm phone jacks on the front of the brain support two independent channels of balanced or 
unbalanced microphone level analog audio inputs. 

 

 

Microphone Input Connector 

PIN SIGNAL DESCRIPTION DIRECTION 

A (TIP) IN + Mic Input (+48V Phantom Power) In 

B (RING) IN - Mic Input (+48V Phantom Power) In 

C (SLEEVE) GND Camera ground -- 

 

Microphone Level analog audio input signals are routed via a high quality pre-amplifier and soft limiter, 
whose Gain may be controlled using the Input Level control to achieve the desired audio reference / 
recording level. Microphone inputs support +48V @ 10mA Phantom Power as a user selectable option. 

To assist with reference level setup, the camera provides a color-coded Peak Level Meter in the 
Graphical User Interface, with witness marks that indicate 0dBu (-20dbFS) and 0Vu (- 16dBFS) levels. 

Peak Level Meter range is –36dBu to +20dBu (-54dBFS to 0dBFS) and provides input clip indication. 

NOTE: A pre-fabricated XLR to TRS interface cable, Part Number 790-0229, is available from RED 
Digital Cinema. 

 

 
 
 
 
 
  

  

A 

B C 
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CAMERA BRAIN REAR 

 

 

A HD-SDI 
B Headphone 
C SYNC (Video Sync) 
D CTRL (RS232 Control) 
E GIG-E (Ethernet) 
F DC IN (Power Input) 
G HDMI 

Camera Brain Connectors - Rear 

  

D E 

A B 
C 

A 

G 
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HD-SDI  

A standard 75 Ohm BNC connector provides a broadcast specification high definition video output. 

 

PIN SIGNAL DESCRIPTION DIRECTION 

Center HD-SDI SMPTE-292M HD-SDI Out 

Shield/Screen GROUND Camera ground -- 

                                                                                             HD-SDI Output 

The HD-SDI output provides a 720p progressive scan video feed operating at 50.00 or 59.94 Hz or a 
1080p 10-bit 4:2:2 progressive scan video feed operating at 23.98, 24.00, 25.00 or 29.97 Hz when in 
1.5GHz HD-SDI mode, or a 1080p 10-bit 4:2:2 progressive scan video feed operating at a 50.00 or 59.94 
Hz when in 3GHz HD-SDI mode. 

The HD-SDI output may be specified as a PROGRAM output (clean feed video) or as a PREVIEW output 
(includes SurroundView™ look around, Clip Name, Timecode and Safe Action / Safe Title frame guides). 

In addition to video, the HD-SDI output also provides two channels of embedded audio, Time of Day 
and Edge timecode, record Tally flag and Clip Name information as SMPTE RP-188 VITC2 HANC 
metadata. 

NOTE: Default setting is PROGRAM. 

NOTE: HD-SDI video output is Progressive Scan; it does not support 1080i or 1080PsF modes. 
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HEADPHONE  

A 3.5mm stereo jack provides two channels of adjustable level analog audio for monitor headphones. 

 

 

 

Headphone Output Connector 

PIN SIGNAL DESCRIPTION DIRECTION 

A (TIP) LEFT Left channel audio Out 

B (RING) RIGHT Right channel audio Out 

C (SLEEVE) GND Camera ground -- 

 

The camera’s four audio channels may be monitored in pairs: either 1L - 2R or 3L - 4 R or as a quad mix 
of 1+3L – 2+4R based on the MIX parameter. Default is 1L-2R. 

Output volume may be adjusted as follows. 

Volume: (master volume) Adjusts headphone volume equally for left and right outputs. 

 Range is -18dB to 0dB in 1dB steps. Default is -9dB. 

NOTE: for maximum output signal quality, only use high impedance headphones. 

NOTE: in Version 3.x software the above selection is not available, the output is set to 1L / 2R. 

 

SYNC (VIDEO SYNC)  

A 4-pin LEMO connector supports shutter synchronization, GPI, timecode and genlock input signals. 

The shutter Sync input signal acts as an immediate response hardware trigger to commence a scan. 
This is useful for motion control and other applications where the camera is driven by a master timing 
device. When using SYNC as the camera shutter timing reference, fine shutter start time timing 
(SHUTTER PHASE) is disabled; make any desired timing adjustments at the external SYNC generator. 

Alternatively, this input may be used as a GPI (General Purpose Input) trigger, whose function is 
programmed in the USER KEYS menu. Default function for the GPI trigger is Record Start / Stop. 

The SMPTE timecode input provides a frame accurate time stamp for each frame of recorded video. 
External TC must be chosen in the Project > Timecode menu. When SMPTE timecode is detected it will 
align the internal TC value to the external TC signal at every :00 frame crossing of the external TC signal. 

A 

B C 
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The Video Genlock input may be used as a vertical interval reference signal for the sensor and HD-SDI 
outputs when precise synchronization is required between cameras, such as for 3D and live broadcasts. 

Note: When GENLOCK is selected as the sensor shutter reference, shutter start timing (SHUTTER 
PHASE) may still be adjusted. HD-SDI monitor outputs will automatically sync to the external 
GENLOCK signal as soon as it is detected, there is no need to enable this function. Sensor shutter 
sync to GENLOCK is only supported with HD-SDI. 

 

 

View into camera SYNC (Video Sync) Interface connector 

Mating Connector: FGG.00.304.CLAD27Z 

PIN SIGNAL DESCRIPTION 

1 GROUND Common Ground  

2 SS/GPI Shutter Sync / GPI Trigger Input 

3 TIMECODE SMPTE unbalanced timecode Input 

4 GENLOCK RS170A Tri-Level Sync Input  

 

NOTE: The Camera Brain’s Shutter Sync / GPI Trigger uses a 3.3 V Schmitt trigger (5 V tolerant),  
current supplied by the trigger source. Both edges of the input signal may be used as a trigger. 

For example, when GPI trigger is used for Record Start / Stop. 

• Start Record:  On Ground to 3.3 V transition 

• During Record:  Hold at 3.3 V 

• Stop Record:  On 3.3 V to Ground transition 

• During Stop:  Hold at Ground 
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NOTE: A pre-fabricated SYNC interface cable is available from RED Digital Cinema. 

• P/N 790-0154 – Video Sync – Camera to 3 BNC – 3 ft. (1m) 

• White BNC: Shutter Sync / GPI 

• Yellow BNC: SMPTE Timecode 

• Green BNC: RS170A Genlock  
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CTRL (RS232 CONTROL)  

A 4-pin LEMO connector supports RS232 remote control for 3D camera communication, and third party 
metadata ingest applications. 

The shutter Sync Output signal acts as an immediate response hardware tally of a scan. This is useful 
for 3D or motion control applications where a slave camera or lighting device needs to be synchronized 
to a master camera.  

Alternatively, this output pin may be used as a GPO (General Purpose Output) tally, whose function is 
programmed in the USER KEYS menu. Default function for the General Purpose Output is Record Tally. 

 

View into camera CTRL (RS232 Control) Interface connector 

Mating Connector: LEMO FGG.00.304.CLAD27Z 

PIN SIGNAL DESCRIPTION 

1 GROUND Common Ground  

2 232 RX RS232 RX 

3 SS/GPO Shutter Sync / GPO Output 

4 232 TX  RS232 TX 

NOTE: When active, the GPO tally presents 3.3V @ 0.04 Amps maximum between pins 1 and 3. 
When used as Sync Out, the rising edge of the pulse indicates start of exposure. When used as a 
Tally, the rising edge of the pulse indicates start of record, falling edge represents end of record. 

NOTE: A pre-fabricated CTRL interface cable is available from RED Digital Cinema.  

• P/N 790-0152 – RS232 – Camera to DB-9 – 3 ft. (1m) 

• DB-9 Pin 1: Shutter Sync / GPO 

• DB-9 Pin 2: RS232 Tx 

• DB-9 Pin 3: RS232 Rx 

• DB-9 Pin 4: Ground 
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GIG-E (ETHERNET) 

A 9-pin LEMO connector provides a Gigabit Ethernet port for remote camera setup, master / slave 
camera communication and external metadata ingest. 

 

 

View into Ethernet Interface connector 

Mating connector:  FGG.0B.309.CLAD32Z 

PIN SIGNAL DESCRIPTION DIRECTION 

1 B1_DC + Data Pair C+ -- 

2 B1_DC - Data Pair C- -- 

3 B1_DD+ Data Pair D+ -- 

4 B1_DD - Data Pair D- -- 

5 B1_DA- Data Pair A- -- 

6 B1_DA+ Data Pair A+ -- 

7 B1_DB+ Data Pair B+ -- 

8 B1_DB- Data Pair B- -- 

9 - Do Not Connect -- 

 

NOTE: Two pre-fabricated Ethernet interface cables are available from RED Digital Cinema.  

• P/N 790-0163 – Ethernet – Camera to Camera – 3 ft. (1m) 

• P/N 790-0159 – Ethernet – Camera to RJ45 – 3 ft. (1m) 

  



  

COPYRIGHT © 2012 RED Digital Cinema 955-0003_v3.2, Rev-A1 
170 

DC IN (POWER INPUT) 

The 6-pin LEMO connector accepts DC input power between +11.5 V and +17 V DC. Power 
conditioning provides protection against reverse-polarity connection, ESD, under and over voltage, and 
over current. 

 

 

View into camera DC IN Power Input connector 

Mating Connector:  LEMO FGJ.1B.306.CWLD72Z 

PIN SIGNAL DESCRIPTION 

1 
+VBATT Power input, +11.5 to +17 V DC 

2 

3 SCL-BATT Serial Battery Bus Clock 

4 
GROUND Power Return (Camera Ground) 

5 

6 SCA-BATT Serial Battery Bus Data 

 

WARNING: It is very important that both pairs of +VBATT and GROUND pins are wired up. DO 
NOT fabricate power cables with just one each of +VBATT and GROUND pins wired, as this may 
cause damage to the camera’s power supply; this is not covered by Warranty. 

NOTE: Two pre-fabricated DC Power input cables are available from RED Digital Cinema.  

• P/N 790-0138 – DC Power – REDBRICK® QUICKPLATE to Camera – 18 in. (0.5m) 

• P/N 790-0164 – DC Power – XLR to Camera – 10 ft. (3m) 
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HDMI OUT 

The HDMI output supports an HDTV and PC monitor compatible 10-bit 4:2:2 progressive scan video 
signal (with embedded audio) at 720p and 1080p resolution. 

The HDMI output may be specified as a PROGRAM output (clean feed video) or as a PREVIEW output 
(including SurroundView™ look around, Clip Name, Timecode and Safe Action / Safe Title frame guides). 

In addition to video data, the HDMI output also provides 4 channels of embedded audio. 

NOTE: Default setting is PREVIEW. 

NOTE: HDMI video output is Progressive Scan; it does not support 1080i or 1080PsF modes. 
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SIDE SSD MODULE 

          
A SSD Slot 

B VIEWFINDER (LCD/EVF) 

Side SSD Module 

The Side SSD Module mounts to the left side of the camera Brain. On the rear face of this module is a 
slot for inserting a REDMAG 1.8”SSD digital Magazine. Do not attempt to insert any other media type, or 
any foreign objects into this slot, as damage to the Side SSD Module and / or the camera Brain may 
occur. 

The VIEWFINDER output Module on the front face of the Side SSD Module provides digital video, 
communications and power interconnection between the camera and a RED EVF or RED LCD digital 
display. Due to the requirement for absolute data integrity this requires a custom cable manufactured by 
RED, the pin-out of this interface is not published. 

NOTE: Pre-fabricated EVF / LCD cables are available from RED Digital Cinema.  

• P/N 790-0157 – EVF / LCD Cable – Right Angle to Right Angle – 6 in. (0.15m)  

• P/N 790-0153 – EVF / LCD Cable – Right Angle to Straight – 18 in. (0.5m) 

  

 

A 

B FRONT REAR 
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REDMOTE 

This section describes the physical connectors on the REDMOTE. 

 

           

 

A Mini USB B Camera Interface 

REDMOTE Connections 

The REDMOTE interface connector allows communication between the REDMOTE and the camera 
Brain or any expansion module. Make sure these contacts are kept clean and free of any contaminants 
that may interfere with a reliable electrical contact. 

 

  

A 

B 
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APPENDIX D: DEFAULT KEY FUNCTIONS 

  

CAMERA BRAIN 

KEY FUNCTION KEY FUNCTION 

Record Half Press Key Disabled- Record Half Release -Key Disabled- 

 Record Full Press Record: Toggle 

  SIDE HANDLE 

KEY FUNCTION KEY FUNCTION 

User A Press AF Mode: Cycle User B Release -Key Disabled- 

User B Press WB: Auto Calc User C Release -Key Disabled- 

User C Press Magnify: Toggle User D Release -Key Disabled- 

User D Press Exposure Check: Toggle User 1 Release -Key Disabled- 

User 1 Press Slot: Set ISO User 2 Release -Key Disabled- 

User 2 Press Slot: Set Aperture User 3 Release -Key Disabled- 

User 3 Press Slot: Set Shutter User 4 Release -Key Disabled- 

User 4 Press Slot: Set Color Temp User 5 Release -Key Disabled- 

User 5 Press Exposure Check: Toggle User 6 Release -Key Disabled- 

User 6 Press -Key Disabled- User 7 Release -Key Disabled- 

User 7 Press Eject Media User 1+4 Release -Key Disabled- 

User 1+4 Press SH: Toggle Key Lock Record Half Release -Key Disabled- 

Still Select Focus Mode: Still Record Full Release -Key Disabled- 

Movie Select Focus Mode: Motion Backlight Release -Key Disabled- 

Record Half Press AF: Start Nav Menu Release -Key Disabled- 

Record Full Press Record: Toggle Nav North Release -Key Disabled- 

Backlight Press SH: Toggle Backlight Nav South Release -Key Disabled- 

Nav Menu Press Navigation: Menu Nav East Release -Key Disabled- 

Nav North Press Navigation: Up Nav West Release -Key Disabled- 

Nav South Press Navigation: Down Nav Enter Release -Key Disabled- 

Nav West Press Navigation: Right Rocker + Release -Key Disabled- 

Nav East Press Navigation: Left Rocker - Release -Key Disabled- 

Nav Enter Press Navigation: Select Rotary Front CW Navigation: CW 

Rocker + Press Iris: Open Rotary Jog CW Navigation: CW 

Rocker - Press Iris: Close Rotary Front CCW Navigation: CCW 

User A Release -Key Disabled- Rotary Jog CCW Navigation: CCW 
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SIDE SSD MODULE 

KEY FUNCTION KEY FUNCTION 

User 1 Press -Key Disabled- User 1 Release -Key Disabled- 

User 2 Press -Key Disabled- User 2 Release -Key Disabled- 

User 1+2 Press Eject Media Record Half Release -Key Disabled- 

Record Half Press AF: Start Record Full Release -Key Disabled- 

Record Full Press Record: Toggle 

  REDMOTE 

KEY FUNCTION KEY FUNCTION 

User A Press AF Mode: Cycle Nav Enter Press Navigation: Select 

User B Press RAW Check: Toggle Rocker + Press Iris: Open 

User C Press Magnify: Toggle Rocker - Press Iris: Close 

User D Press Exposure Check: Toggle Rotary CW Navigation: CW 

Still Select Focus Mode: Still Rotary CCW Navigation: CCW 

Movie Select Focus Mode: Motion User A Release -Key Disabled- 

Record Half Press AF: Start User B Release -Key Disabled- 

Record Full Press Record: Toggle User C Release -Key Disabled- 

Nav Menu Press Navigation: Menu User D Release -Key Disabled- 

Nav North Press Navigation: Up Record Half Release -Key Disabled- 

Nav South Press Navigation: Down Record Full Release -Key Disabled- 

Nav East Press Navigation: Right Rocker + Release -Key Disabled- 

Nav West Press Navigation: Left Rocker - Release -Key Disabled- 

DISPLAY (BRAIN) 

KEY FUNCTION KEY FUNCTION 

LCD  User 1 Press Magnify: Toggle LCD Down Arrow Press Decr. LCD  Brightness 

LCD User 2 Press Exposure Check: Toggle EVF User 1 Press Magnify: Toggle 

LCD Up Arrow Press Incr. LCD  Brightness EVF  User 2 Press Exposure Check: Toggle 
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APPENDIX E: REDMOTE OPERATION 

CONTROL, CONNECTORS AND DISPLAY 

This section describes the REDMOTE physical controls, connectors and color LCD display. 

CONTROLS 

 

REDMOTE Controls 

A Stills/Motion Switch F User Function Keys A-D K Menu Buttons 4-8 

B Release Latch - Left G MENU Button L Power/Lock Switch 

C Record Status LED H Menu Buttons 1-3 M Release Latch – Right 

D Wireless Status LED I Navigation Group N USB External Power Port 

E Zoom Rocker Switch J Focus / Record Button   

STILL / MOTION SWITCH 

The STILLS/MOTION toggle switch is used to switch between STILLS operation (DOWN) and MOTION 
operation (UP). When the toggle switch is set to the MOTION position, all camera settings and defaults 
are movie specific. When the toggle switch is set to the STILLS position, all camera settings and defaults 
are stills photography specific. 

Note: In Version 3.x software the STILLS/MOTION switch is disabled. Default mode is MOTION.  

C 

D 
A 

B 

E 

G 

F 

H 

J 

I 

N 

M 

K 

L 
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LEDS 

There are two status LED indicators located above the rockers switch on the left side of the LCD display.  

 

The upper LED is used to signal camera readiness and camera record status. 

• Red – Camera Startup / Camera Recording. 

 

The lower LED is used to signal camera readiness and REDMOTE communication status to the camera.  

• Green – Camera Ready / REDMOTE connected. 

• Blinking Green – Searching / Establishing communication 

ROCKER SWITCH  

The function of the pressure sensitive ROCKER SWITCH may be assigned by the operator to one of a 
number of operational controls. Refer to SECONDARY MENUS > SETTINGS > SETUP > KEYS / 
SHORTCUTS. 

USER FUNCTION KEYS 

The function of each User Function Key may be assigned by the operator to one of a number of 
operational controls. Refer to SECONDARY MENUS > SETTINGS > SETUP > KEYS / SHORTCUTS. 

Default settings for User Function Keys A-D are as follows: 

• User Key A – Toggles Auto Focus  

• User Key B – Toggles View RAW 

• User Key C – Toggles Focus Check (1:1 Magnify) 

• User Key D – Toggles Sensor RAW Exposure Check 

MENU BUTTON 

Below and to the left of the User Keys is the MENU button, press to switch between primary level and 
secondary level Camera menus. When in Camera menus or REDMOTE menus, press once to exit 
menus.  

SOFT MENU BUTTONS 1-3  

Below the LCD are three Soft Menu Buttons, whose specific functions are indicated by the LCD screen. 
For complete information refer to OPERATION > REDMOTE MENUS > SOFT MENU BUTTONS 1-3. 

NAVIGATION GROUP 

The Navigation Group allows navigation of the camera menus and adjustment of selected parameters. 
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REDMOTE Navigation Group 

A Scroll Wheel B Direction Keys C Enter Button 

The Navigation Group has three separate operational capabilities. 

SCROLL WHEEL 

The Scroll Wheel allows the operator to select and adjust the values of selected camera parameters. 

DIRECTION KEYS 

The Direction Keys allows Left / Right / Up / Down navigation thru the camera menus to select a desired 
parameter for adjustment. 

ENTER BUTTON  

The Enter button allows confirmation of a parameter adjustment or operational mode selection. 

FOCUS AND RECORD BUTTON  

Below the Navigation Group is the focus and record button. A half press initiates Auto Focus; a full press 
initiates Stills capture or starts /stops a Movie recording.  

When recording, the upper LED will illuminate Red and the Timecode readout on the REDMOTE LCD will 
also display in red colored text. 

 

Note: In Version 3.x software the frame count of the Timecode is not displayed. This is normal and does 
not indicate an error.  

C 

B 

A 
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SOFT MENU BUTTONS 4-8 

To the right of the LCD are five Soft Menu Buttons. These buttons select a variety of camera status 
pages. For complete information refer to OPERATION > REDMOTE MENUS > SOFT MENU BUTTONS 
4-8. 

Note: In Version 3.x software, Soft Menu Buttons 7 and 8 are undefined.  

POWER / KEY LOCK SWITCH 

If the REDMOTE is powered OFF, moving and holding the switch in the down (POWER) direction for 2 
seconds will power UP the REDMOTE and if the REDMOTE is powered ON, moving and holding the 
switch in the down (POWER) direction for 5 seconds will power DOWN the REDMOTE. 

Moving the switch to the up (LOCK) position will lockout all REDMOTE buttons to prevent unintentional 
operation. When in the LOCK position, KEYS LOCKED will be displayed in red text above the SOFT 
MENU BUTTONS 1-3 on the REDMOTE LCD display. 

USB POWER PORT 

The USB port may be used to charge the REDMOTE internal battery from a suitable USB power source. 
Refer to CHARGING / BATTERY LIFE > CHARGING USING USB CONNECTOR for complete 
information. 

OPERATION 

DOCKING AND UNDOCKING 

This section describes how to physically dock / undock the REDMOTE to / from the camera Brain or the 
back of the rearmost expansion module.  

DOCKING 

1. Place the female V-Mount of the REDMOTE over the male V-Mount of the camera Brian or rearmost 
module. 
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          Note: For illustration only: rear surface of REDMOTE should face towards camera 

 

2. Slide the REDMOTE down until a click is heard which indicates the REDMOTE is securely attached. 

UNDOCKING 

1. Depress the two latch release buttons located on each side of the REDMOTE. 

2. Slide the REDMOTE upward to release from the V-Mount of the camera Brain / rear most module. 

3. Remove the REDMOTE.  

 

POWER UP / DOWN 

Located on the upper right side of the REDMOTE is the Power / Key Lock Switch (refer to CONTROLS). 
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POWER UP 

CONNECTED TO CAMERA 

If the REDMOTE is physically attached to a camera, when the camera is powered up the REDMOTE will 
automatically power up along with the camera.  

NOT CONNECTED TO CAMERA 

To manually power up the REDMOTE, slide and hold the Power / Key Lock Switch in the down direction 
for 2 seconds, then release.  

POWER DOWN 

USING CAMERA 

When REDMOTE is connected to the camera and the camera is powered down, the REDMOTE will also 
power down. When disconnected from the camera, the REDMOTE will not power down with the camera. 

USING REDMOTE 

To power down REDMOTE, slide and hold the Power / Key Lock Switch in the down direction for 5 
seconds.  

Or slide and hold the Power / Key Lock Switch in the down direction momentarily, then release. A screen 
will display with options to power down the REDMOTE, the Camera, or REDMOTE and Camera 
together. Select the desired option and press the ENTER key in the REDMOTE Navigation Group. 

 

 

NOTE: Wireless mode shown. When docked to camera, SHUTDOWN CAMERA is not displayed. 
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RECORDING 

• To record, press the Red REC (record) button. If media is connected and properly formatted, the 
upper LED will illuminate Red and the Timecode value displayed in the LCD will change to Red text. 

 

 

To stop recording, press the REC button a second time. After recording to media is completed, the 
upper LED will go out and the Timecode value displayed in the LCD will change back to White text. 

 

Note: If media is NOT connected when record is requested, the REDMOTE LCD and camera 
VIEWFINDER (MENUS) output will indicate “NO MEDIA ATTACHED”. 

                                                 
 
 

ACCESSING CAMERA CONTROLS / SETTINGS 

The Navigation Group is used to navigate through camera menus. Refer to CAMERA OPERATIONAL 
CONTROLS > REDMOTE > NAVIGATION GROUP. The camera settings and status are displayed on the 
REDMOTE LCD. Refer to BASIC OPERATION > GRAPHICAL USER INTERFACE AND NAVIGATION > 
REDMOTE. 
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CHANGING CAMERA SETTINGS 

USING CAMERA LCD / EXTERNAL MONITOR AS REFERENCE 

To adjust a parameter value displayed on the camera’s Upper Status Group, first note the red colored 
bar (located under 24fps in this example), indicating the currently active parameter for instant 
adjustment. 

 

Use the NAVIGATION GROUP directional pad to move the cursor to a different parameter if desired, 
then press the ENTER key to select that parameter and use the Scroll Wheel to adjust that parameter’s 
value.  To confirm the change in parameter value and to exit the adjustment menu, press the ENTER 
button. 

To access the camera’s menus, press the MENU button at the lower left. The MENU displays on the 
EVF, LCD or external monitors if the LCD and/or EVF are not connected disconnected. 

 

 

Use the NAV GROUP to make changes to the cameras settings. Use the scroll wheel and directional 
pad to move the cursor to navigate and make changes to the desired settings. When a desired setting 
change is made, press the ENTER button or the directional pad UP arrow to exit from that setting. 

Exiting Menus to Main Screen 

To EXIT from the Secondary Menus and return to the main screen: 

• Press the MENU button until the main screen is displayed. 

USING REDMOTE LCD STAND-ALONE 

The LOCAL function of the REDMOTE allows you to adjust the camera settings from the REDMOTE 
while observing the parameters directly on the REDMOTE LCD as opposed to on the camera LCD or an 
external monitor. For complete details refer to REDMOTE MENUS > SOFT MENU BUTTONS 1-3 > 2 
REMOTE > LOCAL. 
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ADVANCED OPERATION: REDMOTE MENUS 

SOFT MENU BUTTONS 1-3 

Located below the main LCD display are three Soft Menu Buttons, who access advanced function 
menus identified by text in the LCD directly above the corresponding button. These menus control 
wireless connection (CONNECT), camera or local menus (REMOTE/LOCAL) and system setup (SETUP). 

WIRELESS CONNECT: SOFT MENU BUTTON 1 

Note: This Button is hidden if REDMOTE is attached to the camera or rear-most camera module.  

Note: If a REDMOTE has previously been successfully paired with a camera, and the REDMOTE 
has scanned the wireless network and found that camera, the following operation can be 
bypassed as the REDMOTE will auto scan and connect to that camera each time it is powered ON 
and undocked.  

CONNECT REDMOTE TO A PAIRED CAMERA  

NOTE: The following procedure assumes the camera has already been paired and named 
DEFAULT under the camera’s SETTINGS > SETUP >REDMOTE and COMMUNICATION menus.  

 
1. Press CONNECT to initiate a scan by the REDMOTE for available paired cameras in wireless range. 

2. If the REDMOTE fails to find a camera it has been paired with the following screen will be displayed. 
Select RESCAN and press the ENTER button in the Navigation Group to force a second scan for 
paired cameras in wireless range. A wireless scan typically takes 20-30 seconds. 

 

 

3. When REDMOTE finds a camera or cameras it has been paired with in wireless range, the name of 
the available camera or cameras will be displayed - for example a single camera named DEFAULT. 
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4. Select the desired camera to connect to for REDMOTE wireless operation and press the ENTER 
button in the Navigation Group. The REDMOTE will connect to the selected camera. 

 

 

5. Once connected, the REDMOTE will display the key operating parameters of the selected camera. 
The wireless signal strength will be shown in the lower Right corner of the REDMOTE screen.                                                    

 

 

The camera VIEWFINDER monitor output will confirm REDMOTE is wireless connection by displaying 
RM and a signal strength icon in Green on the Lower Status Group.  
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Note: Once this procedure has occurred once, the REDMOTE will automatically search 
for the camera each time it is undocked, until the paired camera selection is changed. 

CANCEL 

If you wish to exit the CONNECT menu at any time press CANCEL. 
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DISCONNECT 

To stop communicating wirelessly with the camera, select Soft Menu Button 1 Connect, then select 
DISCONNECT and press the ENTER key in the Navigation Group.  

 
 

RECONNECTING IF SIGNAL IS LOST 

On loss of wireless communication REDMOTE will scan for the camera it was last paired with.  

 

 

If the REDMOTE is unable to re-connect after 30 seconds, it will enter the manual SCAN menu, follow 
the procedure outlined about to scan and identify camera(s) that you wish to connect to.  
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OPERATING WITH MULTIPLE CAMERAS FROM A REDMOTE 

To control more than one camera from a single REDMOTE, first pair the REDMOTE with each camera. 
After pairing REDMOTE to the desired cameras, press Soft Menu Button 1: CONNECT. Available 
cameras will be listed. 

 

Select the camera you wish to control and press the ENTER button. When you want to switch to a 
different camera, press Soft Menu Button 1: CONNECT again to list available cameras and re-select.  

 

                                                      

 

REDMOTE OR LOCAL MENUS: SOFT MENU BUTTON 2  

When selected allows the user to toggle the REDMOTE between REMOTE and LOCAL menus. 
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REMOTE  

Allows the user to adjust camera settings from REDMOTE, by navigating the camera menus appearing 
on the VIEWFINDER output of the camera, with summary data only appearing on the REDMOTE LCD 

 

LOCAL 

Allows the user to adjust camera settings from REDMOTE, by navigating camera menus appearing on 
the REDMOTE LCD, with summary data only appearing on the VIEWFINDER output of the camera.  

 

 

CUSTOMIZING LOCAL MENUS. 

When operating in LOCAL mode, REDMOTE provides the user the option to configure which parameters 
to display in each of the parameter status windows. You can assign the parameters to one of the 5 
pages of information available under Soft Menu Buttons 4-8. 

To customize parameters: 

1. Ensure camera is ON and wirelessly connected to REDMOTE. 

2. If Soft Menu Button 2 reports as REMOTE, press it once so it reports LOCAL. 

3. Select the Soft Menu Button page you would like to set the parameter on from the right hand side of 
the LCD. Refer to SOFT MENU BUTTONS 4-8. 

4. Use the directional arrows on the Navigational Control to move the Red cursor to the desired 
location within that page to place the parameter. 

5. Now press SETUP: Soft Menu Button 3. 



  

COPYRIGHT © 2012 RED Digital Cinema 955-0003_v3.2, Rev-A1 
190 

6. Select “Setup Slot” and press the ENTER button. 

 

7. A new Setup window will appear displaying available parameters to display. 

 

8. Select the desired parameter and press the ENTER button. 

 

                                                     

 

9. You may now control this parameter directly from the REDMOTE. 

REDMOTE SETUP: SOFT MENU BUTTON 3 

When pressed, SETUP provides the option of forcing the REDLINK wireless link ON or OFF and 
selecting the following REDMOTE Setup menu. 
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Adjustable parameters include LCD screen brightness; beep speaker Volume and Auto Shutdown time. 
In the lower section of the display is the MAC address and the current firmware build of the REDMOTE  

Brightness 

The BRIGHTNESS control adjusts the LCD backlight intensity. Set value to maximum for daylight 
visibility, set value lower for nighttime operation or for maximum battery run time when operating in 
wireless mode.  

Default value is Maximum. 

Volume 

The VOLUME control adjusts the loudness of the beep speaker. As you adjust this value the REDMOTE 
will beep the speaker to give an audible confirmation of the selected volume. Default value is Minimum. 

Auto Shutdown 

The AUTO SHUTDOWN control adjusts the amount of time a REDMOTE will continue to operate when in 
the wireless mode after no detected activity (i.e. no button presses are detected) before powering down.  

Default value is OFF (REDMOTE will operate continuously until manually powered down.)   

DISPLAY LAYOUT: SOFT MENU BUTTONS 4-8 

To the right of the LCD are five Soft Menu buttons 4-8. These buttons select between a variety of 
camera status page layouts.  

Note: In Version 3.x software, buttons 7 and 8 are undefined.  

          

        Menu Button 4         Menu Button 5                    Menu Button 6         Menu Button 7 & 8 
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MAINTENANCE 

INTERNAL BATTERY  

CHARGE STATUS 

An icon shows the charge status of the REDMOTE battery in the lower right corner of the LCD.  

 

 

When REDMOTE is operating in wireless mode, the icon indicates current charge capacity. When 
satisfactory the icon is displayed in Green. When battery charge becomes marginal, the icon turns 
Yellow. When battery charge is critically low, and wireless communication is at risk of being lost the icon 
turns Red. The REDMOTE should be re-attached to the camera or rearmost module, or be attached to a 
suitable USB power source, to recharge the battery before re-attempting wireless operation.   

When attached to the camera or rearmost camera module, or external USB power source, this icon will 
either display solid green, indicating fully charged, or blink, indicating the battery is being charged by the 
camera or external USB power source. 

BATTERY LIFE 

When using the REDMOTE in wireless configuration, the battery will last approximately 8 hours before 
charging is necessary. 

NOTE: When not using the REDMOTE, for maximum battery storage life, use the Power / Lock 
Switch to power down the REDMOTE completely by pressing down in the power off position and 
using the displayed menu to shut down the REDMOTE and/or the REDMOTE and camera. Refer 
to POWER UP / DOWN > POWER DOWN. If the Power / Lock Switch is pressed down in the power 
off position and held until the REDMOTE powers down, the battery storage life will be reduced 
greatly as there will be a slight power draw on the REDMOTE when shut down using this 
procedure. 
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CHARGING 

CHARGE TIME 

A fully discharged REDMOTE battery will be fully charged in approximately 6 hours. 

USING CAMERA 

While connected to the camera, the REDMOTE will automatically recharge its internal battery. Charge 
status is indicated by the Green Battery Icon at the top-right of the REDMOTE LCD display screen. A 
fully discharged REDMOTE battery will be re-charged in approximately 6 hours if connected to a 
powered camera or a USB based power source such as laptop P.C. 

USING USB CONNECTOR  

The REDMOTE can be charged by connecting the RED Mini-USB-to-USB cable (790-0230) between 
REDMOTE and a computer or a cell phone charger. 

NOTE: The REDMOTE can be charged using the Mini-USB connector while connected and controlling a 
camera wirelessly. 

NOTE: If the computer / cable / hub do not provide enough voltage, the REDMOTE will not charge 
and show an "Error Charging" message. 

1. Connect the USB connector to any computer (computer must be ON to charge REDMOTE). 

2. Connect the Mini-USB end to the REDMOTE USB Port located on the lower right side (under rubber 
protective cover). 

3. If the REDMOTE is powered down (and paired camera is OFF), the REDMOTE will power UP, display 
STARTING UP, display SEARCHING (with flashing Green LED), then settle into IDLE mode. 

4. Green battery indicator will blink, indicating REDMOTE is charging. 

5. A fully discharged REDMOTE battery will be fully charged in approximately 6 hours. 
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UPGRADING REDMOTE FIRMWARE  

The REDMOTE update utility allows you to upgrade the firmware on your REDMOTE. 

NOTE: After firmware has been upgraded, the REDMOTE must be paired to the camera again. 

SETUP 

CONFIGURING REDMOTE CONNECTION WITH COMPUTER (MAC) 

The first step in upgrading REDMOTE firmware is to establish communication between the MAC and the 
REDMOTE. 

1. Connect a USB to mini-USB cable between the computer and the USB connector on the 
REDMOTE. 

2. Go to System Preferences and choose Network. This may open automatically when the REDMOTE 
is connected. 

3. Look for a device called RNDIS/ ...Gadget. 

 

4. Change Configure IPv4 setting to “Manually” (as shown). 

5. In the IP Address field, enter 192.168.0.1 (as shown). 

6. In the Subnet Mask field, enter 255.255.255.0 (as shown). 

7. The Status should change to “Connected” after changes. 
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NOTE: After entering the IP address as shown above you may not connect during the upgrade 
procedure. When you go back and check the IP address you see that it is 0.0.0.0 HOWEVER the 
status of the device is shown as “Connected”. 

 

If this is the case, you may need to enter the IP address a second or possibly a third time to make 
it stick. 

8. Click “Apply’ at the bottom of the Network window. 

9. Proceed to UPGRADING REDMOTE FIRMWARE. 

UPDATING REDMOTE FIRMWARE 

The following information will guide you through proper updating of your REDMOTE firmware. 

MAC 

1. Download the camera upgrade EPIC_vX.X.XX zip file located at http://www.red.com/support. 

2. The file will unzip automatically when downloaded. The REDMOTE Upgrade is located in this 
download. 

3. Navigate to the downloads folder and open the newly created EPIC_vX.X.XX folder; or open it 
directly from the downloads window. 

4. Open the REDmoteUpgrade_vXXX folder. 

5. Open the MAC folder. 

6. Double-click the REDmoteUpgradeApp. A Terminal window will open and the REDMOTE Software 
Wizard will open. 
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7. Click “Connect”. When REDMOTE has been established, “Connection to REDMOTE has been 
achieved” will be displayed. 

NOTE: If REDMOTE does not connect, verify that the IP address set under CONFIGURING 
REDMOTE CONNECTION WITH COMPUTER (MAC) has held. If not, enter it again as outlined in 
the procedure. 

 

8. Click "Select File" and navigate to the redmote.1.bin file located in the REDmote_firmware_vXXX 
folder. 
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9. Select "Start upgrade". 

 

10. File transfer status will be displayed as a Blue bar. 

11.  “Updating Firmware” will be displayed with a Green status bar showing upgrade progress. 
REDMOTE will also display UPGRADE during this process. 
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12. Once the File Transfer Status is completed, the REDMOTE Software Wizard will display “Please Wait 
and Don’t Unplug – Firmware Upgrade is in Progress on REDMOTE”. 

 

13. After a few more seconds, the REDMOTE Software Wizard will display “Firmware Upgrade 
Successfully Done”. Select OK. 

 

14. The REDMOTE Software Wizard will disconnect from the REDMOTE. 

15. REDMOTE will reboot. 

16. REDMOTE upgrade is complete. REDMOTE will display “POWER UP”, then “SEARCHING” once the 
upgrade has completed. Finally displaying “Camera: RESCAN…” and going into IDLE mode. 
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17. Verify the current REDMOTE firmware version by selecting SETUP > SETUP SYSTEM on the 
REDMOTE. 

 

18. REDMOTE upgrade is complete. You can now reconnect to the camera. 

NOTE: Pairing of the REDMOTE may not be necessary after upgrading the REDMOTE firmware, 
however after upgrading the camera firmware, you must pair the REDMOTE again. 

WINDOWS 

Install Upgrade Utility 

This procedure outlines installation of the REDMOTE Upgrade Utility for Windows computers. 

1. Download the REDMOTE Update zip file to your desktop. 

2. Uncompress the zip file. 

3. Open the newly created folder. 

4. Double-click on the REDMOTE_upgrade_setup.exe file to install the program. 
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5. Select “I Agree” to the license agreement. 

 

6. On the Choose Components screen, select Install REDMOTE Firmware. 

7. Select “Next”. 
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8. Choose location to install the REDMOTE Upgrade Utility . 

 

9. Choose the location for the shortcut. 
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10. The program will now install. A progress bar is displayed while installing. When complete, select 
Close. 

 

11. The REDMOTE Upgrade Utility installation is complete. 

Upgrading REDMOTE Firmware 

The following information will guide you through proper upgrading of your REDMOTE firmware on 
Windows computers using the REDMOTE Upgrade Utility. 

1. Connect a USB to mini-USB cable between the computer and the USB connector on the 
REDMOTE. 

2. Ensure the REDMOTE wakes up and displays the “Total Cameras Found” screen. 

NOTE: When properly connected to the PC, the battery charge indicator will be Green and blink. 

3. Under Programs, locate REDMOTE_update and open the program. 

4. The REDMOTE Upgrade Utility window will open. 

 

5. Select “Connect” to establish communication between the REDMOTE and REDMOTE Update. 
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NOTE: If when connecting, communication is not established quickly, close the Upgrade Utility, 
open it again and select Connect again. This may have to be repeated a few times until 
communication is established. 

6. When connected, ”Connection is Established with REDMOTE” is displayed. 

 

7. To begin upgrade, click on “Select File”. 

8. Navigate to the *.bin file for updating the REDMOTE firmware. 

NOTE: If you choose an incorrect file, click on “Select File” again to locate the correct file. 

NOTE: Only one file can be added for upgrade. 
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9. The selected file is shown in the window. In this case the selected file is: REDmote.1.bin. 

 

10. After selecting and verifying the correct file for upgrading the REDMOTE, select “Start Upgrade”. 

11. During the upgrade, the REDMOTE Software Wizard will display “Please Do Not Unplug” as well as a 
status bar showing “File transfer progress.” 

   

12. During the upgrade, the REDMOTE will display “Upgrading Firmware” as well as a status bar 
showing upgrade progress. 
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13. When upgrade is complete, the REDMOTE will automatically reboot and display “REBOOTING” on 
the screen. 

 

14. The REDMOTE Software Wizard will display “Firmware Upgrade Successfully Done”. 

 

15. Verify the current REDMOTE firmware version by selecting SETUP > SETUP SYSTEM on the 
REDMOTE. 
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16. Select “Disconnect” on the REDMOTE Upgrade Utility. 

 

17. REDMOTE firmware upgrade is complete. 
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APPENDIX F: 3D SETUP / OPERATION 

OVERVIEW 

The following information outlines basic procedures to connect two RED DSMC cameras together in a 
Master / Slave configuration for 3D operation, operation of cameras in Master / Slave configuration and 
clip naming conventions for clips recorded on those cameras. The MASTER camera will control only the 
METADATA parameters of both cameras. On the SLAVE camera, any other setting outside of these will 
need to be manually changed before recording. 

CAMERA SETUP 

Select one camera to be designated as Master and a second to be designated as Slave. 

NOTE: Cameras can also be set up in a MASTER / MASTER and SLAVE / SLAVE configuration. To 
set as MASTER / MASTER select ALL under TARGET for both cameras. This will allow either 
camera to make METADATA changes and control record start/stop of both cameras. To set as 
SLAVE / SLAVE select NONE under TARGET for both cameras. This allows each camera to 
control its own METADATA.  

MASTER CAMERA 

Perform the following steps on the Master camera: 

1. Go to SECONDARY MENUS > SETTINGS > SETUP > COMMUNICATION > NAME and give the 
camera a unique NAME (CAM A, LEFT, etc…). 

 

2. Under TARGET select ALL. 

3. Give the camera a unique IP address. 

4. Go to SLAVE CAMERA. 
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SLAVE CAMERA 

Perform the following steps on the Slave camera: 

1. Go to SECONDARY MENUS > SETTINGS > SETUP > COMMUNICATION > NAME and give the 
camera a unique NAME (CAM B, RIGHT, etc…). 

 

 

2. Under TARGET select NONE. 

3. Give the Slave camera a unique IP address different from the Master. 

CLIP NAMING CONVENTIONS 

REEL NO. / SLATE (CAMERA ID) / CAMERA POSITION 

Before shooting in Master / Slave or Master / Master configuration for a Stereo / 3D production, make 
sure the Camera Slate (i.e. Reel No. and Cam ID) are set to the same value for both Master and Slave 
cameras. Then change the Cam Pos value from the system default of CENTER, to either LEFT or RIGHT 
to identify the "left eye" and "right eye" camera in the stereo pair. 

The Reel No, Cam ID and Cam Pos can be set when formatting the media or after formatting by using 
the SET option. Refer to SECONDARY MENUS > MEDIA. 
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For example, if Master is set to LEFT and Slave is set to RIGHT and both Cam IDs are set to S, the first 
clip recorded by this stereo camera configuration will be: 

- Master:  S001_L001_0503B6.R3D 

- Slave:  S001_R001_0503R7.R3D 

Where 0503 represents 05 March, B6 and R7 are examples of camera generated wildcard characters. 

Note: If both Master and Slave cameras are accidentally left in default settings of CENTER and 
CAM A ID, the clips recorded on each camera will have the same file structure, with the exception 
of the camera generated wildcard characters which protect against exact file name duplication: 

- Master:  A001_C001_0503B6.R3D 

- Slave:  A001_C001_0503R7.R3D 

CONNECTING CAMERAS 

1. While still powered up, interconnect the cameras using a Master/Slave GIG-E Cable P/N 790-0163. 
Plug the cable into the GIG-E connector on the rear of each camera body.. 

   

2. Power down both cameras, then power back up. If properly connected, LAN will illuminate Green on 
the UI. 

3. Connect a SYNC cable P/N 790-0154 to each camera and connect as to your 3rd party device. 

• Yellow BNC connector is for SMPTE unbalanced Timecode input. 
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• Green BNC connector is for Tri-Level Sync (Genlock) input. 

• White BNC connector is a dual-purpose (Shutter SYNC input or GPI) input. 

4. Go to SETTINGS > SETUP > GPIO/SYNC > SYNC MODE and select GENLOCK. 

5. Verify the camera’s project frame rate matches the Genlock and Timecode generator(s) framerate(s). 

6. When properly connected and synchronized, TC, GEN and SYNC will illuminate Green on the UI. 

OPERATION 

CHANGING SETTINGS 

When changes are made to the Master camera settings, the Slave camera setting will also change, but 
not in real-time. For example, when you change the Frame Rate on the Master camera, you will not see 
the change on the Slave camera until you set the Master camera at the new Frame Rate. 

Also when making changes to the Secondary menu settings, the Slave camera will not display those 
changes unless it affects items displayed on the main screen (example: when HDRx is enabled on the 
Master camera, HDR will change to HDRx on the Slave camera). 

RECORDING 

When the power/record button is pressed on the Master camera to start/stop recording, the Slave 
camera will also start/stop recording.  

POWER DOWN 

When the Master camera is powered down using the Secondary Menu > Power, the Slave camera will 
also power down.  
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APPENDIX G: EXPOSURE – USING FALSE COLOR AND ISO 

NOTE: The following section uses a RED ONE camera display to illustrate exposure tools; 
however, the same principles apply to RED DSMC camera systems.  

RED DSMC cameras provide several advanced exposure indication tools. In the following examples, we 
will show how these tools respond to a reference scene that is under-exposed, over-exposed and then 
correctly exposed. Each scene will have its unique characteristics so the “correct exposure” is a matter 
of judgment, balancing the desire to avoid clipping any highlights and also avoiding underexpose of 
elements in deep shadow – which may therefore be prone to noise when developed in post production.  

The following reference scene includes highlight and shadow elements and was shot at ISO 800. 

UNDEREXPOSURE (~ 2 STOPS) 

 

ISO 800 - Monitor Output 

In the image above it is obvious the camera is under exposed. The initial clues are the monitor is very 
dark, and the histogram is justified to the left. Also note that red bar at the left edge of the histogram and 
the vertical color stack to the right of the histogram is only at grey. These indicators are saying a 
significant amount of the senor’s RAW data is “in the noise” and that the peak level of the sensor’s RAW 
data is at a very low level – in fact less than halfway. 
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ISO 800 - False Color: Exposure 

Select False Color – Exposure: note the √ E icon in the GUI when active. This mode allows us to 
visualize where in the image underexposure is taking place. These areas are indicated in purple. It is 
clear those areas are under the matchbox and coin, and between the bottle and cigar holder.  

 

ISO 800 - False Color: Video 
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Select False Color – Video: note the √ V icon in the GUI when active. This mode allows us to check the 
RGB video levels of the scene. As the peak white chips on the test chart are showing up in green and 
the underexpose areas are showing up in dark blue, this says the monitor path video levels are only 
ranging between 44 IRE and 1 IRE.  

Because the scene is under exposed, when the recorded .R3D file is color corrected in post-production, 
the scene’s highlight information will certainly not be clipped, however the shadow information will 
probably display with significant noise once pushed to an acceptable brightness. 

OVEREXPOSURE (~ 2 STOPS) 

 

ISO 800 - Monitor Output 

In the image above it is obvious the camera is over exposed. The monitor is very bright and the 
histogram is justified to the right. Note the red bar at the right edge of the histogram and the vertical 
color stack to the right of the histogram is showing red plus the three traffic lights to the right of that are 
all illuminated. These indicators are suggesting that a signification portion of the sensor’s RAW data is 
“at clip”, and this clipping is occurring on Red, Green and Blue channels. 
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ISO 800 - False Color: Exposure 

Select False Color – Exposure: note the √ E icon in the GUI when active. This mode allows us to 
visualize where in the image over exposure is taking place. These areas are indicated in red. It is clear 
those areas are on the highlight on coin, and at the top right edge of the color chip test chart. 

  



  
 

955-0003_v3.2, Rev- A1 COPYRIGHT © 2012 RED Digital Cinema 
215 

 

ISO 800 - False Color: Video 

Select False Color – Video: note the √ V icon in the GUI when active. This mode allows us to check the 
RGB video levels of the scene. As all the white chips on the test chart are Yellow, this suggests that a 
significant portion of the monitor path video is at the maximum legal 100 IRE value. 

Because the scene is over exposed, when the recorded .R3D file is color corrected in post-production, 
the scene’s highlight information will almost certainly be clipped, however the shadow information will 
probably display cleanly once pulled back down to an acceptable brightness. 
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APPROPRIATE EXPOSURE 

 

ISO 800 - Monitor Output 

In this image, the camera is appropriately exposed for this scene. The monitor is neither very dark nor 
very bright and the histogram is spread evenly given that there are bright highlights on the coin we wish 
not to blow out. Note that there is no red bar on either the left or the right edges of the histogram and 
the vertical color stack to the right of the histogram is at yellow. These indicators suggest that there is no 
significant amount of the sensor’s RAW data “in the noise” or “at clip”, and that the peak level of the 
sensor’s RAW data is about 2/3 stop below clipping. 
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ISO 800 - False Color: Exposure 

Select False Color – Exposure: note the √ E icon in the GUI when active. This mode allows us to 
visualize where there is under exposure (purple) or over exposure (red) in the image. In this case, there is 
a very small area of purple under the cracker box, and just a suggestion of red on the highlight on the 
coin, which suggested that the sensor is appropriately exposed for this scene.  
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ISO 800 - False Color: Video 

Select False Color – Video: note the √ V icon in the GUI when active. This mode allows us to check the 
RGB video levels of the scene. The two green squares in the upper right corner of the color chart and 
green in the background indicate that the scene’s mid grey and skin tone elements, plus peak white and 
blacks are all at appropriate levels.  

Because the scene was well exposed, when the recorded clip is color corrected in post-production, 
sufficient headroom exists for the scene’s highlight information to be displayed without clipping, and the 
shadow information can be displayed without significant noise, even if the brightness of the shadow 
information is pulled up.  
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ADJUSTING THE ISO RATING 

In the following two examples, the image exposed at ISO 800 rating have had the ISO rating adjusted 
first to ISO 6400 and then to ISO 100.  

NOTE: Although the image and Histogram both adjust to changes in the ISO rating, the sensor 
RAW meters do not change – they always indicate what is happening at the sensor level and 
hence where the image is truly in noise or at clipping.  

 

ISO 6400 - No Exposure Adjustment 
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ISO 100 - No Exposure Adjustment  

In these extreme examples, it is clear that the RGB domain images are respectively very bright and very 
dark. The histogram data reflects that, however you can also see that the sensor RAW meters are 
unchanged. The exposure at the sensor at this point in time is the same. If you choose to close the iris to 
reduce the brightness of the first image you will be reducing exposure at the sensor – this biases 
exposure in favor of protecting the scene highlight. Alternatively, if you choose to open the iris to 
increase the brightness of the image of the second image you will be increasing exposure at the sensor 
–  this biases exposure in favor of minimizing noise in the scene shadows. 

The technique is similar in principle to re-rating a film stock. With practice, the ISO rating can be used as 
a tool to assist ideal exposure based on the dynamic range identified within the scene.  
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APPENDIX H: POST PRODUCTION  

RED workflow is quite easy to understand, especially if you have experience with photographic RAW 
image processing, or shoot 16mm or 35mm film followed by a telecine transfer to video for non-linear 
video editing and on-line conform. 

The RAW data captured by RED cameras has wide dynamic range and color space, so you can freely 
change the white balance, adjust exposure and alter highlight and shadow tonality in post-production.  

The RED DSMC camera records RAW sensor data using wavelet based REDCODE RAW compression 
to REDMAG 1.8” SSD. The compressed RAW data is then transferred from the digital media to a 
Macintosh OSX or Windows XP workstation running REDCINE-X PRO postproduction software. These 
applications do not directly edit or conform the RAW data themselves, but prepare the RAW data for 
editing and conforming by RGB domain post-production software applications. 

In film processing terms, REDCINE-X PRO act as an integrated film laboratory, telecine, and one light 
color corrector. It converts recorded REDCODE RAW data to RGB video, and provides basic one light 
image processing and color correction. Using REDCINE-X PRO, footage can also be cropped, resized, 
or repositioned.  

REDCINE-X PRO can also encode 4K or 2K RAW footage into a variety of uncompressed RGB and 
compressed 4:2:2 video formats. For film out, multi-media or special effects applications, REDCINE-X 
PRO may export a sequence of 2K or 4K image files in TIFF, Open EXR, DPX, JPEG, or Photoshop PSD 
file formats.  

Provided the appropriate QuickTime codecs are available on the host computer workstation, 
compressed video choices include ProRes, DNxHD, DV100 and M-JPEG QuickTime movies at 1080p or 
720p resolution, providing compatibility with the majority of non-linear editing systems.  

Depending on the QuickTime movie resolution, material may be taken directly to a broadcast delivery 
videotape format, or after the editorial decisions have been made, video can be conformed at full image 
resolution by replacing the lower resolution edit proxy with a high resolution 4K, 2K or 1080p image file. 

MONITORING 

When using RED Digital Cinema  software tools it is recommended your monitor should be set to Adobe 
1998, or to SMPTE-C display profile. If you use the HD Cinema display profile, adjust the gamma to 2.2.  
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REDCINE-X® PRO 

REDCINE-X PRO is available for Intel based Mac OSX and Windows XP platforms. The application 
performing white balance and one light color correction, image pan/scan, crop and scaling operations. 

 The application can export either a single clip, or a sequence of clips, as 4K or 2K resolution 10-bit DPX 
or 16-bit TIFF files. REDCINE-X PRO can also render clips into standalone QuickTime movies using a 
variety of  video codecs including H.264, Apple ProRes and Avid DNxHD 

 

REDCINE-X PRO is available for download at http://www.RED.com/support. The REDCINE-X PRO 
Operation Guide Is included with the download package. 

  

http://www.red.com/support�
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APPENDIX I: MAINTENANCE  

WARNING: DO NOT attempt to modify, dismantle or open your camera, lens or other accessory 
as doing so may expose you to electric shock and serious injury. There are no user-serviceable 
parts inside. Alteration or repairs made to the camera, lens or other accessory, except by a RED 
authorized service facility, will void the Limited Warranty. 

CLEANING 

All RED products are designed for rugged durability, but precision instruments demand proper care.  
Please note the following care guidelines: 

WARNING: DO NOT rinse or immerse any element of the camera, lens or other accessory, keep 
them dry at all times. 

WARNING: DO NOT use soaps, detergents, ammonia, acetone, alkaline cleaners, abrasive 
cleaning compounds, or solvents. These substances may damage lens coatings and electronic 
circuitry. 

CAMERA AND ACCESSORY EXTERIOR SURFACES 

Clean ONLY using a dry cloth. When cleaning your camera and accessories, remember that it is not 
waterproof and moisture can damage electronic circuitry. 

BRAIN 

OPTICAL LOW-PASS FILTER (OLPF) 

If equipped with an OLPF, use Delkin Devices Digital Duster Kit (P/N DDSS-DUSTER2) or equivalent to 
clean OLPF surface. 

LCD SCREEN (TOUCHSCREEN / NON-TOUCHSCREEN) 

The specialized AR and AS coatings on RED TOUCH LCD displays must be treated with special care to 
avoid scratching. To help maintain the specialized AR and AS coatings on RED TOUCH LCD displays, 
the RED TOUCH LCD comes with a RED Microfiber bag for cleaning and storage. Using it will preserve 
the superior quality of these coatings. Hand wash and air-dry the RED Microfiber bag regularly. 

NOTE: RED’s warranty does not cover any LCD display against scratches or damage due to use 
of improper chemicals to clean the LCD. 

ONLY USE a RED Microfiber bag or equivalent Photographic Solutions PEC*PADs (P/N 05011) and 
Isopropyl Alcohol (>95%) or equivalent Pancro Professional Lens Cleaner (P/N PANCROCLN) to clean 
the screen on Touchscreen and Non-Touchscreen LCDs. 
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DO NOT USE any other solvents, chemicals or third party cleaning kits because they have not been 
tested on RED TOUCH LCD displays and can possibly damage them. Not approved for use on RED 
TOUCH LCD displays: 

• Rubbing Alcohol 

• Isopropyl Alcohol (<90%) 

• Windex 

• Pre-packaged lens cleaner containing any additives, such as detergent, anti-static, fragrance, etc. 

For proper cleaning and storage, remember to protect the RED TOUCH LCD by storing it in the RED 
Microfiber bag. 

EVF 

Use Pancro Professional Lens Cleaner (P/N PANCROCLN) and Photographic Solutions PEC*PADs (P/N 
05011) or equivalent to clean the viewfinder lens. Ensure your spray the solution onto the pad and not 
directly onto the lens surface. 

REDMOTE SCREEN 

Use Pancro Professional Lens Cleaner (P/N PANCROCLN) and Photographic Solutions PEC*PADs (P/N 
05011) or equivalent to clean the screen on Touchscreen and Non-Touchscreen LCDs. 

LENSES 

Use Pancro Professional Lens Cleaner (P/N PANCROCLN) and Photographic Solutions PEC*PADs (P/N 
05011) or equivalent to clean the viewfinder lens. Ensure your spray the solution onto the pad and not 
directly onto the lens surface. 

SIDE HANDLE LCD 

Use Pancro Professional Lens Cleaner (P/N PANCROCLN) and Photographic Solutions PEC*PADs (P/N 
05011) or equivalent to clean the screen on the Side Handle LCD. 
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BACK FOCUS ADJUSTMENT 

WARNING: THERE IS A SCREW-IN METAL PLUG INSTALLED IN THE CAMERA BODY COVERING 
THE BACK FOCUS SCREW. THIS PLUG MUST BE REMOVED

 

Back Focus Adjustment Location 

 BEFORE TO PERFORMING A BACK 
FOCUS ADJUSTMENT. TO REMOVE THE PLUG, USE A T-10 TORX SCREWDRIVER. 

NOTE: To be able to perform this procedure as written, you must have a PL mount and RED 
Focus™. 

Back focus is adjusted by turning the back focus adjustment on the top of the camera’s front plate using 
a T-10 Torx screwdriver. This screw is indicated by a Siemens Star with an arrow pointing to its location. 

1. Remove the screw-in plug located in the back focus adjustment opening using a T-10 Torx 
screwdriver. 

2. Place the camera on a level, stable surface or mount the camera on a tripod. 

3. Install RED Focus to the camera PL mount. 

a. Remove the camera lens or sensor cover if equipped. 

b. Install RED Focus onto the camera in the position shown. 

c. Ensure RED Focus is secured to the camera with the camera lock ring. 

 



  

COPYRIGHT © 2012 RED Digital Cinema 955-0003_v3.2, Rev-A1 
226 

RED Focus Properly Installed on Camera 

4. Power up the camera. 

5. Power up RED Focus. Refer to POWER UP / DOWN. 

NOTE: Remember that RED Focus will AUTOMATICALLY power down after 3 minutes. Press 
the Red button on the front to power back up. 

6. Set the camera to Magnify. Go to SECONDARY MENUS > SETTINGS > DISPLAY > FALSE COLOR 
> MAGNIFY. 

NOTE: The “Focus” option located under SECONDARY MENUS > SETTINGS > DISPLAY > 
FALSE COLOR > FOCUS can serve as a good double-check for proper focus during this 
procedure. 

 

RED Focus Displayed Image on Camera  

7. Insert a T-10 Torx® screwdriver into the back focus adjustment screw. The screw is oriented at 
approximately 80° as shown. 

 

Performing Back Focus Adjustment  

8. Carefully and slowly, rotate the back focus adjustment screw to achieve optimum focus. 

- Turning CLOCKWISE moves the sensor forward. 
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- Turning COUNTER-CLOCKWISE moves the sensor rearward.  

NOTE: The center of the image will never be in perfect focus as the lines are less than 1/3 of a 
pixel in size. 

9. The back focus adjustment mechanism is self-locking, and does not require a supplementary locking 
screw. 

10. Install the screw-in plug in the back focus adjustment opening using a T-10 Torx screwdriver. 

11. This completes the  back focus adjustment. 
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APPENDIX J: TROUBLESHOOTING 

NO MEDIA ATTACHED 

Displayed if media is not present or not formatted when pressing the record button. Connect media to 
camera if necessary. If media is already connected, format media and attempt to record again. Refer to 
APPENDIX B: MANAGING DIGITAL MEDIA for detailed information. 

 

RECORDING HALTED: RECORD ERROR - SHUTDOWN 

Displayed if media removed while recording. DO NOT remove media while camera is recording. Power 
down the camera, verify the media is inserted properly (inspect connectors for damage), power up and 
resume recording. 

 

PRESET COULD NOT BE APPLIED 

If the preset could not be applied, “Preset Could Not Be Applied” will appear to inform you. Power down 
camera, power back up and attempt to apply the preset that failed. 

 

CAMERA CANNOT BE PAIRED TO REDMOTE 

• Ensure REDMOTE display indicates IDLE before attempting to pair the camera to the REDMOTE. 

• Ensure the REDMOTE is detached from the rear of the camera body and powered on. 

• Ensure the REDMOTE wireless in turned on. 

• Ensure camera does not display REDLINK Upgrade Required. 

CANNOT SEE MENUS ON LCD TOUCH SCREEN 

Double tap the LCD screen to exit clean mode. 
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APPENDIX K: TECHNICAL SPECIFICATIONS 

SENSOR 14 MEGAPIXEL MYSTERIUM-X™ 

PIXEL ARRAY 5120 (h) x 2700 (v) 

DYNAMIC RANGE 
13.5 stops, up to 18 stops with HDRx™ 6 fps with 5K FF and HDRx On 12 fps with 4K HD and 

HDRx™ On 

MAX IMAGE AREA 5120 (h) x 2700 (v) 

LENS COVERAGE 27.7mm (h) x 14.6mm (v) = 31.4 mm (d) 

LENS MOUNT Al Canon EF (PL mount optional) 

MAX DEPTH OF FIELD Equivalent to S35mm (Motion) / APS-H (Still) lenses 

ACQUISITION 
FORMATS 5K FF REDCODE RAW (Full Frame) 

  4K HD REDCODE RAW 

  3K HD REDCODE RAW 

  1080p REDCODE RAW 

  1K REDCODE RAW 

PROJECT FRAME 
RATES 23.98, 24, 25, 29.97, 47.96, 48, 50, 59.97 

MONITOR/PROGRAM 
OUTPUT 

HD-SDI and HDMI with Frame Guides and Look Around or Clean Feed 1080p 4:2:2, 720p 4:2:2 
SMPTE Timecode, HANC Metadata, 24-bit 48Khz Audio 

DIGITAL MEDIA REDMAG (SSD) Module : (64, 128, 256GB Media) 

REDCODE™ 16-bit RAW Processing : Compression choices of 18:1 to 3:1 

  1-12 fps 5K FF 

  1-30 fps 4K HD 

  1-48 fps 3K HD 

  1-60 fps 1080p HD 

  1-120 fps 1K 

AUDIO 2 channel, uncompressed, 24 bit, 48KHz. 

  Optional 4 channel, and AES / EBU digital audio. 

MONITORING 
OPTIONS RED LCD 5" Touchscreen Display 

  BOMB EVF™ High Definition Viewfinder 

REMOTE CONTROL REDLINK Wireless, Ethernet, RS232, GPI Trigger 

WEIGHT 5lbs. Body only 

CONSTRUCTION Aluminum Alloy 

COLOR Battleship Gray Brain Body, Black Canon Mount and Side SSD, All DSMC Modules Black 

TEMPERATURE 
RANGES Operating Range: 0 ˚C to +40˚C (32˚F to 104˚F) 

  Storage Range: -20˚C to +50˚C (-4˚F to 122˚F) 
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CAMERA BRAIN DIMENSIONS 

Dimensions shown in mm 

 

 

Front View 
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Side View 
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Top View 

 

Bottom View 
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Rear View 
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APPENDIX L: RESOLUTION CHART 
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APPENDIX M: MENU MAPS 



M
E
N
U
 
M

A
P

R
E
D
 
S
C
A
R
L
E
T

T
M

TI
TL

E
:

3
.2

R
E

V

A

V
E

R
S

IO
N

:
©

2
0
1
2
 R

E
D

.C
O

M
, 
IN

C
.

S
C
A
R
L
E
T
-X

S
H

E
E

T
 1

 O
F

 4

D
E

L
E

T
E

S
 D

IS
P

L
A

Y
E

D

P
R

E
S

E
T

 F
R

O
M

 C
A

M
E

R
A

IS
O

 (
S

E
N

S
IT

IV
IT

Y
)

/F
 (

F
-S

T
O

P
)*

B
A

S
IC

1
/S

E
C

 (
E

X
P

O
S

U
R

E
)

R
E

D
C

O
D

E
 (

Q
U

A
L

IT
Y

)

B
A

S
IC

F
P

S
 (

V
A

R
IS

P
E

E
D

)

2
4

 F
P

S

E
X

P
O

S
U

R
E

1
/2

4
 t

o
 1

/7
5
3
0
1
 S

E
C

1/
48

 S
E

C

IN
T
. 
T

IM
E

0
.1

0
0
 t

o
 4

1
.7

0
8
 M

S

20
.8

33
 M

S

A
B

S
. 
A

N
G

L
E

1
.0

0
0
 t

o
 3

6
0
.0

0
0
 D

E
G

18
0.

00
0 

D
E

G

1
.0

0
0
 t

o
 3

0
 F

P
S

M
A
I
N

M
E
N
U

P
R

E
S

E
T

S

D
ay

lig
ht

C
O

L
O

R
 T

E
M

P

56
00

K

T
IN

T

-1
0
0
.0

0
0
 t

o
 +

1
0
0
.0

0
0

0

C
A

L
C

 W
B

C
A

L
C

U
L

A
T

E
S

W
H

IT
E

 B
A

L
A

N
C

E

S
T

O
P

S

1
 t

o
 6

2

Z
O

N
E

S

C
E

N
T

E
R

S
P

O
T

C
en

te
r

D
E

F
A

U
L
T

 V
A

L
U

E
S

 A
R

E
 D

IS
P

L
A

Y
E

D
 I

N
 B

O
X

E
S

F
L

O
W

C
H

A
R

T
 C

O
N

C
E

P
T

 X
L

 F
IL

M
S

 L
T

D
.

A
P

P
L
Y

 P
R

E
S

E
T

S

A
P

P
L

IE
S

 P
R

E
S

E
T

W
H

IT
E

 B
A

L
A

N
C

E
R

E
S

O
L

U
T

IO
N

A
D

V
A

N
C

E
D

A
D

V
A

N
C

E
D

A
D

V
A

N
C

E
D

2
4

 F
P

S

M
A

N
U

A
L

L
Y

E
N

T
E

R
 V

A
L

U
E

1
.0

0
0
 t

o
 3

0
 F

P
S

IS
 8

0
0

2
5
0
 t

o
 1

2
8
0
0
 I

S
O

V
ar

ie
s

W
IL

L
 V

A
R

Y
 B

Y

A
T

T
A

C
H

E
D

 L
E

N
S

1
/4

8
 S

E
C

1
/2

4
 t

o
 1

/8
0
0
0
 S

E
C

5
6

0
0

K

1
,7

0
0
 t

o
 1

0
,0

0
0
 K

B
A

S
IC

4
K

 H
D

8
:1

3
:1

 t
o

 1
8
:1

S
E
C
O
N
D
A
R
Y
 
M

E
N
U
S

P
R
E
S
S
 
M

E
N
U
 
I
C
O
N
 
 
 
(
L
C
D
)
 
O
R
 
M

E
N
U
 
B
U
T
T
O
N
 
T
O
 
A
C
C
E
S
S

F
O

C
U

S
E

X
P

O
S

U
R

E
P

R
E

S
E

T
S

P
O

W
E

R
H

D
R

M
E

D
IA

S
E

T
T

T
IN

G
S

S
H

U
T

D
O

W
N

P
O

W
E

R
S

 D
O

W
N

 C
A

M
E

R
A

D
is

p
la

y
s
 l
o

c
a

ti
o

n

(B
ra

in
, 
S

id
e

 H
a

n
d

le
,

Q
u

a
d

 B
a

tt
e

ry

M
o

d
u

le
 1

-4
 e

tc
.)

a
n

d
 c

u
rr

e
n

t 
s
ta

tu
s

(V
o

lt
a

g
e

 /
 %

)

fo
r 

a
tt

a
c

h
e

d

p
o

w
e

r 
s
o

u
rc

e
s

(R
E

D
v
o

lt
, 
D

C
, 
e

tc
.)

O
F

F

H
D

R
x
 O

F
F

H
D

R
x

 H
D

R
x
 O

N

F
O

C
U

S
*

Va
rie

s

A
P

E
R

T
U

R
E

*

W
IL

L
 V

A
R

Y
 B

Y

A
T

T
A

C
H

E
D

 L
E

N
S

Va
rie

s

P
R

E
S

E
T

U
S

E
R

 D
E

F
IN

E
D

P
R

E
S

E
T

S

C
R

E
A

T
E

IM
P

O
R

T
/E

X
P

O
R

T
D

E
L

E
T

E

N
E

W
 P

R
E

S
E

T

Im
a

g
e

  
 P

ro
je

c
t 

  
O

u
tp

u
t

S
y
s
te

m
  
 K

e
y
s

S
E

L
E

C
T

 V
A

L
U

E
S

:

S
H

A
D

E

C
L

O
U

D
Y

D
A

Y
L

IG
H

T

D
IS

K
 P

R
E

S
E

T
S

S
E

L
E

C
T

 O
N

-C
A

M
E

R
A

 

P
R

E
S

E
T

 >
 E

X
P

O
R

T
 T

O
 

E
X

T
E

R
N

A
L

 M
E

D
IA

C
A

M
E

R
A

 P
R

E
S

E
T

S
R

M
D

 P
R

E
S

E
T

S
E

L
E

C
T

 E
X

T
E

R
N

A
L

M
E

D
IA

 P
R

E
S

E
T

>
 I

M
P

O
R

T
 T

O
 C

A
M

E
R

A

S
E

L
E

C
T

 R
M

D
 F

R
O

M

E
X

T
E

R
N

A
L

 M
E

D
IA

 A
N

D

S
E

L
E

C
T

 A
P

P
L
Y

<
IN

P
U

T
 P

R
E

S
E

T
 N

A
M

E
>

C
R

E
A

T
E

A
P

P
L
Y

A
P

P
L

IE
S

 P
R

E
S

E
T

T
O

 C
A

M
E

R
A

S
E

L
E

C
T

 M
E

D
IA

S
E

L
E

C
T

 D
E

S
IR

E
D

 M
E

D
IA

L
O

C
A

T
IO

N

S
-S

S
D

E
J
E

C
T

 

E
J
E

C
T

C
U

R
R

E
N

T
 M

E
D

IA

F
O

R
M

A
T

 

F
O

R
M

A
T

C
U

R
R

E
N

T
 M

E
D

IA

D
IS

P
L

A
Y

L
O

O
K

P
R

O
J
E

C
T

A
U

D
IO

/V
ID

E
O

S
E

T
U

P
M

A
IN

T
E

N
A

N
C

E

N
O

T
 I

M
P

L
E

M
E

N
T

E
D

 A
T

 T
H

IS
 T

IM
E

 

G
O

 T
O

 S
H

E
E

T
 3

 O
F

 4

G
O

 T
O

 S
H

E
E

T
 2

 O
F

 4

R
e

e
l 
N

o
/C

a
m

 I
D

/C
a

m
 P

o
s

M
A

N
U

A
L

L
Y

E
N

T
E

R
 V

A
L

U
E

1
,7

0
0
 t

o
 1

0
0
,0

0
0
 K

<
U

ns
p

ec
ifi

ed
>

F
L

A
S

H

F
L

O
U

R
E

S
C

E
N

T

T
U

N
G

S
T

E
N

IN
C

A
N

D
E

C
E

N
T

5
K

  
4
K

  
4
K

 H
D

  
 3

K
  
 2

K
 

G
O

 T
O

 S
H

E
E

T
 4

 O
F

 4

W
IL

L
 V

A
R

Y
 B

Y

A
T

T
A

C
H

E
D

 L
E

N
S

* 
V

is
ib

le
 O

N
L
Y

 w
it

h
  
R

E
D

 E
P

IC
 C

a
n

o
n

 E
O

S
 M

o
u

n
t

  
A

N
D

 C
a

n
o

n
 E

F
 /

 E
F

-S
 L

e
n

s

* 
V

is
ib

le
 O

N
L
Y

 w
it

h

  
R

E
D

 E
P

IC
 C

a
n

o
n

 E
O

S
 M

o
u

n
t

  
A

N
D

 C
a

n
o

n
 E

F
 /

 E
F

-S
 L

e
n

s

U
T

IL
IT

IE
S

M
E

D
IA

 U
T

IL
IT

IE
S

S
e

c
u

re
 F

o
rm

a
t

R
e

e
l 
N

o
/C

a
m

 I
D

/C
a

m
 P

o
s

P
L

A
Y

B
A

C
K

A
U

T
O

 F
O

C
U

S
*

M
an

ua
l

M
A

N
U

A
L

M
A

N
U

A
L

C
O

N
F

IR
M

 

M
an

ua
l

M
O

D
E

C
O

N
T

IN
U

O
U

S

T
O

U
C

H
 T

R
A

C
K

R
A

C
K

 

* 
V

is
ib

le
 O

N
L
Y

 w
it

h

  
R

E
D

 E
P

IC
 C

a
n

o
n

 E
O

S
 M

o
u

n
t

  
A

N
D

 C
a

n
o

n
 E

F
 /

 E
F

-S
 L

e
n

s

M
A

N
U

A
L

C
O

N
F

IR
M

S
IN

G
L

E



M
E
N
U
 
M

A
P

R
E
D
 
S
C
A
R
L
E
T

T
M

TI
TL

E
:

3
.2

R
E

V

A

V
E

R
S

IO
N

:
©

2
0
1
2
 R

E
D

.C
O

M
, 
IN

C
.

S
C
A
R
L
E
T
-X

S
H

E
E

T
 2

 O
F

4
  
  
 

L
O

O
K

U
S

E
R

D
E

F
A

U
L
T

 V
A

L
U

E
S

 A
R

E
 D

IS
P

L
A

Y
E

D
 I

N
 B

O
X

E
S

F
L

O
W

C
H

A
R

T
 C

O
N

C
E

P
T

 X
L

 F
IL

M
S

 L
T

D
.

F
O

C
U

S
E

X
P

O
S

U
R

E
P

R
E

S
E

T
S

P
O

W
E

R
H

D
R

M
E

D
IA

S
E

T
T

T
IN

G
S

D
IS

P
L

A
Y

P
R

O
J
E

C
T

A
U

D
IO

/V
ID

E
O

S
E

T
U

P
M

A
IN

T
E

N
A

N
C

E

G
O

 T
O

 S
H

E
E

T
 1

 O
F

 4

T
O

O
L

S
Z

E
B

R
A

O
V

E
R

L
A

Y
M

O
D

E
S

F
R

A
M

E
 G

U
ID

E
A

R
E

A
 G

U
ID

E
S

T
O

O
L

S
 O

F
F

E
X

P
O

S
U

R
E

F
O

C
U

S
V

ID
E

O
E

D
G

E

Z
E

B
R

A
 1

D
IS

A
B

L
E

D
 B

Y
 D

E
F
A

U
L
T

H
IG

H
 I

R
E

9
3
 T

O
 1

0
9

10
8

L
O

W
 I

R
E

7
5
 T

O
 1

0
7

99

T
IT

L
E

 G
U

ID
E

A
C

T
IO

N
 G

U
ID

E

C
O

L
O

R
G

A
IN

F
L

U
T

®
C

O
L

O
R

/G
A

M
M

A

1
.0

0
0

0
.0

0
 T

O
 4

.0

S
A

T
U

R
A

T
IO

N

0
.0

0
0

-1
.0

 T
O

 1
.0

C
O

N
T

R
A

S
T

0
.0

0
0

-1
0
.0

 T
O

 1
0
.0

B
R

IG
H

T
N

E
S

S

S
E
C
O
N
D
A
R
Y
 
M

E
N
U
S

P
R
E
S
S
 
M

E
N
U
 
I
C
O
N
 
 
 
(
L
C
D
)
 
O
R
 
M

E
N
U
 
B
U
T
T
O
N
 
T
O
 
A
C
C
E
S
S

G
O

 T
O

 S
H

E
E

T
 1

 O
F

 4

G
O

 T
O

 S
H

E
E

T
 3

 O
F

 4

M
O

N
IT

O
R

Z
E

B
R

A
 2

D
IS

A
B

L
E

D
 B

Y
 D

E
F
A

U
L
T

H
IG

H
 I

R
E

1
 T

O
 9

9

47

L
O

W
 I

R
E

0
 T

O
 8

4

44

S
H

O
W

:

F
il
e

 N
a

m
e

T
im

e
 C

o
d

e

A
F

 Z
o

n
e

s

G
ri

d

T
R

A
N

S
P

A
R

A
N

C
Y

 %
 /

 C
O

L
O

R
:

L
e

n
s
 I

n
fo

C
e

n
te

r

L
o

o
k

 A
ro

u
n

d
:

A
P

E
R

T
U

R
E

1
/4

 F
#
 /

 1
/3

 F
#

1/
3 

F#

F
O

C
A

L
 D

IS
T
A

N
C

E

M
E

T
R

IC
  
  
  
  

 I
M

P
E

R
IA

L

Im
p

er
ia

l

E
X

P
O

S
U

R
E

T
IM

E
 /

 A
N

G
L

E

Ti
m

e

S
H

U
T

T
E

R
 M

O
D

E

A
B

S
O

L
U

T
E

  
  
  
R

E
L

A
T

IV
E

A
b

so
lu

te

S
IZ

E

O
F

F

F
U

L
L

4
:3

Fu
ll

T
R

A
N

S
P

A
R

E
N

C
Y

0
 /

 2
5
 /

 5
0
 /

 7
5
 /

 1
0
0
%

50
%

2
.4

:1

U
S

E
R

1
6
:9

1
.8

5
:1

1
.9

:1

C
O

L
O

R

W
H

IT
E

G
R

A
Y

T
E

A
L

W
hi

te

B
L

U
E

R
E

D

B
L

A
C

K

P
U

R
P

L
E

Y
E

L
L

O
W

G
R

E
E

N

A
S

P
E

C
T

 R
A

T
IO

1
.0

0
 T

O
 1

0
.0

0

2.
40

1.
00

+
-

+
- :

1
.0

0
 T

O
 1

0
.0

0

S
C

A
L

E
 /

 O
F

F
S

E
T

S
 X

 /
 Y

X
 =

 0
.0

%
 T

O
 1

0
0
.0

%

10
0.

0%
 /

 0
.0

%
10

0.
0%

 /
 0

.0
%

+
-

+
-

Y
 =

 0
.0

%
 T

O
 1

0
0
.0

%

A
S

P
E

C
T

 R
A

T
IO

O
F

F

1
6
:9

1
4
:9

O
ff

T
R

A
N

S
P

A
R

E
N

C
Y

0
 /

 2
5
 /

 5
0
 /

 7
5
 /

 1
0
0
%

50
%

1
.8

5
:1

U
S

E
R

4
:3

2
.4

:1

C
O

L
O

R

W
H

IT
E

G
R

A
Y

T
E

A
L

W
hi

te

B
L

U
E

R
E

D

B
L

A
C

K

P
U

R
P

L
E

Y
E

L
L

O
W

G
R

E
E

N

A
S

P
E

C
T

 R
A

T
IO

O
ff

T
R

A
N

S
P

A
R

E
N

C
Y

0
 /

 2
5
 /

 5
0
 /

 7
5
 /

 1
0
0
%

50
%

C
O

L
O

R

W
H

IT
E

G
R

A
Y

T
E

A
L

W
hi

te

B
L

U
E

R
E

D

B
L

A
C

K

P
U

R
P

L
E

Y
E

L
L

O
W

G
R

E
E

N

O
F

F

1
6
:9

1
4
:9

1
.8

5
:1

U
S

E
R

4
:3

2
.4

:1

1
.0

0
0

0
.0

 T
O

 1
0
.0

R
E

D

1
.0

0
0

0
.0

 T
O

 1
0
.0

G
R

E
E

N

1
.0

0
0

0
.0

 T
O

 1
0
.0

B
L

U
E

0
.0

0
0

-8
.0

 T
O

 8
.0

F
L

U
T

0
.0

0
0

-7
.0

 T
O

 7
.0

E
X

P
O

S
U

R
E

0
.0

0
0

-2
.0

 T
O

 2
.0

S
H

A
D

O
W

R
E

D
G

am
m

a3

R
E

D
G

a
m

m
a
2

R
E

D
G

a
m

m
a
3

S
P

A
C

E
 /

 G
A

M
M

A

R
A

W

U
S

E
R

 S
C

A
L

E
 X

 /
 Y

X
 =

 0
.0

%
 T

O
 1

0
0
.0

%

80
.0

%
80

.0
%

+
-

+
-

Y
 =

 0
.0

%
 T

O
 1

0
0
.0

%

U
S

E
R

 S
C

A
L

E
 /

 O
F

F
S

E
T

S
 X

 /
 Y

X
 =

 0
.0

%
 T

O
 1

0
0
.0

%

10
0.

0%
 /

 0
.0

%
10

0.
0%

 /
 0

.0
%

+
-

+
-

Y
 =

 0
.0

%
 T

O
 1

0
0
.0

%

T
O

U
C

H
 G

E
S

T
U

R
E

S
:

P
in

c
h

 t
o

 M
a

g
n

if
y

D
o

u
b

le
-C

li
c

k
 R

ig
h

t 
2
5
%

 t
o

 R
e

c
o

rd

D
o

u
b

le
-C

li
c

k
 L

e
ft

 2
5
%

 t
o

 S
ta

rt
 A

F

L
C

D
/E

V
F

 B
R

IG
H

T
N

E
S

S

O
F

F

G
O

 T
O

 S
H

E
E

T
 4

 O
F

 4

M
A

G
N

IF
Y

T
O

G
G

L
E

 M
A

G
N

IF
Y

 1
:1

L
IN

E
 S

T
Y

L
E

S
O

L
ID

/D
A

S
H

E
D

/B
R

A
C

K
E

T

B
ra

ck
et

E
n

a
b

le
 U

s
e

r 
C

u
rv

e

B
L

A
C

K
/T

O
E

/C
E

N
T

E
R

/K
N

E
E

/W
H

IT
E

 X
 /

 Y

X
 =

 0
.0

0
 T

O
 1

.0
0

0.
00

/0
.2

5/
0.

50
/0

.7
5/

1.
00

+
-

+
-

Y
 =

 0
.0

0
 T

O
 1

.0
0

0.
00

/0
.2

5/
0.

50
/0

.7
5/

1.
00

E
N

A
B

L
E

 U
S

E
R

C
U

R
V

E

D
im

e
n

s
io

n
s
:

L
IN

E
 S

T
Y

L
E

S
O

L
ID

/D
A

S
H

E
D

/B
R

A
C

K
E

T

B
ra

ck
et

P
L

A
Y

B
A

C
K

R
E

D
L

o
g

F
il
m



M
E
N
U
 
M

A
P

R
E
D
 
S
C
A
R
L
E
T

T
M

TI
TL

E
:

3
.2

R
E

V

A

V
E

R
S

IO
N

:
©

2
0
1
2
 R

E
D

.C
O

M
, 
IN

C
.

S
C
A
R
L
E
T
-X

S
H

E
E

T
 3

 O
F

4

D
E

F
A

U
L
T

 V
A

L
U

E
S

 A
R

E
 D

IS
P

L
A

Y
E

D
 I

N
 B

O
X

E
S

F
L

O
W

C
H

A
R

T
 C

O
N

C
E

P
T

 X
L

 F
IL

M
S

 L
T

D
.

F
O

C
U

S
E

X
P

O
S

U
R

E
P

R
E

S
E

T
S

P
O

W
E

R
H

D
R

M
E

D
IA

S
E

T
T

T
IN

G
S

D
IS

P
L

A
Y

L
O

O
K

P
R

O
J
E

C
T

A
U

D
IO

/V
ID

E
O

M
A

IN
T

E
N

A
N

C
E

G
O

 T
O

 S
H

E
E

T
 1

 O
F

 4

G
O

 T
O

 S
H

E
E

T
 2

 O
F

 4

U
S

E
 R

T
C

 T
IM

E
S

E
T

 M
A

N
U

A
L

L
Y

A
U

D
IO

 I
N

P
U

T
A

U
D

IO
 O

U
T

P
U

T
M

O
N

IT
O

R
 C

N
T

L
T

E
S

T
 S

IG
N

A
L

S

S
M

P
T

E
 B

A
R

S

L
C

D
 /

 E
V

F

C
A

M
 L

/R
 P

R
O

 I
/O

 L
/R

O
N

 /
 M

U
T

E
 -

1
 t

o
 -

6
3

O
N

 /
 -

9 
d

B

In
c

lu
d

e
s
 O

u
tp

u
t

V
o

lu
m

e
 A

d
ju

s
tm

e
n

t

C
H

IP
 C

H
A

R
T

D
IS

P
L

A
Y

S

T
E

S
T

 S
IG

N
A

L

D
IS

P
L

A
Y

S

T
E

S
T

 S
IG

N
A

L

F
P

S

2
3
.9

8

2
4
.0

0

2
5
.0

0

2
9
.9

7

23
.9

8

T
IM

E
 C

O
D

E
 S

R
C

.

E
X

T
E

R
N

A
L

U
S

E
R

-P
R

O
V

ID
E

D

E
xt

er
na

l

T
IM

E
 B

A
S

E
T

IM
E

 C
O

D
E

0
 T

O
 2

3

0
-

+

M
IN

U
T

E
S

0
 T

O
 5

9

0
-

+

S
E

C
O

N
D

S

0
 T

O
 5

9

0
-

+

H
O

U
R

S

U
S

E
R

 P
R

O
V

ID
E

D

S
E
C
O
N
D
A
R
Y
 
M

E
N
U
S

P
R
E
S
S
 
M

E
N
U
 
I
C
O
N
 
 
 
(
L
C
D
)
 
O
R
 
M

E
N
U
 
B
U
T
T
O
N
 
T
O
 
A
C
C
E
S
S

G
O

 T
O

 S
H

E
E

T
 1

 O
F

 4

4
7
.9

6

4
8
.0

0

5
0
.0

0

5
9
.9

4

S
E

T
U

P

G
O

 T
O

 S
H

E
E

T
 4

 O
F

 4

T
IM

E
 C

O
D

E
 D

IS
P
.

T
O

D
  
  
  
  
  
  
  
  

  
  
  
  
  
E

D
G

E

TO
D

A
U

D
IO

 C
H

A
N

.

IN
P

U
T

 C
H

 1
/2

L
IN

K
  
  
  
  
  
  
 L

IM
IT

E
R

C
A

M
 A

N
A

L
O

G

A
U

D
IO

 R
E

C
O

R
D

 E
N

A
B

L
E

  
8
 t

o
 6

3
 d

B

10
d

B

In
c

lu
d

e
s
 I

n
p

u
t

V
o

lu
m

e
 A

d
ju

s
tm

e
n

t

IN
P

U
T

 C
H

 3
/4

O
U

T
P

U
T

L
IN

K

P
R

O
 I

/O

L
IN

K

S
O

U
R

C
E

C
A

M
 A

N
A

  
  
  
P

R
O

 I
/O

 A
N

A

P
R

O
 I

/O
 A

E
S

 A

P
R

O
 I

/O
 A

E
S

 B

C
am

 A
na

lo
g

M
O

D
E

U
N

B
A

L
A

N
C

E
D

B
A

L
A

N
C

E
D

U
nb

al
an

ce
d

L
IN

K
  
  
  
  
  
  
 L

IM
IT

E
R

S
O

U
R

C
E

N
O

N
E

  
  
  
P

R
O

 I
/O

 A
N

A
L

O
G

P
R

O
 I

/O
 A

E
S

 A

P
R

O
 I

/O
 A

E
S

 B

N
on

e

M
O

D
E

N
O

N
E

N
on

e C
A

M

H
D

M
I*

H
D

-S
D

I*

1
0

8
0

p

A
U

T
O

  
  
  
  
7
2
0
p

  
  
  
  
1
0
8
0
p

R
E

S
O

L
U

T
IO

N

M
en

u
s

O
F

F
  
  
  
  
  
  
  
  
  
  
  
  
 M

E
N

U
S

P
R

E
V

IE
W

  
  
  
  
  
  
  
  
C

L
E

A
N

O
V

E
R

L
A

Y
  
  
  
  
  
  
 3

D
 L

E
F

T

3
D

 R
IG

H
TM

O
D

E

A
u

to

A
U

T
O

  
  
  
  
  
  
  
2
3
.9

7
6
/2

4
H

z

2
5
H

z
  
  
  
  
  
  
  
  
  
  
 2

9
.9

7
6
H

z

4
7
.9

5
2
/4

8
H

z
  
  
  
  
  
  
  
  
5
0
H

z

5
9
.9

4
H

z

F
R

E
Q

U
E

N
C

Y

O
ff

O
F

F
  
  
  
  
  
  
  
  
  
  
  
  
M

E
N

U
S

P
R

E
V

IE
W

  
  
  
  
  
  
  
 C

L
E

A
N

O
V

E
R

L
A

Y
  
  
  
  
  
  
 3

D
 L

E
F

T

3
D

 R
IG

H
T

 

M
O

D
E

1
0

8
0

p

A
U

T
O

  
  
  
  
 7

2
0
p

  
  
  
1
0
8
0
p

R
E

S
O

L
U

T
IO

N

M
en

u
s

M
E

N
U

S
  
  
  
  
  
  
  
P

R
E

V
IE

W

C
L

E
A

N
  
  
  
  
  
  
  
 O

V
E

R
L

A
Y

3
D

 L
E

F
T

  
  
  
  
  
  
 3

D
 R

IG
H

T

M
O

D
E

A
U

T
O

M
A

T
IC

A
L

L
Y

 A
S

S
IG

N

M
E

N
U

 S
C

R
E

E
N

 I
F

 E
N

A
B

L
E

D

* 
H

D
M

I 
a
n

d
 H

D
-S

D
I 
c
a
n

n
o

t 
b

e

e
n

a
b

le
d

a
t 

th
e
 s

a
m

e
 t

im
e
.

C
a
m

e
ra

 M
U

S
T

 b
e
 r

e
s
ta

rt
e
d

fo
r 

c
h

a
n

g
e
s
 t

o
 t

a
k
e
 e

ff
e
c
t.

T
o

 E
X

IT
:

- 
T
a
p

 T
o

u
c
h

s
c
re

e
n

- 
P

re
s
s
 E

N
T

E
R

- 
P

re
s
s
 M

E
N

U
 B

u
tt

o
n

P
L

A
Y

B
A

C
K

S
L

A
T

E

S
E

T
 C

U
R

R
E

N
T

M
E

D
IA

 P
R

O
P

E
R

T
IE

S

  
  
  
 C

a
m

 I
D

/C
a

m
 P

o
s



M
E
N
U
 
M

A
P

R
E
D
 
S
C
A
R
L
E
T

T
M

TI
TL

E
:

3
.2

R
E

V

A

V
E

R
S

IO
N

:
©

2
0
1
2
 R

E
D

.C
O

M
, 
IN

C
.

S
C
A
R
L
E
T
-X

S
H

E
E

T
 4

 O
F

4

F
O

C
U

S
E

X
P

O
S

U
R

E
P

R
E

S
E

T
S

P
O

W
E

R
H

D
R

D
IS

P
L

A
Y

L
O

O
K

S
E

N
S

O
R

P
R

O
J

E
C

T
M

O
D

E
S

A
U

D
IO

/V
ID

E
O

S
E

T
U

P
M

A
IN

T
E

N
A

N
C

E

G
O

 T
O

 S
H

E
E

T
 1

 O
F

 4

G
O

 T
O

 S
H

E
E

T
 2

 O
F

 4

E
N

A
B

L
E

  
/ 

D
IS

A
B

L
E

S
E

N
S

O
R

 T
E

S
T

 P
A

T
T

E
R

N

S
E

N
S

O
R

 T
E

S
T

 P
A

T
T

E
R

N

S
E
C
O
N
D
A
R
Y
 
M

E
N
U
S

P
R
E
S
S
 
M

E
N
U
 
I
C
O
N
 
 
 
(
L
C
D
)
 
O
R
 
M

E
N
U
 
B
U
T
T
O
N
 
T
O
 
A
C
C
E
S
S

G
O

 T
O

 S
H

E
E

T
 1

 O
F

 4

D
IS

P
L

A
Y

S

S
Y

S
T

E
M

 C
O

N
F

IG
U

R
A

T
IO

N

S
C

R
E

E
N

G
O

 T
O

 S
H

E
E

T
 3

 O
F

 4

S
Y

S
 S

T
A

T
U

S
S

Y
S

 I
N

F
O

S
A

V
E

 L
O

G
S

W
 U

P
D

A
T

E
C

A
L

IB
R

A
T

IO
N

S
E

L
F

 T
E

S
T

R
E

S
T

O
R

E
 S

Y
S

D
IS

P
L

A
Y

S

C
A

M
E

R
A

 P
IN

 &
 

S
O

F
T

W
A

R
E

 V
E

R
S

IO
N

S
A

V
E

S
 S

Y
S

T
E

M
 L

O
G

 F
IL

E

T
O

 E
X

T
E

R
N

A
L

 M
E

D
IA

C
H

E
C

K
S

E
X

T
E

R
N

A
L

 M
E

D
IA

F
O

R
 S

O
F

T
W

A
R

E
 U

P
D

A
T

E

P
R

O
M

P
T

S
 F

O
R

 I
N

S
T
A

L
L

P
R

O
M

P
T

S
 T

O
 P

E
R

F
O

R
M

 B
L

A
C

K
 S

H
A

D
IN

G
 C

A
L

IB
R

A
T

IO
N

P
R

O
M

P
T

S
 T

O
 P

E
R

F
O

R
M

 B
L

A
C

K
 S

H
A

D
IN

G
 C

A
L

IB
R

A
T

IO
N

E
N

A
B

L
E

S
 T

O
U

C
H

S
C

R
E

E
N

 T
E

S
T

T
O

 E
X

IT
, 
T
A

P
 A

N
D

 H
O

L
D

 O
R

P
R

E
S

S
 E

N
T

E
R

 B
U

T
T

O
N

T
O

U
C

H
S

C
R

E
E

N

P
R

O
M

P
T

S
 T

O
 R

E
S

T
O

R
E

T
O

 F
A

C
T

O
R

Y
 S

E
T

T
IN

G
S

R
E

Q
U

IR
E

S
 R

E
B

O
O

T

O
F

 C
A

M
E

R
A

M
E

D
IA

S
E

T
T

T
IN

G
S

D
E

F
A

U
L
T

 V
A

L
U

E
S

 A
R

E
 D

IS
P

L
A

Y
E

D
 I

N
 B

O
X

E
S

F
L

O
W

C
H

A
R

T
 C

O
N

C
E

P
T

 X
L

 F
IL

M
S

 L
T

D
.

R
E

D
IS

C
O

V
E

R

R
E

D
IS

C
O

V
E

R
S

 A
L

L

H
A

R
D

W
A

R
E

R
E

Q
U

IR
E

S
 R

E
B

O
O

T

O
F

 C
A

M
E

R
A

B
L

A
C

K
 S

H
A

D
IN

G
 (

C
U

R
R

E
N

T
 F

P
S

/E
X

P
O

S
U

R
E

)
B

L
A

C
K

 S
H

A
D

IN
G

 (
D

E
F
A

U
L
T

)

P
L

A
Y

B
A

C
K

A
L

L
O

W
S

 P
L

A
Y

B
A

C
K

 O
F

C
L

IP
S

 O
N

 A
T

T
A

C
H

E
D

 M
E

D
IA

- 
C

A
N

 A
L

S
O

 B
E

 A
C

C
E

S
S

E
D

 B
Y

S
E

L
E

C
T

IN
G

 T
H

E
 A

R
R

O
W

IN
 T

H
E

 U
P

P
E

R
 L

E
F

T
 C

O
R

N
E

R

O
F

 T
H

E
 L

C
D

 S
C

R
E

E
N

- 
T

O
 E

X
IT

 P
L

A
Y

B
A

C
K

, 
S

E
L

E
C

T

T
H

E
 C

IR
C

L
E

 I
N

 T
H

E
 U

P
P

E
R

L
E

F
T

 C
O

R
N

E
R

R
E

F
E

R
 T

O
 O

P
E

R
A

T
IO

N
 G

U
ID

E

F
O

R
 O

P
E

R
A

T
IO

N
A

L
 D

E
T
A

IL
S

A
N

D
 F

E
A

T
U

R
E

S

K
E

Y
S

/S
H

O
R

T
C

U
T

S
D

A
T

E
/T

IM
E

C
O

M
M

.
R

E
D

M
O

T
E

G
P

IO
/S

Y
N

C
S

Y
S

T
E

M

K
E

Y
 S

O
U

R
C

E

R
ef

er
 t

o 
O

p
er

at
io

n 
G

ui
d

e

U
S

E
R

 K
E

Y

R
ef

er
 t

o 
O

p
er

at
io

n 
G

ui
d

e

D
A

T
E

: 
M

/D
/Y

T
IM

E
: 
H

/M
/S

E
N

T
E

R
:

IP
 A

d
d

re
s
s
  
  
 N

e
tm

a
s
k

  
  
  
G

a
te

w
a

y

N
o

n
e

N
O

N
E

E
L

E
M

E
N

T
 T

E
C

H
N

IC
IA

3
A

L
IT

Y
 S

P
C

 7
1
0
0

3
A

L
IT

Y
 S

P
C

 7
0
0
0

S
E

R
IA

L
 P

R
O

T
O

C
O

L

E
N

T
E

R
:

N
a

m
e

  
G

ro
u

p
  
T
a

rg
e

t 
 A

ll
  
  
 N

o
n

e

S
yn

c 
O

u
t

S
Y

N
C

 O
U

T

G
E

N
E

R
A

L
 P

U
R

P
O

S
E

 O
U

T

C
A

M
E

R
A

 O
U

T

S
yn

c 
In

S
Y

N
C

 I
N

G
E

N
E

R
A

L
 P

U
R

P
O

S
E

 I
N

C
A

M
E

R
A

 I
N

F
A

N
 C

O
N

T
R

O
L

IN
D

IC
A

T
O

R
S

R
E

C
 S

P
E

E
D

2
5
 T

O
 1

0
0
%

50
%

-
+

S
T

B
Y

 S
P

E
E

D

2
5
 T

O
 1

0
0
%

75
%

-
+

A
u

to

M
A

N
U

A
L

 /
 A

U
T

O

F
A

N
 C

O
N

T
R

O
L

O
ffO

F
F

R
E

C
O

R
D

 /
 S

T
O

P

B
E

E
P

 S
P

E
A

K
E

R

E
V

F
 T

A
L

L
Y

 L
IG

H
T

M
a

n
u

a
l 
C

h
a

n
n

e
l 
S

e
le

c
t

0
√

0
-1

5

√

K
E

Y
 A

C
T

IO
N

R
ef

er
 t

o 
O

p
er

at
io

n 
G

ui
d

e

M
E

N
U

 K
E

Y
 R

E
T

U
R

N
S

T
O

 S
E

T
IN

G
S

 M
E

N
U

√

N
E

T
W

O
R

K
:

  
  
 D

H
C

P
  
  
  
  
 C

2
C

  
  
  
  
  
E

X
T

√

S
C

A
N

 F
O

R
 R

E
D

M
O

T
E

S

P
A

IR
 R

E
D

M
O

T
E

  
  
  
  
U

N
P

A
IR

 R
E

D
M

O
T

E

S
Y

N
C

 M
O

D
E

O
F

F
  
  
  
  
  
  
G

E
N

L
O

C
K

S
H

U
T

T
E

R
  
IN

T
E

R
N

A
L

P
R

O
X

Y
  
  
  
  
  
  
 S

L
A

V
E

O
ff

C
U

R
. 
C

A
L

 M
A

P

F
A

C
T

O
R

Y
  
  
U

S
E

R
 H

S

Fa
ct

or
y

√



RED DIGITAL CINEMA®
COPYRIGHT© 2012 Red Digital Cinema

All trademarks, trade names, logos, icons, images, written material, code, and product names used in association with the
accompanying product are the copyrights, trademarks or other intellectual property owned and controlled exclusively by Red Digital Cinema


	RED SCARLET-X® OPERATION GUIDE - BUILD 3.2
	TABLE OF CONTENTS
	1 of 2
	2 of 2

	DISCLAIMER
	Copyright Notice
	Trademark Disclaimer

	COMPLIANCE
	Industrial Canada Emission Compliance Statements
	Federal Communications Commission (FCC) Statement
	Australia and New Zealand Statement
	Japan Statements
	European Union Compliance Statements

	BEFORE YOU START
	Important Safety Instructions

	THEORY OF OPERATION
	MYSTERIUM X® Sensor
	Image Processing
	HDRx™
	Magic Motion™
	Audio Recording
	Microphone Level Analog Inputs
	Line Level Analog Inputs
	Video Monitoring Outputs
	Bomb EVF
	RED LCD
	HD-SDI
	HDMI

	RED LCD / Bomb EVF®
	REDMOTE®
	Digital Magazine (Media)
	Metadata
	Clip Naming Conventions
	Multi Camera Shoots
	3D (STEREO) CAMERA SHOOTS

	SMPTE Timecode
	Power Consumption


	CAMERA OPERATIONAL CONTROLS
	Brain
	Side SSD Module
	Side Handle
	Top
	Front
	Rear
	Installation / Removal

	DSMC Modules
	Rear SSD Module
	/
	Quad Battery Module
	Dual Battery Module
	Module Installation / Removal
	Attaching the DSMC Module


	REDMOTE
	Displays
	BOMB EVF and Bomb EVF (OLED)
	Touchscreen LCD

	BASIC OPERATION
	Power Sources
	Side Handle
	Quad Battery Module
	REDVOLT and REDVOLT XL
	BACKPACK QUICKPLATE
	AC POWER ADAPTOR - (DSMC)
	External DC Power
	Power UP
	Power Down

	Graphical User Interface and Navigation
	RED LCD/Touchscreen LCD, BOMB EVF, External Monitors
	Upper Status Row
	Live Action Area
	Lower Status Row
	ICON Behavior
	TC
	GEN
	SYNC

	Power Status
	RAW Clip Meter
	RAW Noise Level Bar
	RAW Clip Level Bar


	Side Handle
	REDMOTE

	Navigating Menus
	Using Touchscreen LCD
	Touchscreen Shortcuts
	Power Down
	Power Menu
	Using Power Status Display

	Lock / Unlock Touchscreen Opreration
	Lock
	Unlock



	FIRST TIME USE – SETTING UP YOUR RED EPIC
	Attach Power Source
	Battery
	Side Handle
	Install
	Remove


	Quad Battery Module
	Install
	Remove

	RED Brick
	DC Power

	Power UP
	Preparing to Record
	Connect and Format Media
	Perform a Black Shading Calibration
	Adjust Project Settings
	Time Base
	Record Resolution
	Record Quality (REDCODE)
	Camera ID (Slate)


	Recording
	Record Indicator

	Playback

	MENU CONTROLS
	Adjustments
	Basic Setting Adjustments
	Side Handle / REDMOTE
	Basic Adjustments Using Side Handle ONLY

	Touchscreen

	Advanced Setting Menus
	Side Handle / REDMOTE
	Touchscreen



	MAIN MENU
	FPS
	Varispeed
	Basic Settings
	Advanced Settings

	ISO (Sensitivity)
	F Stop
	Basic Settings
	Advanced Settings
	Aperture (f stop)
	Focus


	Exposure
	Basic Settings
	Advanced Settings
	Exposure (Speed)
	Integration Time
	Absolute Angle


	White Balance
	Basic Settings
	Advanced Settings
	Preset
	Shade
	Cloudy
	Daylight
	Flash
	Flourescent
	Tungsten
	Incandecent

	Color Temp
	Tint
	Calc White Balance


	Resolution
	REDcode
	REDcode Options for Various Frame Rates


	SECONDARY MENUS
	HDR Menu
	HDR ON / OFF
	Stops

	Focus Menu
	Mode
	Manual Focus
	Manual
	Confirm

	Auto Focus
	Manual
	Confirm
	Single
	Continuous
	Touch Track
	Rack


	DSMC Canon Mount Electronically Supported Lenses
	Zones
	Center
	Spot
	Spot Focus Indicator
	Moving
	Touchscreen
	Side Handle / REDMOTE

	Resizing
	Touchscreen





	Lens Information Display
	RED DSMC Ti PL Mount + Lens
	DSMC Canon Mount + Lens

	Exposure Menu
	Presets Menu
	Camera Presets
	Applying a Preset
	Creating a Preset
	Sharing Presets
	Copy presets from camera to SSD
	Copy presets from SSD to camera
	Managing Preset Files


	LOOKs Presets

	Media Menu
	Select Media
	Format Media
	Reel No.
	Camera ID (Slate)
	Camera Pos (Position)
	Format

	Eject Media
	Utilities
	Secure Format


	Settings Menu
	Display
	Tools
	Off
	Exposure
	Focus
	Video
	Edge
	Magnify
	RAW

	Zebra
	Zebra 1
	High IRE
	Low IRE

	Zebra 2
	High IRE
	Low IRE


	Overlay
	Grid
	Look Around
	Overlay Elements

	Modes
	Exposure
	Shutter
	Absolute
	Relative

	Aperture
	Focal Distance

	Guides
	Size
	Line Style
	Color
	Transparancy

	Monitor
	Brightness Control
	Touch Gestures
	Pinch to Magnify
	Double-Click Right 25% to Record
	Double-Click Left 25% to Start AF



	Look
	Color
	Saturation
	Contrast
	Brightness

	Gain
	Red
	Blue
	Green

	FLUT
	FLUT
	Exposure
	Shadow

	CURvES
	/
	Color/Gamma

	Project
	Time Base
	Time Code
	Time Code Display
	Time Code Source
	User-Provided
	Use RTC Time
	Set Manually



	Slate

	System Status
	Audio/Video
	Audio Input
	Audio Output
	Audio Channels
	Input
	Source
	Mode
	Link
	Limiter

	Output
	Link


	Monitor Control
	Mode
	LCD/EVF
	HDMI

	Res
	HD-SDI

	Res
	Freq
	Automatically Assign Menu Screen if Enabled

	Test Signals

	Setup
	Keys
	Key Mapping
	Options
	Advanced

	Date / Time
	Communication
	Name
	Group
	Target
	Serial Protocol
	Network
	DHCP
	C2C
	EXT
	IP Address
	Netmask
	Gateway


	REDMOTE
	Scan and Pair REDMOTEs
	Manual Channel Select

	GPIO
	Camera Input
	Sync In
	General Purpose In

	Camera Output
	Sync Out
	General Purpose Out

	Sync Mode

	System
	Fan Control
	Auto
	Manual
	Record Speed
	Standby Speed

	Indicators
	Beep Speaker
	EVF Tally Light



	Maintenance
	System Info
	Save Log
	SW Update
	Calibration
	Current CalMap
	Factory
	User HS

	Black Shading (Default)
	Black Shading (Current FPS/Exposure Settings)
	Black Shading Procedure

	Self Test
	Enable / Disable Sensor Test Pattern
	Touchscreen

	Restore System
	Rediscover

	Playback
	Upper Controls
	Exit Playback ICON (Touchscreen)
	ISO
	White Balance
	Advanced Menu

	View
	Presets
	Media
	Touchscreen
	Side Handle / REDMOTE

	Settings
	Display
	Tools
	Zebra

	Look
	Record (Exit)

	Meta
	Clip Playback Status Bar
	Touchscreen
	Side Handle / REDMOTE


	Lower Controls
	Resolution / Project Framerate / Quality
	Histogram
	Playback Speed
	In / Out Point Marker
	Frame-by-Frame Reverse / Forward
	Play / Pause
	Play Once / Loop
	Playback Direction
	Additional Clip/Camera Information



	Power
	Power Status
	Shutdown


	APPENDIX A: UPGRADING CAMERA FIRMWARE
	Verify Current Camera Firmware
	Upgrade Procedure

	APPENDIX B: MANAGING DIGITAL MEDIA
	Media
	Formatting Media
	Media Capacity Remaining Status
	Eject Media from Camera (Unmount)
	Using REDMOTE / Touchscreen LCD
	Using Side Handle
	Using Side SSD

	Copying Media
	Erasing Media
	Macintosh OS X
	Windows


	APPENDIX C: INPUT / OUTPUT CONNECTORS
	Camera Brain Front
	MIC-1, MIC-2 (Microphone Audio)

	Camera Brain Rear
	HD-SDI
	Headphone
	SYNC (Video Sync)
	CTRL (RS232 Control)
	GIG-E (Ethernet)
	DC IN (Power Input)
	HDMI Out

	Side SSD Module
	REDMOTE

	APPENDIX D: DEFAULT KEY FUNCTIONS
	APPENDIX E: REDMOTE OPERATION
	Control, Connectors and Display
	Controls
	Still / Motion Switch
	LEDs
	Rocker Switch
	User Function Keys
	Menu Button
	SOFT Menu Buttons 1-3
	Navigation Group
	Scroll Wheel
	Direction KEYS
	Enter Button

	Focus and Record Button
	Soft Menu Buttons 4-8
	Power / KEY Lock Switch
	USB Power Port


	Operation
	Docking and Undocking
	Docking
	Undocking

	Power Up / Down
	Power UP
	Connected to Camera
	Not Connected to Camera

	Power DOWN
	Using Camera
	Using REDMOTE


	Recording
	Accessing Camera Controls / Settings
	Changing Camera Settings
	Using Camera LCD / External Monitor as Reference
	Exiting Menus to Main Screen

	Using REDMOTE LCD Stand-Alone


	ADVANCED OPERATION: REDMOTE Menus
	Soft Menu Buttons 1-3
	WIRELESS CONNECT: SOFT MENU BUTTON 1

	Connect REDMOTE to a Paired Camera
	CANCEL
	DISCONNECT
	ReconnectING IF Signal is Lost
	Operating WITH Multiple Cameras FROM a REDMOTE
	REDMOTE or LOCAL MENUS: SOFT MENU BUTTON 2
	REMOTE
	LOCAL
	CUSTOMIZING LOCAL MENUS.


	REDMOTE SETUP: SOFT MENU BUTTON 3
	Brightness
	Volume
	Auto Shutdown


	DISPLAY LAYOUT: Soft Menu Buttons 4-8


	Maintenance
	Internal Battery
	Charge Status
	Battery Life
	CHARGING
	CHARGE TIME
	USING CAMERA
	USING USB CONNECTOR


	Upgrading REDMOTE Firmware
	Setup
	Configuring REDMOTE Connection with Computer (MAC)

	Updating REDMOTE Firmware
	MAC
	Windows
	Install Upgrade Utility
	Upgrading REDMOTE Firmware





	APPENDIX F: 3D SETUP / OPERATION
	Overview
	Camera Setup
	Master Camera
	Slave Camera

	Clip Naming Conventions
	Reel No. / Slate (Camera ID) / Camera Position

	Connecting Cameras
	Operation
	Changing Settings
	Recording
	Power Down


	APPENDIX G: EXPOSURE – USING FALSE COLOR AND ISO
	Underexposure (~ 2 stops)
	Overexposure (~ 2 stops)
	Appropriate Exposure
	Adjusting the ISO Rating

	APPENDIX H: POST PRODUCTION
	Monitoring
	REDCINE-X® PRO


	APPENDIX I: MAINTENANCE
	Cleaning
	Camera And Accessory Exterior Surfaces
	Brain
	Optical Low-Pass Filter (OLPF)

	LCD Screen (Touchscreen / Non-Touchscreen)
	EVF
	REDMOTE Screen
	Lenses
	Side Handle LCD

	Back Focus Adjustment

	APPENDIX J: TROUBLESHOOTING
	No Media Attached
	Recording Halted: Record Error - Shutdown
	Preset Could Not Be Applied
	Camera Cannot Be Paired to REDMOTE
	Cannot See Menus on LCD Touch Screen

	APPENDIX K: TECHNICAL SPECIFICATIONS
	Camera Brain Dimensions

	/APPENDIX L: RESOLUTION CHART
	APPENDIX M: MENU MAPS
	1 of 4
	2 of 4
	3 of 4
	4 of 4




